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Abstract

				This guide describes how to use the Red Hat JBoss Fuse Tooling, which provides developer tools designed to increase your productivity when designing, developing, testing, and debugging your integration applications.
			






Part I. Introducing the Fuse Tooling User Interface





				Red Hat JBoss Fuse Tooling is an Eclipse-based IDE for creating and testing small- and large-scale integration applications. Its key features are a graphical routing editor, a full-featured Camel debugger for debugging locally running routing contexts, an integrated testing platform that uses JMX to communicate with the containers in a small-scale test environment, and tooling for using Fabric8 to test applications in large-scale, highly-distributed test environments.
			


Chapter 1. JBoss Perspective



Overview




				By default, Red Hat JBoss Developer Studio starts up in JBoss perspective. To access the design time tooling, you select File → New → Fuse Project on the menu bar.
			
Note

					Though you can also do all of your development in Fuse Integration perspective, JBoss perspective provides more space for the route editor to expand to accommodate complex routes.
				


				Creating a new Fuse project provides access to the route editor, the main design time tooling, shown in Figure 1.1.
			
Figure 1.1. route editor
[image: four sections of the route editor]



				It consists of four main areas:
			
	
						Canvas—the large grid area on which routes are constructed
					

	
						Palette—the pane to the right of the canvas from which Enterprise Integration Patterns (EIPs) are selected
					

	
						Project view—the pane on the left side of the canvas, which can display multiple views of the active project. The pane defaults to Project Explorer, which displays the project's folders and files in an hierarchical tree format.
					
Note

							Red Hat recommends you to close the JMX Navigator view and then drag Outline view from the upper right side of the workspace to the lower left side, beneath Project Explorer, to provide optimal space for the route editor. Outline view displays, in an outline of EIP icons, the contents of the current <camelContext> element in the routing context file.
						


	
						Properties editor—the editor in which you configure the selected node's properties. It opens in a tab in the pane below the canvas.
					




Canvas




				The canvas is route editor's workbench and where you do most of your work. It displays a graphical representation of a route, which is made up of one or more connected EIP patterns (called nodes once they are placed on the canvas). Because the canvas displays only one route at a time, it delineates one route from another. You can add additional routes to your project, but each is displayed separately on its own slice of canvas.
			

				Patterns are typically placed on the canvas by dragging them from the palette. Once on the canvas, a node's properties can be edited in the Properties editor. To do so, you need only select a node to open and populate the Properties editor with the properties that apply to that node. You can also edit a route's properties by clicking the canvas, which opens and populates the Properties editor with the properties that correspond to a single route in the routing context file.
			
Note

					Clicking the Source tab at the lower, left of the canvas displays the XML code generated for the route, which you can then edit. The edits you make in Source view appear on the canvas when you switch back to Design View.
				


Palette




				The Palette contains all of the patterns needed to construct a route. The Palette groups the patterns into categories according to function:
			
	
						Components—endpoint patterns that start or end a route
					

	
						Defined Endpoints—endpoint nodes that have been defined in the routing context
					

	
						Routing—patterns that direct the flow of messages based on specified criteria
					

	
						Control Flow—patterns that behave like control functions in a programming language. For example, some define loops, some handle error conditions, some handle transactions, and so on.
					

	
						Transformation—patterns that change the contents of a message as it passes through a route
					

	
						Miscellaneous—patterns that control the environment in which a route executes. For example, the Threads pattern specifies the number of threads available.
					




Project Explorer




				Project Explorer provides access to all of the components that make up a project. It provides the tools for managing, configuring, running, and debugging your project.
			

Outline view




				Outline view provides a graphical outline of your route components. It enables you to switch easily between routes in a multiroute project. Clicking on a route in Outline view displays it on the route editor's canvas.
			

				Outline view also provides a viewing portal when the route extends beyond the viewable area on the canvas. Sliding the view portal in Outline view over outlier nodes moves the canvas accordingly to bring those nodes into view.
			


			

Properties editor




				You use the Properties editor to configure the route and each node in it. Each type of node has a set of properties that can or must be set. The Properties editor opens populated with fields that apply to the selected node.
			

				The Properties editor makes it clear which fields are required. 
				[image: Properties editor]
				 marks any required property that is not set, and the Properties editor displays an error message stating the number of required properties that still must be set, as shown in Figure 1.2.
			
Figure 1.2. Properties editor's error reporting
[image: properties of the When node]



				The Properties editor's Documentation tab displays information about how to configure the selected node.
			


Chapter 2. Debug Perspective



Overview




				The Debug perspective, shown in Figure 2.1, provides access to all of the Camel debugger's functions. It contains all of the views used to monitor and debug a running routing context.
			
Figure 2.1. Debug perspective
[image: Camel Context debugger]


	
						Debug view
					

						For the running routing context, Debug view displays the debug stack.
					

						You can switch between breakpoints within the same message flow, listed under the Camel Context at service:jmx:rmi://jndi/rmi://localhost:1099/jmxrmi/camel entry, to review and compare variable values in Variables view.
					

						Messages flows are identified by their unique breadcrumb ID, and the breadcrumb ID of each subsequent message flow is incremented by 2. For example, in Figure 2.1, “Debug perspective”, the breadcrumb ID for the first message flow is ID-janemurpheysmbp-home-61339-11430424775526-0-1, so the breadcrumbID for the second message flow would be ID-janemurpheysmbp-home-61339-11430424775526-0-3.
					

	
						Variables view
					

						For each node in the routing context that has a breakpoint set, Variables view displays the value of the available variables when the breakpoint is hit. Each variable who's value changed since the preceding breakpoint is highlighted in yellow.
					

						You can change the value of editable variables to check whether such changes produce the expected results and to test the robustness of your routing context.
					

						You can also add variables to the watch list, so you can quickly and easily see whether their values change as expected at the expected point in the message flow.
					

	
						Breakpoints view
					

						Displays a list of the breakpoints set in the routing context, and shows whether they are enabled or disabled. You can enable and disable individual breakpoints by checking (enabling) or unchecking (disabling) them. This enables you to temporarily focus on nodes in your routing context that are behaving problematically.
					

						The 
						[image: Debug perspective]
						 button skips over disabled breakpoints to jump to the next active breakpoint in the routing context. In contrast, the 
						[image: Debug perspective]
						 button jumps to the next node of execution in the routing context, regardless of breakpoints.
					

	
						Camel Context: view
					

						Displays the running CamelContext:<CamelId>.xml in graphical mode. For nodes set with breakpoints, it shows the type of breakpoint set and whether the breakpoint is enabled or disabled. When a breakpoint is hit, its corresponding node on the canvas is outlined in red.
					

						To check a node's configuration, open Properties view and then select the node on the canvas in Camel Context: view.
					

	
						Console view
					

						Displays the log output generated by the Camel debugger as it executes the routing context.
					

	
						Properties view
					

						Displays the properties set for the node selected on the canvas in CamelContext: view.
					




Related topics



	 Part III, “Debugging Routing Contexts” 
	 chapter "To Debug a Routing Context" in "Tooling Tutorials" 



Chapter 3. Fuse Integration Perspective



Overview




				The Fuse Integration perspective, shown in Figure 3.1, provides access to all of the tooling for monitoring and testing your integration application.
			
Figure 3.1. Fuse Integration perspective
[image: Fuse Integration debugging stage]



				The Fuse Integration perspective consists of eight main areas:
			
	
						Project Explorer—displays all of the projects known to the tooling. You can view all of the artifacts that make up each project. Project Explorer also displays all of the routing context .xml. files for a project under its Camel Contexts node. This makes it easy for you to find and open the routing context file of any route included in a project.
					

	
						JMX Navigator—lists the JMX servers and the infrastructure they monitor. It allows you to browse JMX servers and the pocesses they are monitoring. It also identifies instances of Red Hat processes.
					

	
						Diagram View—displays a graphical tree representing the node selected in JMX Navigator. When you select a process, server, endpoint, or other node, Diagram view shows the selected node as the root and branches down to its children and grandchildren.
					

						When you select a broker, Diagram View displays up to three children: connections, topics, and queues. It also shows configured connections and destinations as grandchildren.
					

						When you select a route, Diagram view displays all of the nodes in the route and shows the different paths that messages can take through it. It also displays timing metrics for each processing step in the route when route tracing is enabled.
					

	
						Shell view—Displays the command console of the connected container. You can control the container by entering commands in Shell view.
					

	
						Messages View—lists the messages that have passed through the selected JMS destination or through Apache Camel endpoints when route tracing is enabled.
					

	
						Servers view—displays a list of servers (Red Hat JBosss Fuse, Apache Karaf, or Apache ServiceMix) managed by the tooling. It displays their runtime status and provides controls for starting and stopping them and for debugging projects deployed on them.
					

	
						Properties view—displays the properties of the selected node.
					

	
						Console view— displays the console output for recently executed actions.
					




JMX Navigator




				The JMX Navigator drives all monitoring and testing activities in Fuse Integration perspective. It determines which routes are displayed in Diagram View, the Properties viewer, and Messages View. It is also provides menu commands for activating route tracing, adding and deleting JMS destinations, and starting and suspending routes. It is also the target for dragging and dropping messages onto a route.
			

				By default, JMX Navigator shows all of the Java processes running on your local machine. You can add JMX servers as needed to view infrastructure on other machines.
			

Messages view




				The Messages View is used for browsing JMS destinations and for tracing messages that have passed through a route.
			

				When a JMS destination is selected in JMX Navigator, the view lists all of the messages sitting in the destination.
			

				When route tracing is enabled, Messages View lists all of the messages that passed through the nodes in the route since tracing started. You can configure Messages View to display only the data in which you are interested and in your preferred sequence.
			

				When a message trace in Messages View is selected, its details (message body and all message headers) are displayed in the Properties viewer. In Diagram View, the step in the route associated with the selected message trace is also highlighted.
			


Chapter 4. Fabric8 Perspective




				The Fabric8 perspective, shown in Figure 4.1, is where you access the fabric development and debugging tools.
			
Figure 4.1. Fabric8 perspective
[image: Fabric8 management perspective]



				The Fabric8 perspective consists of six main areas:
			
	
						Fabric Explorer—lists the fabrics and the containers, profiles, and versions of which they consist.
					

	
						Diagram View—provides a graphical representation of a node selected in Fabric Explorer.
					

	
						Shell— provides console access to any container running on the fabric.
					

	
						Log view—lists the log entries of the selected container or the selected JMX process.
					

	
						Messages View—lists the message instances that passed through the nodes in a selected route, after tracing was enabled on the route.
					

	
						Properties view—displays the properties of an object selected in Fabric Explorer.
					



Fabric Explorer 




				Fabric Explorer provides access to your fabrics. Once the tooling is connected to a fabric, Fabric Explorer provides access to all of the fabric's components (containers, profiles, and profile versions) enabling you to configure, run, and debug your project in the fabric environment.
			

Diagram view




				Use Diagram View in conjunction with Messages View to track a message through the nodes of a route for which tracing has been activated. In Diagram View, the node which corresponds to the message instance selected in Messages View is highlighted. Messages View displays metrics for the selected message instance, including the time at which it exited the highlighted node.
			

Log view




				Log view displays the log entries of the container selected in Fabric Explorer. This feature enables you to see the log messages of any container running in a fabric.
			

				Double-clicking a process in a container's JMX tree opens the process in a jconsole-like viewer, where you can browse its attributes, operations, notifications, and other information, all of which are presented in tabular format.
			

Messages view




				The Messages View is used for tracing messages through a route in a fabric environment.
			

				When an Apache Camel route for which route tracing has been activated is selected in Fabric Explorer, Messages View lists all messages that pass through the route from the time tracing was activated. Messages View also provides metrics for each message instance, making it easier to debug routes.
			

				Use the view's Refresh button periodically to update its display of message traces.
			

Properties view




				For container nodes, the Properties view also provides the Profiles tab, for viewing the profiles assigned to the container, and the Profile Details tab, for viewing the details of each assigned profile.
			

				The Profiles editor enables you to change the profiles associated with the selected container, and the Profile Details editor enables you to modify the configuration of the selected profile.
			

JMX viewer




				Double-clicking a process in a container's JMX tree opens the process in a jconsole-like viewer, where you can browse its attributes, operations, notifications, and other information, all of which are presented in tabular format.
			


Part II. Developing Applications





				We reccomend that you develop your applications in Chapter 1, JBoss Perspective because it provides more room to expand the route editor's canvas when you are building complex routes. If it is not already open, click 
				[image: Developing Applications]
				 on the right side of the JBoss Developer Studio tool bar.
			


Chapter 5. Creating a New Fuse Project



Overview




				The tooling uses Maven archetypes to generate a project with all of the dependencies preconfigured. The archetypes also create the POM file needed to run and deploy your application, as well as sample code and data to get you started.
			

Procedure




				To create a Fuse project:
			
	
						Select File → New → Fuse Project to open the New Fuse Project wizard shown in Figure 5.1, “New Fuse Project Wizard's Project Location Page”.
					
Figure 5.1. New Fuse Project Wizard's Project Location Page
[image: project location page of Red Hat JBoss Fuse Tooling's new project wizard]



						The wizard opens with the Use default workspace location option selected on the location page.
					

	
						Enter the name of the Fuse project.
					

	
						Specify the location where the data for the project will be stored.
					

							
								To use the default workspace select Use default workspace location.
							


						 	
								To use an alternative location clear Use default workspace location and specify a new location in the provided field.
							

								Clicking 
								[image: Browse button]
								 opens a file browser.
							



					

	
						If you want to add the new project to an Eclipse working set, select Add project(s) to working set and enter the name of the working set.
					

	
						Click 
						[image: Next button]
						 to open the New Fuse Project details page shown in Figure 5.2.
					
Figure 5.2. New Fuse Project wizard's details page
[image: project details page of Fuse new project wizard]



	
						Select a project type from the list.
					
Note

							The route editor works with these project types:
						
	
									camel-archetype-activemq
								

									Creates a new Apache Camel project that configures and interacts with Apache ActiveMQ.
								

	
									camel-archetype-blueprint
								

									Creates a new Apache Camel project with support for OSGi blueprint that is deployment-ready for OSGi.
								

	
									camel-archetype-cxf-code-first-blueprint
								

									Creates a new Apache Camel project with Apache CXF code-first example using OSGi Blueprint.
								

	
									camel-archetype-cxf-contract-first-blueprint
								

									Creates a new Apache Camel project with Apache CXF contract-first example using OSGi Blueprint.
								

	
									camel-archetype-java
								

									Creates a new Apache Camel project using Java DSL.
								

									You cannot edit Java DSL in the route editor.
								

	
									camel-archetype-spring
								

									Creates a new Apache Camel project with added support for Spring DSL.
								

	
									camel-archetype-spring-dm
								

									Creates a new Apache Camel project with added support for Spring DSL that is deployment-ready for OSGi.
								

	
									camel-archetype-web
								

									Creates a new Apache Camel web project that deploys the Camel routes as a WAR.
								

	
									cxf-jaxrs-service
								

									Creates a simple CXF JAX-RS web application service using Spring configuration.
								

	
									cxf-jaxws-javafirst
								

									Creates a project for developing a Web service starting from Java code.
								





	
						Enter a group ID for the project in the Group Id field, or accept the default.
					

						The tooling uses the group ID to form the first part of the dot-separated package name. For example, if you enter Demo for the group ID, it appears in the Package field as Demo..
					

	
						Enter an artifact ID for the project in the Artifact Id field, or accept the default.
					

						The tooling uses the artifact ID as the name of the project and to form the second part of the dot-separated package name. For example, if you enter BigRoute for the artifact ID, it appears in the Package field as Demo.BigRoute.
					

	
						Enter a version for the project in the Version field, or accept the default.
					

	
						If you want to change the package name generated for the artifacts, enter the new package name in the Package field.
					

	
						Click Finish to create the Maven project, which contains starting point artifacts.
					




Resolving Maven dependency errors




				You may encounter Maven dependency errors after you create a new Fuse project.
			

				Though it can happen at other times, it more typically occurs when you create a project based on any of the supplied archetypes for the first time, but then cancel the project before the process finishes. Interrupting the process in this way often prevents all of the project's dependencies from downloading from the Maven repositories, which can take some time.
			

				You can often easily resolve these dependency errors by updating Maven dependencies this way:
			
	
						In Project Explorer, select the root project just created.
					

	
						Right-click it to open the context menu.
					

	
						Select Maven → Update Project...
					

	
						In the Update Maven Project wizard, check Force Update of Snapshots/Releases.
					

	
						Click OK.
					

						In the bottom, right corner of the workbench, you may see the progress status bar churning as missing dependencies are downloaded from the Maven repositories.
					




Related topics



	 New Fuse Project 
	Red Hat JBoss Fuse Tooling Tutorials, To Create a New Route



Chapter 6. Creating a New Camel XML file



Overview




				Apache Camel stores routes in an XML file that contains a camelContext element. The tooling includes a wizard that simplifies adding an Apache Camel context file to your project. It creates a new XML file that has all of the required namespaces preconfigured and a template camelContext element.
			

Procedure




				To add an Apache Camel context file to your project:
			
	
						Select File → New → Other... → Fuse Tooling → Camel XML File from the main menu to open the Camel XML File wizard, as shown in Figure 6.1, “Camel XML File wizard”.
					
Figure 6.1. Camel XML File wizard
[image: Camel XML file wizard]



	
						In RouteContainer, enter the location for the new file, or accept the default.
					

						You can click 
						[image: Browse... button]
						 to search for an appropriate location.
					
Important

							The Spring framework and the OSGi Blueprint framework require that all Apache Camel files be placed in specific locations under the project's META-INF or OSGI-INF folder:
						
	
									Spring—projectName /src/main/resources/META-INF/spring/
								

	
									OSGi Blueprint—projectName /src/main/resources/OSGI-INF/blueprint/
								





	
						In File Name, enter a name for the new context file, or accept the default.
					

						The file's name cannot contain spaces or special characters, and it must be unique within the JVM.
					

	
						In Framework, accept the default, or select which framework the routes will use:
					
	
								Spring—for routes that will be deployed in Spring containers, non-OSGi containers, or as standalone applications
							

	
								OSGi Blueprint—for routes that will be deployed in OSGi containers
							

	
								Routes—for routes that you can load and add into existing camelContexts
							




	
						Click Finish.
					

						The new context file is added to the project and opened in the route editor.
					




Related topics



	 New Camel XML File 



Chapter 7. Editing a routing context in the route editor




				Developing an Apache Camel application typically consists of the following tasks:
			
	
						Adding one or more routes to the routing context.
					

	
						Adding a starting point pattern to a route.
					

	
						Adding one or more endpoint patterns to a route.
					

	
						Adding one or more processor patterns that represent how messages will be transformed and routed between the starting point and endpoint(s).
					

	
						Connecting the patterns (referred to as nodes once they are placed on the canvas).
					

	
						Configuring the details for each of the endpoints and processors that make up the route.
					

	
						Adding any configuration beans to the context.
					



Adding routes to the routing context



Overview




					The camelContext element within an XML context file creates a routing context. The camelContext element can contain one or more routes, but the route editor's canvas can display only one of the routes at a time. Therefore the canvas is each route's delineator, and each route displayed on the canvas maps to a route element in the generated camelContext element.
				

					When you create a new Fuse Project, the tooling creates an example camelContext.xml file that is defined either as camel-context.xml (Spring) or blueprint.xml (Blueprint). You can view and edit the contents of the camelContext.xml file in the route editor's Source view. In Design view, the route editor presents an empty canvas, which represents the empty route element. You can drag patterns from the Palette and drop them onto the canvas to create a route. The design time tooling updates the empty route element with XML code generated from the patterns you drop onto the canvas.
				

					The tooling provides three methods for adding a new route:
				
	
							From the menu bar, by opening the Routes menu, and then selecting Add Route
						

	
							In Design view, by right-clicking the canvas or a node to access the context menu, and then selecting Add → Route
						

	
							In Source view, by adding a <route/> element to the existing list within the camelContext element
						




Procedure




					To add another route to the camelContext:
				
	
							Select one of the methods for adding a route.
						

							In Design view, a route icon appears in Outline view, and the Properties editor displays the list of the new route's properties for you to edit.
						

	
							In the Properties editor, enter an ID (for example, Route2) for the new route in the route's ID field.
						

							In Outline view, the new ID displays next to the new route icon.
						

	
							In the Properties editor, enter a description of the route in the Description field.
						

	
							On the menu bar, select File → Save to save the changes you made to the routing context file.
						



Note

						To switch between multiple routes, select the route you want to display on the canvas by clicking it in Outline view or by selecting it from the Routes menu on the menu bar.
					


Related topics



	Red Hat JBoss Fuse Tooling Tutorials, To Add a Content-Based Router
	Red Hat JBoss Fuse Tooling Tutorials, To Add Another Route to the CBR Routing Context



Adding patterns to a route




					Routes consist of a sequence of connected patterns, referred to as nodes once they are placed on the canvas. To add a pattern to a route you can either:
				
	
							Drag the pattern from the palette
						

	
							Use the context menu
						




					Both methods provide access to all of the available patterns. Dragging patterns from the palette and dropping them onto the canvas is an easy and convenient way to add multiple patterns to the canvas quickly. Using a node's context menu, you can add and automatically connect a pattern to the node.
				
Drag and drop a pattern



Overview




						The Palette lists all of the available patterns, grouped by function. For example, the Loop pattern is part of the Control Flow group.
					

						You can select any pattern from the Palette and drag it to the canvas, which represents a single route.
					

Procedure




						To drag a pattern onto a route:
					
	
								In the Palette, locate the desired pattern.
							

	
								Select the pattern, drag it to the canvas, and then release the mouse button.
							
Note

									You need not place the pattern in its intended location. You can easily move any node on the canvas by dragging it to a new location.
								





						The new pattern appears on the canvas and becomes the selected node. The Properties editor displays a list of the node's properties for you to edit and configure.
					

Related topics



	
	the section called “Rearranging patterns on the canvas”
	the section called “Configuring a pattern”
	the section called “Removing patterns from a route”



Using the context menu



Overview




						Nodes on the canvas have a context menu that includes an Add option for adding new patterns to a route.
					

Procedure




						To add and connect a pattern to a node in a route:
					
	
								In the canvas, select the node to which you want to connect the new pattern.
							

	
								Right-click it to open the context menu.
							

	
								Select Add to display the list of patterns that can be connected to the selected node. The patterns are grouped according to function.
							

	
								Select the pattern to add to the route.
							




						The new pattern is added to the route and automatically linked to the selected node. The new pattern becomes the currently selected node, and the Properties editor displays a list of the node's properties for you to edit and configure.
					

Related topics



	
	the section called “Rearranging patterns on the canvas”
	the section called “Configuring a pattern”
	the section called “Removing patterns from a route”




Connecting patterns to make a route



Overview




					Until the patterns on the canvas (referred to as nodes) are connected, they do not constitute a route. The editor does not save a route element in the context file until all nodes are linked together to form a complete route. A complete route typically consists of a starting endpoint, a string of processing nodes, and one or more destination endpoints.
				

					Connecting two nodes on the canvas is as simple as dragging a line from one to the other. Each node has a connector arrow. Selecting a node and dragging its connector arrow to a target node establishes a connection between the two nodes.
				

Procedure




					To connect two nodes:
				
	
							On the canvas, select the source node to display its connector arrow.
						

	
							Click-drag the source node's connector arrow ( 
							[image: Procedure]
							 ) to the target node.
						

							The direction of the connection represents the direction messages flow between the nodes in the route.
						

	
							While hovering over the target node, release the mouse button to drop the connector on it.
						

							The route editor updates the <route> element with the xml generated from the connection. You can view the xml in Source view.
						

	
							When you are done, save your work by selecting File → Save from the menu bar.
						





Configuring a pattern



Overview




					Most patterns require some explicit configuration. For example, an endpoint requires an explicitly entered URI.
				

					The tooling's Properties editor provides a form that lists all of the configuration details a particular pattern supports. The Properties editor also provides the following convenience features:
				
	
							validating that all required properties have values
						

	
							drop-down lists for properties that have a fixed set of values
						

	
							drop-down lists that are populated with the available bean references from the Apache Camel Spring configuration
						




Procedure




					To configure a pattern:
				
	
							On the canvas, select the node you want to configure.
						

							The Details tab in the Properties editor lists all of the selected node's properties for you to edit. The Documentation tab describes the pattern and each of its properties.
						

	
							Edit the fields in the Properties editor to configure the node.
						

	
							When done, save your work by selecting File → Save from the menu bar.
						




Related topics



	



Rearranging patterns on the canvas




					As your route grows and changes, you'll likely need to change how it is laid out on the canvas. Changing the layout does not change the underlying DSL, but it does make it easier to visualize the route.
				

					The tooling provides two ways to rearrange the patterns on the canvas:
				
	
							dragging and dropping
						

	
							the context menu's 
						



Rearranging patterns by dragging them



Overview




						You can select one or more nodes on the canvas and drag them to a new location. Each node's connections are retained and move along with it. However, the layout of the route will continue to change as it grows in scope and complexity.
					

Procedure




						To drag a node to a new location on the canvas:
					
	
								Determine which node or nodes you want to move.
							

	
								Select one node, or select a group of nodes by dragging a box around them.
							

	
								Drag the node or nodes to their new location, then release the mouse button.
							



Note

							You can also rearrange the connectors between nodes to accommodate increasing numbers of patterns on the canvas. Clicking a connector joining two nodes on the canvas reveals a line segmented by a bendpoint. You can drag the bendpoint to another location on the canvas while leaving the two nodes in place. Dragging a bendpoint creates two new bendpoints on either side of it, further segmenting the connector. This feature makes it easy to organize the nodes in a complex route for visual clarity.
						



Automatically aligning patterns



Overview




						The Layout Diagram command on the canvas' context menu automatically aligns all nodes on the canvas relative to the route's start point. By default, the route editor arranges the nodes in a route from left to right across the canvas, according to the order in which they are connected to each other. It moves the start point to the left edge of the canvas, then aligns the processing nodes and endpoints accordingly.
					
Note

							You can change the default layout direction (Right). To do so, on the menu bar select Preferences → Fuse Tooling → Editor, and then select Down from the Choose the layout direction for the diagram editor's drop-down list.
						


						You can continue adding more patterns to your route after you execute the Layout Diagram command.
					

Procedure




						To direct the tooling to automatically align all nodes on the canvas:
					
	
								Right-click the canvas to open the context menu.
							

	
								Select Layout Diagram.
							






Removing patterns from a route



Overview




					As you develop and update a route, you may need to remove one or more of the route's nodes. The Remove option on the nodes' context menu makes this easy to do. When you delete a node from the canvas, all of its connections with all other nodes on the canvas are also deleted.
				
Note

						You can also remove a node by right-clicking it in Outline view and selecting Remove, or by selecting Edit → Delete from the menu bar.
					


Procedure




					To remove a node from a route:
				
	
							Select the node you want to delete.
						

	
							Right-click it to open the context menu.
						

	
							Select Remove.
						




					The node and all of its connections are deleted from the canvas.
				

Related topics



	the section called “Adding patterns to a route”



Disconnecting two patterns



Overview




					As you develop and update a route, you may need to disconnect some nodes. The Remove option on the connector context menu makes this easy to do.
				
Note

						You can also delete a connector by selecting Edit → Delete from the menu bar.
					


Procedure




					To disconnect two nodes:
				
	
							Select the connector you want to delete.
						

	
							Right-click it to open the context menu.
						

	
							Select Remove.
						




					The connector between the nodes is removed.
				

Related topics



	the section called “Connecting patterns to make a route”



Deleting a route



Overview




					In some cases you made need to delete an entire route from your routing context. The Remove Route option on the canvas' context menu makes this easy to do. When you delete a route, all of the nodes the route contains are also deleted.
				
Note

						You can also remove a route from the Routes menu on the menu bar.
					


Procedure




					To delete a route:
				
	
							If the routing context contains more than one route, first select the route you want to delete in Outline view.
						

	
							Right-click on the canvas to open the context menu.
						

	
							Select Remove Route.
						




					The route is removed from the canvas and from the camelContext.
				


Adding beans and configuration



Overview




					Many routing patterns rely on references to Java objects (beans) for configuration or for implementation details. You add the beans into the routing context file using the route editor's Source tab.
				

Procedure




					To add beans to your routing context file:
				
	
							Open your routing context file in the route editor.
						

	
							Click the Source tab at the bottom of the route editor's canvas to switch to Source view, so you can edit the XML that defines the route.
						

	
							Enter the bean elements needed by your route before the camelContext element.
						
Note

								Use the id attribute to identify the bean, not the name attribute.
							

Important

								Do not edit the contents of the camelContext element.  overwrites the camelContext element when changes are made to the route diagram in Design view.
							


	
							Save your changes by selecting File → Save on the menu bar.
						

	
							Click the Design tab at the bottom of the route editor's canvas to return to Design view and the route diagram.
						




Related topics



	 Chapter 9, The Source View 
	 Apache Camel Development Guide, Part IV Programming EIP Components 



Configuring the route editor



Overview




					Using the 's preference panel, you can specify many aspects of the route editor's behavior: 
					
	
								The default language to use for expressions in EIPs
							

	
								The method for labeling nodes on the canvas
							

	
								The direction in which patterns flow on the canvas when creating routes
							

	
								Whether the canvas displays a grid overlay
							

	
								Colors used for various diagrammatic components
							





				

Procedure




					To configure the route editor:
				
	
							In JBoss Developer Studio, click Window → Preferences to open the Preferences dialog.
						

	
							Click Fuse Tooling → Editor to show the Editor preferences.
						

	
							Select, from the drop-down list, the default language you want to use for expressions in EIP nodes.
						

	
							Click the checkbox next to If enabled the ID values will be use for labels if existing to enable or disable using node IDs as labels.
						

	
							Select, from the drop-down list, the direction in which you want the route editor to align the patterns in a route.
						

	
							Click the checkbox next to Show diagram grid in Routes Editor to enable or disable displaying the grid overlay on the canvas.
						

	
							Click Apply to apply the changes to the Editor preferences.
						

	
							Click Fuse Tooling → Colors to show the Colors preferences.
						

	
							For each component whose color you want to change, click its color icon to open the color palette, and then select a color from the palette.
						

	
							When done, click Apply and then OK to close the Preferences dialog.
						

							You can restore the route editor's original color scheme at any time by returning to Fuse Tooling → Colors and clicking Restore Defaults.
						




Related topics



	Editor
	Colors




Chapter 8. Creating a new Apache Camel JUnit test case



Overview




				A common way of testing routes is to use JUnit. The design time tooling includes a wizard that simplifies creating a JUnit test case for your routes. The wizard uses the endpoints you specify to generate the starting point code and configuration for the test.
			
Note

					After you create the boilerplate JUnit test case, you need to modify it to add expectations and assertions specific to the route that you've created or modified, so the test is valid for the route.
				


Procedure




				To create a new JUnit test case for your route:
			
	
						In Project Explorer, select the camel-context.xml file in your routing project.
					

	
						Right-click it to open the context menu, and then select New → Camel Test Case to open the New Camel JUnit Test Case wizard, as shown in Figure 8.1, “New Camel JUnit Test Case wizard”.
					
Figure 8.1. New Camel JUnit Test Case wizard
[image: Entry page of the New Camel JUnit Test Case wizard]



						Alternatively, you can open the wizard by selecting File → New → Other... → Fuse Tooling → Camel Test Case from the menu bar.
					

	
						In Source folder, accept the default location of the source code for the test case, or enter another location.
					

						You can click 
						[image: Browse button]
						 to search for a location.
					

	
						In Package, accept the default package name for the generated test code, or enter another package name.
					

						You can click 
						[image: Browse button]
						 to search for a package.
					

	
						In Camel XML file under test, accept the default pathname of the routing context file that contains the route you want to test, or enter another pathname.
					

						You can click 
						[image: Browse button]
						 to search for a context file.
					

	
						In Name, accept the default name for the generated test class, or enter another name.
					

	
						Select the method stubs you want to include in the generated code.
					

	
						If you want to include the default generated comments in the generated code, check the Generate comments box.
					

	
						Click 
						[image: Next button]
						 to open the  Test Endpoints page. For example, Figure 8.2, “New Camel JUnit Test Case page” shows a route's input and output file endpoints selected.
					
Figure 8.2. New Camel JUnit Test Case page
[image: Example Test Endpoints page]



	
						Under Available endpoints, select the endpoints you want to test. Click the checkbox next to any selected endpoint to deselect it.
					

	
						Click 
						[image: Finish button]
						 .
					
Note

							If prompted, add JUnit to the build path.
						





				The artifacts for the test are added to your project and appear in Project Explorer under src/test/java. The class implementing the test case opens in the Java editor.
			

Related topics



	 New Camel JUnit Test Case 
	 Test Endpoints 
	Red Hat JBoss Fuse Tooling Tutorials, To Test a Route with JUnit



Chapter 9. The Source View




				The tooling's Source tab opens the route editor in Source view (Figure 9.1) to display the contents of an Apache Camel route file as XML.
			
Figure 9.1. Source view
[image: route editor's Source view]



				The Source view is useful for editing and adding any configuration, comments, or beans to the routing context file. The Content Assist functionality helps you when working with configuration files. In the Source view, press Ctrl+Space to see a list of possible values that can be inserted into your project.
			

				While the route editor allows you to change the contents of the camelContext element in the routing context file, not all changes are preserved. Comments inserted into the camelContext element are lost upon switching to Design view.
			

Chapter 10. Running routes inside Red Hat JBoss Fuse Tooling




				There are two basic ways to run your routes using the tooling:
			
	
						As a local camel context (with or without tests)
					

	
						Using Maven
					



Running routes as a local Camel context



Overview




					The simplest way to run an Apache Camel route is as a Local Camel Context. This method enables you to launch the route directly from Project Explorer's context menu. When you run a route from the context menu, the tooling automatically creates a runtime profile for you. You can also create a custom runtime profile for running your route.
				

					Your route runs as if it were invoked directly from the command line and uses Apache Camel's embedded Spring container. You can configure a number of the runtime parameters by editing the runtime profile.
				

Procedure




					To run a route as a local Camel context:
				
	
							In Project Explorer, select a routing context file.
						

	
							Right-click it to open the context menu, and then select Run As → Local Camel Context.
						
Note

								Selecting Local Camel Context (without tests) directs the tooling to run the project without performing validation tests, which may be faster.
							





Result




					The Console view displays the output generated from running the route.
				

Related topics



	the section called “Editing a Local Camel Context runtime profile”
	Red Hat JBoss Fuse Tooling Tutorials, To Run a Route



Running routes using Maven



Overview




					If the project containing your route is a Maven project, you can use the m2e plug-in to run your route. Using this option, you can execute any Maven goals, before the route runs.
				

Procedure




					To run a route using Maven:
				
	
							In Project Explorer, select the root of the project .
						

	
							Right-click it to open the context menu, and then select Run As → Maven build.
						

								
									The first time you run the project using Maven the Edit Configuration and launch editor opens, so you can create a Maven runtime profile.
								

									To create the runtime profile:
								
	
											Make sure the route directory of your Apache Camel project appears in the Base directory: field.
										

											For example on Linux the root of your project will be similar to ~/workspace/simple-router.
										

	
											In the Goals: field, enter camel:run.
										

	
											Click Apply and then Run.
										





							 	
									Subsequent Maven runs use this profile, unless you modify it between runs.
								



						




Results




					The Console view displays the output from the Maven run.
				

Related topics



	the section called “Editing a Maven runtime profile”



Working with runtime profiles




					Red Hat JBoss Fuse Tooling information about the runtime environments for each project in runtime profiles. The runtime profiles keep track of such information as which Maven goals to call, the Java runtime environment to use, any system variables that need to be set, and so on. A project can have more than one runtime profile.
				
Editing a Local Camel Context runtime profile



Overview




						A Local Camel Context runtime profile configures how Apache Camel is invoked to execute a route. A Local Camel Context runtime profile stores the name of the context file in which your routes are defined, the name of the main to invoke, the command line options passed into the JVM, the JRE to use, the classpath to use, any environment variables that need to be set, and a few other pieces of information.
					

						The runtime configuration editor for a Local Camel Context runtime profile contains the following tabs:
					
	
								Camel Context File—specifies the name of the new configuration and the full path of the routing context file that contains your routes.
							

	
								Main—specifies the fully qualified name of the project's base directory, a few options for locating the base directory, any goals required to execute before running the route, and the version of the Maven runtime to use.
							

	
								JRE—specifies the JRE and command line arguments to use when starting the JVM.
							

	
								Refresh—specifies how Maven refreshes the project's resource files after a run terminates.
							

	
								Environment—specifies any environment variables that need to be set.
							

	
								Common—specifies how the profile is stored and the output displayed.
							




						The first time an Apache Camel route is run as a Local Camel Context,  creates for the routing context file a default runtime profile, which should not require editing.
					

Accessing the Local Camel Context's runtime configuration editor





					
	
								In Project Explorer, select the camelContext file for which you want to edit or create a custom runtime profile.
							

	
								Right-click it to open the context menu, and then select Run As... → Run Configurations to open the Run Configurations dialog.
							

	
								In the context selection pane, select Local Camel Context, and then click 
								[image: New profile icon]
								 at the top, left of the context selection pane.
							

	
								In the Name field, enter a new name for your runtime profile.
							



Figure 10.1. Runtime configuration editor for Local Camel Context
[image: Local camel context runtime configuration editor]



Setting the camel context file




						The Camel Context File tab has one field, Select Camel Context file.... Enter the full path to the routing context file that contains your route definitions.
					

						The Browse... button accesses the Open Resource dialog, which facilitates locating the target routing context file. This dialog is preconfigured to search for files that contain Apache Camel routes.
					

Changing the command line options




						By default the only command line option passed to the JVM is:
					
-fa context-file

						If you are using a custom main class you may need to pass in different options. To do so, on the Main tab, click the Add button to enter a parameter's name and value. You can click the Add Parameter dialog's Variables... button to display a list of variables that you can select.
					

						To add or modify JVM-specific arguments, edit the VM arguments field on the JRE tab.
					

Changing where output is sent




						By default, the output generated from running the route is sent to the Console view. But you can redirect it to a file instead.
					

						To redirect output to a file:
					
	
								Select the Common tab.
							

	
								In the Standard Input and Output pane, click the checkbox next to the File: field, and then enter the path to the file where you want to send the output.
							

								The Workspace..., File System..., and Variables... buttons facilitate building the path to the output file.
							




Related topics



	the section called “Running routes as a local Camel context”



Editing a Maven runtime profile



Overview




						A Maven runtime profile configures how Maven invokes Apache Camel. A Maven runtime profile stores the Maven goals to execute, any Maven profiles to use, the version of Maven to use, the JRE to use, the classpath to use, any environment variables that need to be set, and a few other pieces of information.
					

						The runtime configuration editor for a Fuse runtime profile contains the following tabs:
					
	
								Main—specifies the name of the new configuration, the fully qualified name of the project's base directory, a few options for locating the base directory, any goals required to execute before running the route, and the version of the Maven runtime to use.
							

	
								JRE—specifies the JRE and command line arguments to use when starting the JVM.
							

	
								Refresh—specifies how Maven refreshes the project's resource files after a run terminates.
							

	
								Environment—specifies any environment variables that need to be set.
							

	
								Common—specifies how the profile is stored and the output displayed.
							




						The first time an Apache Camel route is run using Maven, you must create a default runtime profile for it.
					

Accessing the Maven runtime configuration editor





					
	
								In Project Explorer, select the root of the project for which you want to edit or create a custom runtime profile.
							

	
								Right-click it to open the context menu, and then select Run As... → Run Configurations to open the Run Configurations dialog.
							

	
								In the context selection pane, select m2 Maven Build, and then click 
								[image: New profile icon]
								 at the top, left of the context selection pane.
							



Figure 10.2. Runtime configuration editor for Maven
[image: Maven runtime configuration editor]



Changing the Maven goal




						The most commonly used goal when running a route is camel:run. It loads the routes into a Spring container running in its own JVM.
					

						The Apache Camel plug-in also supports a camel:embedded goal that loads the Spring container into the same JVM used by Maven. The advantage of this is that the routes should bootstrap faster.
					

						If your POM contains other goals, you can change the Maven goal used by clicking the Configure... button next to the Maven Runtime field on the Main tab. On the Installations dialog, you edit the Global settings for <selected_runtime> installation field.
					

Changing the version of Maven




						By default, the Red Hat JBoss Fuse Tooling for Eclipse uses m2e, which is embedded in Eclipse. If you want to use a different version of Maven or have a newer version installed on your development machine, you can select it from the Maven Runtime drop-down menu on the Main tab.
					

Changing where the output is sent




						By default, the output from the route execution is sent to the Console view. But you can redirect it to a file instead.
					

						To redirect output to a file:
					
	
								Select the Common tab.
							

	
								Click the checkbox next to the File: field, and then enter the path to the file where you want to send the output.
							

								The Workspace..., File System..., and Variables... buttons facilitate building the path to the output file.
							




Related topics



	the section called “Running routes using Maven”





Chapter 11. Using the JBoss Fuse SAP Tool Suite

Abstract

						The JBoss Fuse SAP Tool Suite makes it possible to integrate your Camel routes with a remote SAP Application Server. A variety of SAP components are provided to support Remote Function Calls (RFC) and the sending and receiving of Intermediate Documents (IDocs). Note that the SAP Tool Suite depends on the JCo and IDoc client libraries from SAP. You must have an SAP Service Marketplace Account, in order to install and use these libraries.
					




Installing the JBoss Fuse SAP Tool Suite



Overview




					The JBoss Fuse SAP Tool Suite provides a SAP Connections view for configuring SAP connections and a collection of SAP components for integrating your Camel routes with an SAP server. The suite is not installed by default, because it requires third-party Jco and IDoc client libraries, which are licensed separately by SAP.
				

Platform restrictions for SAP tooling




					Because the SAP tool suite depends on the third-party JCo 3.0 and IDoc 3.0 libraries, it can only be installed on the platforms that these libraries support. For more details about the platform restrictions for SAP tooling, see Red Hat JBoss Fuse Supported Configurations.
				

Prerequisites




					Before you can install the JBoss Fuse SAP Tool Suite, you must download the requisites JCo and IDoc libraries from the following location:
				
	
							http://service.sap.com/connectors
						




					Please note the following points:
				
	
							You will require an SAP Service Marketplace Account to download the JCo and IDoc client archives.
						

	
							Choose the appropriate JCo and IDoc libraries for your operating system.
						

	
							Only version 3.0.11 or greater of the JCo library is supported.
						

	
							Only version 3.0.10 or greater of the IDoc library is supported.
						

	
							For this installation procedure, you can leave the downloaded files in archive format. There is no need to extract the contents.
						




Procedure




					To install the JBoss Fuse SAP Tool Suite into JBoss Developer Studio, perform the following steps:
				
	
							In JBoss Developer Studio, select File → Import to open the Import wizard.
						

	
							In the Select screen of the Import wizard, select JBoss Fuse → Install JBoss Fuse SAP Tool Suite, and click Next.
						

	
							The Install the JBoss Fuse SAP Tool Suite screen opens, which displays the instructions for downloading the JCo and IDoc libraries from the SAP Service Marketplace. Click Next.
						

	
							The Select JCo3 and IDoc3 Archive to Import screen opens. Next to the JCo Archive File field, use the Browse button to select the JCo archive that you downloaded from the SAP Service Marketplace. After selecting the JCo archive, the Archive Version and Archive OS Platform fields are automatically filled in, so that you can check whether the library you are installing has the correct version and OS platform.
						

							Next to the IDoc3 Archive File field, use the Browse button to select the IDoc archive that you downloaded from the SAP Service Marketplace.
						

							After selecting both archive files, click Finish.
						

	
							A new Install wizard (for installing Eclipse plug-ins) opens automatically. This wizard displays the following to plug-ins to be installed:
						
	
									JBoss Fuse SAP Tool Suite
								

	
									SAP JCo3 and IDoc3 Libraries
								




							Make sure that both of these plug-ins are selected. Click Next.
						
Note

								The SAP JCo3 and IDoc3 Libraries plug-in is dynamically constructed from the selected JCo and IDoc libraries.
							


	
							The Install Details screen allows you to review the plug-ins to be installed. Click Next.
						

	
							The Review Licenses dialog opens. Select the I accept radiobutton option, and then click Finish.
						

	
							If you encounter a Security Warning dialog (warning of unsigned content), click OK to ignore the warning and continue installing.
						

	
							The Restart Eclipse dialog opens. Click OK to restart Eclipse.
						





Create and Test an SAP Destination Connection



Overview




					The JBoss Fuse SAP Tools Suite provides an SAP Connections view, which enables you to create and manage SAP destination connections and SAP server connections. This section describes how to create and test an SAP destination connection in the SAP Connections view.
				

Procedure




					To create and test an SAP destination connection, perform the following steps:
				
	
							If you have not already added the SAP Connections view to your perspective, select Window → Show View → Other to open the Show View dialog. Select SAP Connections and click OK. The SAP Connections view opens on the left of your perspective (under Project Explorer).
						

	
							In the SAP Connections view, right-click on Destination Data Store and select New Destination, to open the Create Destination dialog.
						

	
							Enter a name for the destination in the New Destination Name field and click OK.
						

	
							Select the newly created destination in the Destination Data Store tree, so that its properties show up in the Properties view.
						

	
							In the Properties view, click on the Basic tab to configure the basic properties required to connect to an SAP destination. In this tab, fill in the following property fields to configure the connection:
						
	
									SAP Application Server
								

	
									SAP System Number
								

	
									SAP Client
								

	
									Logon User
								

	
									Logon Password
								

	
									Logon Language
								




							These are standard SAP client connection properties. If you need more information about these settings, please consult the SAP documentation.
						

	
							You are now ready to test the destination connection. In the SAP Connection view, right-click on the destination name and select Test.
						

	
							The Test Destination Connection dialog opens. Click Test.
						

	
							The dialog uses the current destination configuration settings to connect to the SAP server. If the test is successful, you will see the following message in the status area:
						
Connection test for destination 'YourDestination' succeeded.

							Otherwise, an error report appears in the status area.
						

	
							Click Close, to close the Test Destination Connection dialog.
						





Create and Test an SAP Server Connection



Overview




					The JBoss Fuse SAP Tools Suite provides an SAP Connections view, which enables you to create and manage SAP destination connections and SAP server connections. This section describes how to create and test an SAP server connection in the SAP Connections view.
				

Procedure




					To create and test an SAP server connection, perform the following steps:
				
	
							If you have not already added the SAP Connections view to your perspective, select Window → Show View → Other to open the Show View dialog. Select SAP Connections and click OK. The SAP Connections view opens on the left of your perspective (under Project Explorer).
						

	
							In the SAP Connections view, right-click on Server Data Store and select New Server, to open the Create Server dialog.
						

	
							Enter a name for the server connection in the New Server Name field and click OK.
						

	
							Select the newly created server connection in the Server Data Store tree, so that its properties show up in the Properties view.
						

	
							In the Properties view, click on the Mandatory tab to configure the basic properties required for an SAP server connection. In this tab, fill in the following property fields to configure the connection:
						
	
									Gateway Host
								

	
									Gateway Port
								

	
									Program ID
								

	
									Repository Destination
								

	
									Connection Count
								




							In the Repository Destination field, you can fill in one of the destination names from the Destination Data Store tree (see the section called “Create and Test an SAP Destination Connection”). An SAP server endpoint uses this destination to retrieve meta-data from a remotely hosted meta-data repository.
						

							The other properties are standard SAP server connection properties. Please consult the SAP documentation for more information.
						

	
							You are now ready to test the server connection. In the SAP Connection view, right-click on the server connection name and select Test.
						

	
							The Test Server Connection dialog opens. Click Server.
						

	
							The dialog uses the current server configuration settings to start up a server endpoint and connect to the gateway host. If the test is successful, you will see the following messages in the status area:
						
Server state: STARTED
Server state: ALIVE

							If the test fails, the server status is reported as DEAD.
						

	
							Click Stop, to shut down the test server.
						

	
							Click Close, to close the Test Server Connection dialog.
						





Export SAP Connection Configuration to a File



Overview




					After creating some SAP destination connections (see the section called “Create and Test an SAP Destination Connection”) and SAP server connections (see the section called “Create and Test an SAP Server Connection”), you can export the SAP connection configuration to a file (either in Blueprint XML or Spring XML format). You will need this exported configuration data when you come to creating an SAP endpoint (the connection configuration is required in order to configure an SAP endpoint).
				

Procedure




					To export SAP connection configurations to a file, perform the following steps:
				
	
							In the SAP Connections view, right-click on Sap Connection Configuration and select Export to open the Export SAP Connection Configuration dialog.
						

	
							Enter the location of the export file in the Export Location field, either directly or using the Browse button.
						

	
							Select the Export File Type using the drop-down menu. The supported file types are: Blueprint XML or Spring XML. Select the file type that matches the file type you will use to create your Camel routes.
						

	
							Click Finish.
						





Create a New SAP Endpoint



Overview




					You can use the Components palette in the Camel editor to add SAP components to a route. But you must also remember to paste the requisite SAP connection configuration data into your Blueprint XML or Spring XML code.
				

Prerequisites




					You must already have created some SAP destination connections and/or server connections, and have exported this configuration to a file of the appropriate type (Blueprint XML or Spring XML). See the section called “Export SAP Connection Configuration to a File”.
				

Procedure




					To create a new SAP endpoint, perform the following steps:
				
	
							It is assumed that you already have a Fuse project and a Camel XML file to work with (which could either be in Blueprint XML or Spring XML format).
						

	
							Open your Camel XML file in the Camel editor. If you have already installed the JBoss Fuse SAP Tool Suite, you should be able to see the SAP components under the Components palette in the Camel editor. The following SAP components are provided by the tool suite:
						
	
									SAP IDoc Destination
								

	
									SAP IDoc List Destination
								

	
									SAP IDoc List Server
								

	
									SAP qRFC Destination
								

	
									SAP Queued IDoc Destination
								

	
									SAP Queued IDoc List Destination
								

	
									SAP sRFC Destination
								

	
									SAP sRFC Server
								

	
									SAP tRFC Destination
								

	
									SAP tRFC Server
								




							In the Design view of the Camel editor, drag one of these components onto the canvas to create a new SAP endpoint in the current camelContext.
						
Note

								The SAP Netweaver component does not belong to the JBoss Fuse SAP Tool Suite. It is hosted in the Apache Camel project.
							


	
							Switch to the Source view of the Camel editor, by clicking on the Source tab at the bottom of the canvas. In this view, you can see the XML source of the routes.
						

	
							Open an exported SAP connection configuration file that you exported earlier (see the section called “Export SAP Connection Configuration to a File”), making sure that the type of the exported SAP connection configuration file matches the type of your Camel XML file (Blueprint XML or Spring XML).
						

	
							The SAP connection configuration data is encoded as a bean element, with the id value, sap-configuration. Copy this bean element.
						

	
							Return to the Source view of the Camel editor. Paste the bean element as a child of the root beans element in the Camel XML file.
						

	
							You might not need all of the entries in the SAP connection configuration. Delete any unneeded destination connection and server connection entries (entry elements).
						
Note

								Remember that server connections usually also depend on a destination connection (for retrieving meta-data from a remote repository). So, even if you only need a server connection, do not delete all of the destination connection entries.
							


	
							When specifying an SAP endpoint URI, you must embed either a destination name or a server connection name in the URI format. For example, the sap-srfc-destination component has the following URI format:
						
sap-srfc-destination:destinationName:rfcName

							To reference a particular destination, use the value of the relevant entry element's key attribute as the destinationName in this URI.
						






Chapter 12. Getting Started with Data Transformation



Fuse Transformation Tooling




					One of the challenges that comes with system and data integration is that the component systems often work with different data formats. You cannot simply send messages from one system to another without translating it into a format (or language) recognized by the receiving system. Data transformation is the term given to this translation.
				

					The Fuse Transformation tooling provided with JBoss Fuse is a GUI to assist developers in implementing data translations as part of Camel routes.
				
Warning

						JBoss Fuse Transformation tooling is currently provided as a technical preview only, not suitable for production environments. For details on what "technical preview" means, see https://access.redhat.com/solutions/21101.
					


Your First Data Transformation




					In this tutorial you will learn how to use the tooling provided by JBoss Fuse to add a data transformation to a predefined Camel route. The Camel route used in this example directs messages from a source endpoint that produces XML data to a target endpoint that consumes JSON data. You will add a data transformation to map the XML data to JSON data in order for this route to work correctly.
				
 Prerequisites 
	
							JBoss Fuse tooling is installed on JBoss Developer Studio. See Install Red Hat JBoss Developer Studio Integration Stack.
						

	
							Maven is installed and configured correctly. See Red Hat JBoss Fuse Maven Repositories.
						

	
							You have downloaded the transformation quickstart applications for use with this technical preview.
						



 Procedure 
	Import the starter quickstart application in JBoss Developer Studio.
	
									Select File → Import. Expand Maven and select Existing Maven Projects, then select Next.
								

	
									You are prompted to select a Maven project to import. Select Browse and navigate to the root directory of the starter quickstart application, then select OK. Review the selection and select Finish. The starter application will appear in the Project Explorer.
								

	
									Expand the starter project in the Project Explorer and navigate to starter/src/main/resources/META-INF/spring/camel-context.xml. Open this file to view the Camel route. By default, the file is presented visually on the Design tab.
								
[image: Description]


									Select the Source tab to view the underlying XML. You can see that an XML file is produced from a source endpoint and a JSON file is consumed by a target endpoint.
								



	Add a data transformation to the Camel route.
	
									Select the Design view for the camel-context.xml file.
								

	
									Remove the arrow connecting the two endpoints.
								
Note

										Do not save your project at this point. If you save your project now, the endpoints will disappear.
									


	
									Click on the Transformation drawer in the Palette. Drag a Data Transformation endpoint onto the canvas.
								
[image: Description]


									This will invoke the New Transformation wizard. If the Palette is not yet visible, select Window → Show View → Other, then expand General and select Palette.
								

	
									In the New Transformation wizard, set the following values (leaving all other default values) then select Next.
								
	 Field 	 Value 
	 Transformation ID 	 xml2json 
	 Source Type 	 XML 
	 Target Type 	 JSON 



	
									Now you are prompted to provide the source type definition. You can do this by supplying either an XML Schema (default) or an example XML Instance Document. Leave the default option and browse to select a Source File. Choose abc-order.xsd, then select OK. You are provided with a preview of the XML. Select Next to continue.
								

	
									Now you are prompted to describe the target type definition in the same way. Browse to select a Target File. Choose xyz-order.json, then select OK. Because this is an example file, the JSON Type Definition is updated automatically to reflect this. Select Finish.
								



	You are now presented with the transformation editor with source fields on the left and target fields on the right. Map one set to the other. 
	
									Expand all of the fields on both sides of the transformation editor.
								

	
									Drag the source customerNum field from the left onto the target custId field on the right. The transformation (or mapping) will appear in the center.
								
[image: Description]


									Continue to map the fields as follows:
								
	 Source 	 Target 
	 orderNum 	 orderId 
	 status 	 priority 
	 item 	 lineItems 
	 id 	 itemId 
	 price 	 cost 
	 quantity 	 amount 





	Map any remaining fields.
	
									Click on Hide mapped fields for both source and target to determine whether all fields have been mapped.
								
[image: Description]


									You will find that the target approvalCode and origin fields remain unmapped.
								
[image: Description]


	
									Map the origin field to a constant variable: click on the Variables tab on the Source side. Select Add a new variable.
								
[image: Description]


	
									You are prompted to Enter a new variable name. Enter ORIGIN and select OK. The variable is created and appears on the left in the Variables window.
								

	
									Select the default value and change it to Web.
								
[image: Description]


	
									Drag the new variable onto the target origin field.
								
[image: Description]


	
									Associate the approvalCode field with a dynamic evaluation of a Camel language expression: select Add a new mapping.
								
[image: Description]


									An empty transformation is added.
								
[image: Description]


	
									Drag approvalCode from the target list into the target box of the empty transformation. You will notice that the selected transformation also appears in a window below. When you move your cursor over the source field in this view, an arrow appears. Select this arrow to open the menu from which you select Set expression.
								
[image: Description]


	
									You are prompted to select the expression language, and to enter an expression. Set the following values, then select OK:
								
	 Field 	 Value 
	 Language 	 Header 
	 Expression 	 ApprovalID 





	Connect the endpoints.
	
									Select the camel-context.xml tab to focus on the Camel route again.
								

	
									When you hover your cursor over each endpoint, you are presented with an option to Create connection.
								
[image: Description]


									Create a connection from the source endpoint to the transformation endpoint and then from the transformation endpoint to the target endpoint. Save your changes. The endpoints are automatically arranged horizontally.
								
[image: Description]




	Test your data transformation.
	
									Select File → New → Other. Expand Fuse Tooling and select Fuse Transformation Test, then select Next. This will invoke the New Transformation Test wizard.
								

	
									In the New Transformation Test wizard, set the following values:
								
	 Field 	 Value 
	 Package 	 example 
	 Transformation ID 	 xml2json 



	
									In the Project Explorer navigate to starter/src/test/java/example and then open the TransformationTest.java file.
								

	
									Add the following code to the transform method:
								
startEndpoint.sendBodyAndHeader(readFile("src/data/abc-order.xml"), "approvalID", "AUTO_OK");

	
									Ensure the TransformationTest.java file has focus, then select Run → Run As → JUnit Test.
								

	
									The output will be presented in the Console window. Here you can see both the source XML and the resulting target JSON.
								
Example 12.1. Source XML
<ABCOrder xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:java="http://java.sun.com">
    <header>
        <status>GOLD</status>
        <customer-num>ACME-123</customer-num>
        <order-num>ORDER1</order-num>
    </header>
    <order-items>
        <item id="PICKLE">
            <price>2.25</price>
            <quantity>1000</quantity>
        </item>
        <item id="BANANA">
            <price>1.25</price>
            <quantity>400</quantity>
        </item>
    </order-items>
</ABCOrder>


Example 12.2. Target JSON
{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","origin":"Web","approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},{"itemId":"BANANA","amount":400,"cost":1.25}]}









Part III. Debugging Routing Contexts





				The Camel debugger includes many features for debugging routing contexts: 
				
	
							Setting conditional and unconditional breakpoints on nodes in the route editor
						

	
							Autolaunching the debugger and switching to Debug Perspective
						

	
							Interacting with the running routing context:
						
	
									Switch between breakpoints to quickly compare variable values of message instances
								

	
									Examine and change the value of variables of interest
								

	
									Add variables of interest to the Watch list to track them throughout the debug session
								

	
									Disable and re-enable breakpoints on-the-fly
								

	
									Track message flow graphically in the routing context runtime
								

	
									Examine Console logs to track Camel and debugger actions
								








			
Note

					Before you can run the Camel debugger, you must set breakpoints on the nodes of interest displayed on the route editor's canvas. Once that's done, you can run the Camel debugger on a project's routing context .xml file to find the logic errors in it and fix them. Invoking the Camel debugger runs the routing context in debug mode and opens the Debug perspective (Chapter 2, Debug Perspective).
				



Chapter 13. Setting Breakpoints



Overview




				You can set breakpoints in either JBoss perspective or in Fuse Integration perspective, but JBoss perspective provides more room for expanding the route editor's canvas when building and modifying routes. To set breakpoints, your project's routing context .xml file must be open in the route editor's Design View.
			

				The Camel debugger supports two types of breakpoints:
			
	
						Unconditional breakpoints—triggered whenever one is encountered during a debugging session
					

	
						Conditional breakpoints—triggered only when the breakpoint's specified condition is met during a debugging session
					



Note

					You cannot set breakpoints on Consumer endpoints or on When or Otherwise nodes.
				

Note

					The Camel debugger requires the camelContext element and each node for which a breakpoint is set to have a unique ID. You can set IDs manually in a node's Properties editor or directly in the CamelContext file in Source view, or you can let Fuse Tooling generate and apply them automatically. The Please confirm... dialog opens whenever you set a breakpoint on a node that does not already have a unique ID.
				
[image: Overview]


Important

					Make sure you save any changes you make to your routing context file before you run the Camel debugger on it. Otherwise, your changes will not be included in the debugging session.
				


Setting unconditional breakpoints




				With your routing context displayed on the canvas in Design View:
			
	
						Select a node whose state you want to examine during the debugging session.
					

	
						Click its 
						[image: Setting unconditional breakpoints]
						 icon to set an unconditional breakpoint.
					

	
						In the Please Confirm... dialog, click OK to have the Route Editor automatically generate and apply a unique ID to the <camelContext> element and to the node or nodes that need it, or click Cancel if you want to manually enter unique IDs in the <camelContext> element and to each node that needs one.
					

	
						Repeat these steps for each node on which you want to set an unconditional breakpoint.
					




Setting conditional breakpoints




				With your routing context displayed on the canvas in Design View:
			
	
						Select a node whose state you want to examine during the debugging session.
					

	
						Click its 
						[image: Setting conditional breakpoints]
						 icon to set a conditional breakpoint and open the Edit the condition and language of your breakpoint... dialog.
					
[image: Setting conditional breakpoints]


	
						Click the Language drop-down menu and select the expression langauge to use to create the condition that will trigger the breakpoint.
					

						Fuse Tooling supports twenty expression languages from which to choose. Except for constant, method, property, and ref, each of these languages provides variables for creating conditional expressions.
					

	
						Click the Variables drop-down menu and select in sequence one or more of the language's supported variables to create the condition for triggering the breakpoint. The variables you select appear in the Condition text box.
					

						Alternatively, you can manually enter the expression directly into the Condition text box.
					

	
						Repeat steps Step 1 through Step 4 for each node on which you want to set a conditioanl breakpoint.
					




Disabling breakpoints




				You can temporarily disable a breakpoint, leaving it in place, then enable it again later. The 
				[image: Disabling breakpoints]
				 button skips over disabled breakpoints during debugging sessions.
			

				To disable a breakpoint, select the node on the canvas and click its 
				[image: Disabling breakpoints]
				 icon. The breakpoint turns gray, indicating it has been disabled.
			

				To enable a disabled breakpoint, select the node on the canvas and click its 
				[image: Disabling breakpoints]
				 icon. Depending on whether the disabled breakpoint is conditional or unconditional, it turns yellow or red, respectively, to indicate it has been re-enabled.
			
Note

					You can also disable and re-enable breakpoints during debugging sessions. For details, see Chapter 18, Disabling Breakpoints in a Running Context.
				


Deleting breakpoints




				You can delete individual breakpoints or all breakpoints.
			
	
						Individual breakpoints—on the canvas, select the node whose breakpoint you want to delete, and click its 
						[image: Deleting breakpoints]
						 icon.
					

	
						All breakpoints—right-click the canvas, and select  [image: Deleting breakpoints]
						 Delete all breakpoints.
					




Related topics



	 Chapter 14, Starting the Camel Debugger 
	 chapter "To Debug a Routing Context" in "Tooling Tutorials" 



Chapter 14. Starting the Camel Debugger



Overview



Note

					You must set breakpoints in your routing context file before you can start the Camel debugger.
				


				You run the Camel debugger on the routing context file, so be sure to save any changes you made to the file before you invoke the debugger. Otherwise your changes will not be included in the debugging session.
			

Procedure



	
						In Project Explorer, select the routing context file you want to debug.
					

	
						Right-click it to open the context menu, and then select Debug As... → Local Camel Context.
					

						Fuse Tooling builds the Camel route, starts up Apache Camel, starts the routing context, enables JMX, starts the route(s) in the routing context, adds the breakpoints to the nodes, and enables the Camel debugger.
					

						The Camel debugger suspends execution of the routing context at the first breakpoint it encounters, and asks whether you want it to open the Debug perspective.
					
[image: Procedure]


	
						Click Yes to open Debug perspective.
					

						Debug perspective opens with the routing context suspended at the first breakpoint in the running routing context.
					
Important

							Breakpoints are held for a maximum of five minutes, after which debugging automatically resumes, moving on to the next breakpoint or to the end of the routing context if there are no more breakpoints.
						

[image: Procedure]

Note

							To see the console output, you'll need to open Console view if it was not open when you switched perspectives.
						

Note

							By default, Debug perspective opens displaying Outline view, which provides the means to switch between separate routes in a routing context. If your routing context contains a single route, closing Outline view will provide more space to expand the other views, making it easier to access and examine debugger output.
						





Watching message exchanges progress through the routing context




				Click 
				[image: Watching message exchanges progress through the routing context]
				 (Step Over) to jump to the next node of execution in the routing context. Click 
				[image: Watching message exchanges progress through the routing context]
				 (Resume) to continue execution at the next active breakpoint in the routing context.
			
[image: Watching message exchanges progress through the routing context]


Related topics



	 Chapter 15, Stopping the Camel Debugger 
	 chapter "To Debug a Routing Context" in "Tooling Tutorials" 



Chapter 15. Stopping the Camel Debugger



Overview




				To stop the Camel debugger, click 
				[image: Terminate button]
				 on the menu bar once if the debugging session has ended. Otherwise you need to click 
				[image: Terminate button]
				 twice. Once to terminate the currently running node thread and once to terminate the Camel Context thread (both displayed in Debug view).
			
Note

					Terminating the Camel debugger also terminates the Console but does not clear its output. To clear the output, click 
					[image: Overview]
					 (Clear Console) on Console view's menu bar.
				


Terminating the Camel Debugger before the session ends




				Terminating the debugger before the debugging session ends may add extraneous entries to some of the project's folders in Project Explorer. You may see message lock files or target/.CamelContextInDebug_xxxxxxxx_temp/camel-context.xml lines in the root project's src/main/resources/framework-INF/framework_name folder. InFuse Integration perspective, You may also see them in the project's Camel Contexts folder.
			

				To clear them, right-click the root project, and then select Refresh.
			

Related topics



	 Chapter 14, Starting the Camel Debugger 
	 chapter "To Debug a Routing Context" in "Tooling Tutorials" 



Chapter 16. Changing Variable Values



Overview




				When the Camel debugger hits a breakpoint, Variables view displays the values of all variables available at that point in the routing context. Some variables are editable, allowing you to change their value. This enables you to see how the application handles changes in program state.
			
Note

					Not all variables are editable. The context menu of those that are displays the option, Change Value....
				


Procedure




				To change the value of a variable:
			
	
						If necessary, start up the debugger. See Chapter 14, Starting the Camel Debugger.
					

	
						In Variables view, select a variable whose value you want to change, and then click its Value field.
					
[image: Procedure]


						The variable's value field turns a lighter shade of blue, indicating it is in edit mode.
					
Note

							Alternatively, you can right-click the variable to open its context menu, and select Change Value... to edit its value.
						


	
						Enter the new value and then click Enter.
					

						Console view displays an INFO level log entry noting the change in the variable's value (for example, Breakpoint at node to1 is updating message header on exchangeId: ID-dhcp-97-16-bos-redhat-com-52574-1417298894070-0-2 with header: Destination and value: ChangedTarget).
					

	
						Continue stepping through the breakpoints and check whether the message is processed as expected. At each step, check Debug view, Variables view, and the Console output.
					




Related topics



	 Chapter 18, Disabling Breakpoints in a Running Context 
	 Chapter 17, Adding Variables to the Watch List 
	 chapter "To Debug a Routing Context" in "Tooling Tutorials" 



Chapter 17. Adding Variables to the Watch List



Overview




				By adding them to the watch list, you can easily zero in on particular variables to see whether their values change as expected over the course of the routing context.
			

Procedure




				To add a variable to the watch list:
			
	
						If necessary, start up the debugger. See Chapter 14, Starting the Camel Debugger.
					

	
						In Variables view, right-click a variable you want to track to open the context menu.
					
[image: Procedure]


	
						Select Watch.
					

						A new tab, Expressions, appears next to the Breakpoints tab.
					

	
						Click the Expressions tab to open it.
					
[image: Procedure]


						Expressions view displays the name of the added variable and its current value.
					

	
						Repeat Step 2 through Step 4 to add additional variables to the Watch list.
					
Note

							The variables you add will remain in the watch list until you remove them. To do so, right-click a variable in the list to open the context menu, and then click Remove.
						


	
						With Expressions view open, step through the routing context to track how the value of each variable in the Watch list changes at each step in the routing context.
					




Related topics



	 Chapter 16, Changing Variable Values 



Chapter 18. Disabling Breakpoints in a Running Context



Overview




				You can disable and re-enable breakpoints in a running routing context in either Breakpoints view or on the canvas of the running CamelContext: <xxxxxx>. You can delete and reset a deleted breakpoint only on the canvas of the running CamelContext: <xxxxxx>.
			
Note

					The string <xxxxxx> represents the ID that you or the debugger assigned to the camelContext element in the project's routing context file.
				


				When a breakpoint is disabled, the 
				[image: Overview]
				 button causes the debugger to skip over it during the debugging session.
			

Disabling and enabling breakpoints in Breakpoints view




				Breakpoints view opens with all set breakpoints enabled.
			
[image: Disabling and enabling breakpoints in Breakpoints view]


				To disable a breakpoint, clear its check box.
			
[image: Disabling and enabling breakpoints in Breakpoints view]


				For each breakpoint you disable, Console view displays an INFO level log entry noting that it has been disabled (for example, Removing breakpoint to3). Likewise, for each breakpoint you re-enable, Console view displays an INFO level log entry noting that it has been enabled (for example, Adding breakpoint to3).
			
Note

					To re-enable a disabled breakpoint, click its check box. Console view displays an INFO level log entry noting that the breakpoint has been added to the selected node.
				


Disabling and enabling breakpoints on the running CamelContext: canvas




				Make sure the routing context running in memory, CamelContext: <xxxxxx>, is active on the canvas.
			
	
						On the canvas, select the node with the breakpoint you want to disable; for example:
					
[image: Disabling and enabling breakpoints on the running CamelContext: canvas]

Note

							The 
							[image: Disabling and enabling breakpoints on the running CamelContext: canvas]
							 icon denotes an unconditional breakpoint. A 
							[image: Disabling and enabling breakpoints on the running CamelContext: canvas]
							 icon denotes a conditional breakpoint.
						


	
						Click the 
						[image: Disabling and enabling breakpoints on the running CamelContext: canvas]
						 icon in the node's side bar.
					

						The 
						[image: Disabling and enabling breakpoints on the running CamelContext: canvas]
						 icon replaces the 
						[image: Disabling and enabling breakpoints on the running CamelContext: canvas]
						 icon in the node's upper left corner, indicating that the breakpoint is now disabled:
					
[image: Disabling and enabling breakpoints on the running CamelContext: canvas]


						The node's check box in Breakpoints view is clear, also indicating that the breakpoint is disabled:
					
[image: Disabling and enabling breakpoints on the running CamelContext: canvas]


						Console view contains a log of the event:
					
[image: Disabling and enabling breakpoints on the running CamelContext: canvas]

Note

							To re-enable the breakpoint, select the node, and then click the 
							[image: Disabling and enabling breakpoints on the running CamelContext: canvas]
							 icon in its side bar.
						





Deleting and resetting breakpoints on the running CamelContext: canvas




				You can delete and reset deleted breakpoints only on the running CamelContext: <xxxxxx> canvas.
			
	
						On the CamelContext: <xxxxxx> canvas, select the node whose breakpoint you want to delete; for example, setHead_usa:
					
[image: Deleting and resetting breakpoints on the running CamelContext: canvas]


						Note that the node's breakpoint is enabled in Breakpoints view.
					
Note

							In the above graphic, the dotted red line surrounding the setHead_usa node identifies the breakpoint on which the debugger is currently suspended.
						


	
						Click the 
						[image: Deleting and resetting breakpoints on the running CamelContext: canvas]
						 icon in the node's side bar:
					
[image: Deleting and resetting breakpoints on the running CamelContext: canvas]


						The breakpoint is removed from the node on the canvas and also from the list of breakpoints in Breakpoints view:
					
[image: Deleting and resetting breakpoints on the running CamelContext: canvas]

Note

							To reset the breakpoint, select the node, and then click the 
							[image: Deleting and resetting breakpoints on the running CamelContext: canvas]
							 or 
							[image: Deleting and resetting breakpoints on the running CamelContext: canvas]
							 icon in its side bar, depending on whether you want to set an unconditional or conditional breakpoint.
						





Related topics



	 Chapter 13, Setting Breakpoints 
	 the section called “Disabling breakpoints” 
	 the section called “Deleting breakpoints” 
	 chapter "To Debug a Routing Context" in "Tooling Tutorials" 



Part IV. Monitoring and Testing Applications





				To open Fuse Integration perspective (Chapter 3, Fuse Integration Perspective), click 
				[image: Monitoring and Testing Applications]
				 on the right side of the JBoss Developer Studio tool bar. If the 
				[image: Monitoring and Testing Applications]
				 icon is not available on the tool bar, click 
				[image: Monitoring and Testing Applications]
				 and then select Fuse Integration from the list of available perspectives.
			


Chapter 19. JMX Navigator




				JMX Navigator, shown in Figure 19.1, displays all of the processes running in your application and drives all interactions with the monitoring and testing features. Other areas of the Fuse Integration perspective adapt to display information related to the node selected in JMX Navigator. JMX Navigator's context menu also provides the commands needed to activate route tracing and to add JMS destinations.
			
Figure 19.1. JMX Navigator
[image: JMX Navigator window]



				By default, JMX Navigator discovers all of the JMX servers running on the local machine and lists them under the lists them following categories: 
				
	
							Local Processes
						

	
							Server Connections
						

	
							User-defined connections
						





			

				You can add other JMX servers using a server's JMX URL.
			
Viewing Processes in JMX



Overview




					JMX Navigator lists all known processes in a series of trees. The root for each tree is a JMX server.
				

					The first tree in the list is a special Local Processes tree that contains all of the JMX servers running on the local machine. You must connect to one of the JMX servers to see the processes it contains.
				

Viewing processes in a local JMX server




					To view information about processes in a local JMX server:
				
	
							Expand the Local Processes entry in JMX Navigator.
						

	
							Double-click one of the top-level entries under Local Processes to connect to the JMX server.
						

	
							Double-click it to open a connection.
						

	
							Click the  [image: expansion arrow]
							  icon that appears next to the entry to display the list of all components running in the JVM.
						




Viewing processes in alternate JMX servers




					To view information about processes in an alternate JMX server:
				
	
							Add the JMX server to JMX Navigator.
						

	
							Expand the server's entry in JMX Navigator using the 
							[image: expansion arrow]
							 icon that appears next to the entry to display the list of all components running in the JVM.
						





Adding a JMX server



Overview




					JMX Navigator lists all of the local JMX servers under the Local Processes branch of the tree. You may need to connect to specific JMX servers to see components deployed on other machines.
				

					To add a JMX server you need to know the JMX URL of the server you want to add.
				

Procedure




					To add a JMX server to the JMX Navigator:
				
	
							Click New Connection [image: Procedure]
							 on the JMX Navigator tab .
						

	
							In the Create a new JMX connection wizard, select Default JMX Connection.
						

	
							Click Next>.
						

	
							Select the Advanced tab.
						

	
							In the Name field, enter a name for the JMX server.
						

							The name can be any string. It is used to label the entry in the JMX Navigator tree.
						

	
							In the JMX URL field, enter the JMX URL of the server.
						

	
							If the JMX server requires authentication, enter your user name and password in the Username and Password fields.
						

	
							Click Finish.
						

							The new JMX server is displayed as a branch in the JMX Navigator tree.
						






Chapter 20. Viewing a component's properties



Overview




				The tooling collects and displays all of the JMX properties reported by Fuse components. This information can provide significant insight into what is happening in your integration application.
			

Procedure




				To see a Fuse component's properties:
			
	
						Locate the node for the component in the .
					

						You may have to expand nodes on the tree to locate low-level components.
					

	
						Select the Fuse component's node from the tree.
					

	
						Open the Properties view.
					

						The selected component's properties will be displayed in table format.
					

						You can use the Search box in Properties view to locate specific properties based on value.
					





Chapter 21. Browsing messages



Overview




				A key tool in debugging applications in a distributed environment is seeing all of the messages stored in the JMS destinations and route endpoints in the application. The tooling can browse the following:
			
	
						JMS destinations
					

	
						JMS routing endpoints
					

	
						Apache Camel routing endpoints
					

	
						SEDA routing endpoints
					

	
						Browse routing endpoints
					

	
						Mock routing endpoints
					

	
						VM routing endpoints
					

	
						DataSet routing endpoints
					




Procedure




				To browse messages:
			
	
						Select the JMS destination or endpoint from .
					

						The list of messages is displayed in the Messages View.
					

	
						Select an individual message to inspect from the list of messages in the Messages View.
					

						Message details and content are displayed in the Properties view.
					




Related topics



	 the section called “Tracing messages through a route” 



Chapter 22. Tracing Routes




				Debugging a route usually involves solving one of two problems:
			
	
						a message was improperly transformed
					

	
						a message failed to reach its destination endpoint
					




				Tracing one or more test messages through the route is the easiest way to discover the source of these problems.
			

				The route tracing feature of the tooling enables you to monitor the path a message takes through a route and see how the message is transformed as it passes from processor to processor.
			

				Diagram View displays a graphical representation of the route, which enables you to see the path a message takes through it. For each processor in a route, it also displays the average processing time, in milliseconds, for all messages processed since route start-up and the number of messages processed since route start-up.
			

				Messages View displays the messages processed by a JMS destination or route endpoint selected in the JMX Navigator tree. Selecting an individual message in Messages View displays the full details and content of the message in Properties view.
			

				Tracing messages through a route involves the following steps:
			
	
						Creating test messages for route tracing
					

	
						Activating route tracing
					

	
						Tracing messages through a route
					

	
						Deactivating route tracing
					



Creating test messages for route tracing



Overview




					Route tracing works with any kind of message structure. The Fuse Message wizard creates an empty message, leaving the structuring of the message entirely up to you.
				

Procedure




					To create a test message:
				
	
							In Project Explorer, right-click the project to open the context menu.
						

	
							Select New → Fuse Message to open the New File wizard.
						

	
							Enter or select the folder in which you want to store the message.
						

	
							In the File name field, enter a name for the message.
						

	
							Click Finish.
						

							The new message opens in the XML editor.
						

	
							Fill in the contents (body and header text) of the message.
						

	
							On the menu bar, click File → Save to save the test message.
						




Related topics



	the section called “Tracing messages through a route”
	New Fuse Message
	 chapter "To Trace a Message Through a Route" in "Tooling Tutorials" 



Activating route tracing



Overview




					Before you can trace messages through a route, you must activate route tracing for the route's routing context.
				

Procedure




					To start tracing on a routing context:
				
	
							In the  tree, select the routing context on which you want to start tracing.
						

							You can select any route in the context to start tracing on the entire context.
						

	
							Right-click it to open the context menu, and then select Start Tracing to start the trace.
						

							If Stop Tracing Context is enabled on the context menu, then tracing is already active.
						




Related topics



	the section called “Tracing messages through a route”
	the section called “Deactivating route tracing”



Tracing messages through a route



Overview




					The best way to see what's happening in a route is to watch what happens to a message at each stop along the route. The tooling provides a mechanism for dropping messages into a route and tracing the message's path through it.
				

Procedure




					To trace messages through a route:
				
	
							Create one or more test messages as described in the section called “Creating test messages for route tracing”.
						

	
							Activate tracing for the route's routing context as described in the section called “Activating route tracing”.
						

	
							Drag one of the test messages onto the route's starting point.
						

	
							In the  tree, select the route being traced.
						

							The Messages View is populated with a list of messages representing the message at each stage in the traced route.
						

	
							Open Diagram View to see a graphical representation of the selected route.
						

	
							In the Messages View, select one of the messages.
						

							In Diagram View, the route step in which the selected message is sitting is highlighted. The Properties view displays the full details and content of the test message.
						




					You can repeat this process as needed.
				

Related topics



	the section called “Creating test messages for route tracing”
	the section called “Activating route tracing”
	the section called “Deactivating route tracing”
	 chapter "To Trace a Message Through a Route" in "Tooling Tutorials" 



Deactivating route tracing



Overview




					When you are finished debugging the routes in a routing context, you should deactivate tracing for the routing context.
				
Important

						Deactivating tracing stops tracing and flushes the trace data for all of the routes in the routing context. This means that you cannot review any past tracing sessions.
					


Procedure




					To stop tracing for a routing context:
				
	
							In the  tree, select the routing context for which you want to deactivate tracing.
						

							You can select any route in the context to stop tracing for the context.
						

	
							Right-click it to open the context menu, and then select Stop Tracing Context.
						

							If Start Tracing appears on the context menu, tracing is not activated for the routing context.
						




Related topics



	the section called “Activating route tracing”
	the section called “Tracing messages through a route”




Chapter 23. Managing JMS destinations




				The tooling's Fuse JMX Navigator allows you to easily add or delete JMS destinations from a running Red Hat JBoss Fuse A-MQ.
			
Important

					These changes are not persistent across broker restarts.
				

Adding a JMS destination



Overview




					When testing a new scenario, it is convenient to add a new JMS destination to one of your brokers. The tooling provides a menu choice for adding a destination with a single click.
				

Procedure




					To add a JMS destination to a broker:
				
	
							In the Fuse JMX Navigator tree, select either the Queues child or the Topics child in the broker node where you want to add a destination.
						

	
							Right-click it to open the context menu, and then select Create Queue/Topic.
						

	
							In the naming dialog, enter a name for the destination.
						

	
							Click OK.
						

							The new destination appears in the tree.
						




Related topics



	the section called “Deleting a JMS destination”



Deleting a JMS destination



Overview




					When testing fail over scenarios or other scenarios that involve failure handling, it's convenient to be able to easily remove a JMS destination. The tooling has a menu option that allows you to remove a destination with a single click.
				

Procedure




					To delete a JMS destination:
				
	
							In the Fuse JMX Navigator tree, select the JMS destination you want to delete.
						

	
							Right-click it to open the context menu, and then select Delete Queue/Topic.
						




Related topics



	the section called “Adding a JMS destination”




Chapter 24. Managing routing endpoints




				JMX Navigator allows you to easily add or delete routing endpoints.
			
Important

					These changes are not persistent across router restarts.
				

Adding a routing endpoint



Overview




					When testing a new scenario, it is convenient to add a new endpoint to a routing context. The tooling provides a menu choice for adding a routing endpoint with a single click.
				

Procedure




					To add an endpoint to a routing context:
				
	
							In the JMX Navigator tree, select the Endpoints child in the routing context node where you want to add an endpoint.
						

	
							Right-click it to open the context menu, and then select Create Endpoint.
						

	
							In the naming dialog, enter a URL defining the new endpoint.
						

	
							Click OK.
						

							The new destination appears in the tree.
						




Related topics



	the section called “Deleting a routing endpoint”



Deleting a routing endpoint



Overview




					When testing fail over scenarios or other scenarios that involve failure handling, it is convenient to be able to easily remove an endpoint from a routing context. The tooling has a menu option that allows you to remove an endpoint with a single click.
				

Procedure




					To delete a routing endpoint:
				
	
							In the JMX Navigator tree, select the endpoint you want delete.
						

	
							Right-click it to open the context menu, and then select Delete Endpoint.
						




Related topics



	the section called “Adding a routing endpoint”




Chapter 25. Editing running routes



Overview




				If you want to experiment with changes to a running route, you can make the edits directly from the Fuse Integration perspective. The tooling opens the context file containing the route in the route editor. When your changes are saved, they take effect immediately.
			

				The changes are made to the in-memory model of the running context, but are not persisted as part of their original project or any other project.
			
Note

					If you want to save the changes permanently, you must use the Save As menu option.
				


Procedure




				To edit a running route:
			
	
						In the JMX Navigator tree, select the context containing the route(s) you want to edit.
					

	
						Right-click to open the context menu, and select Edit Routes.
					

						Route editor displays the context and all of its routes.
					

	
						Edit the route(s) as described in Part II, “Developing Applications”.
					

	
						When done, save the edited route.
					

							
								Select File → Save to update the in-memory version of the routing context.
							

								Changes take effect immediately.
							


						 	
								>Select File → Save As to save the edited routing context in a new context file.
							



					




Related topics



	 the section called “Adding routes to the routing context” 
	 the section called “Adding patterns to a route” 
	 the section called “Configuring a pattern” 
	 the section called “Connecting patterns to make a route” 
	 the section called “Rearranging patterns on the canvas” 
	 the section called “Removing patterns from a route” 
	 the section called “Disconnecting two patterns” 
	 the section called “Deleting a route” 



Chapter 26. Managing routing contexts




				JMX Navigator enables you to easily suspend and resume routing contexts.
			
Suspending a routing context



Overview




					The tooling enables you to suspend the operation of a routing context from JMX Navigator. Suspending a context gracefully shuts down all of the routes in the context, but keeps them loaded in memory so that they can easily be resumed.
				

Procedure




					To suspend a routing context:
				
	
							In the JMX Navigator tree, expand the project's Camel Contexts node, and select the routing context you want to suspend.
						

	
							Right-click it to open the context menu, and then select Suspend Camel Context.
						
Note

								If Resume Camel Context appears on the context menu, the context is already suspended.
							





Related topics



	the section called “Resuming a routing context”



Resuming a routing context



Overview




					The tooling enables you to resume a suspended routing context from JMX Navigator. Resuming a context restarts all of the routes in it, so that they can process messages.
				

Procedure




					To resume a routing context:
				
	
							In the JMX Navigator tree, expand the project's Camel Contexts node, and select the routing context you want to resume.
						

	
							Right-click it to open the context menu, and then select Resume Camel Context.
						
Note

								If Suspend Camel Context appears in the context menu, the context and its routes are running.
							





Related topics



	the section called “Suspending a routing context”




Part V. Publishing Applications to a Container





				To publish Fuse projects to a server container, you must first add the server and its runime definition to the tooling's Servers list. Then you can assign Fuse projects to the server runtime and set the publishing options for it.
			

				You manage servers and publish Fuse projects to them in Fuse Integration perspective (for an overview, see Chapter 3, Fuse Integration Perspective). To open Fuse Integration perspective, click 
				[image: Publishing Applications to a Container]
				 on the right side of the JBoss Developer Studio tool bar. If the 
				[image: Publishing Applications to a Container]
				 icon does not appear on the tool bar, click 
				[image: Publishing Applications to a Container]
				 and then select Fuse Integration from the list of available perspectives.
			


Chapter 27. Managing servers




				The Servers panel enables you to run and manage servers in your Red Hat Developer Studio environment. The supported servers are:
			
	
						Red Hat JBoss Fuse Server—versions 6.x
					

	
						Apache Karaf Server—versions 2.x, 3.0
					

	
						Apache ServiceMix Server—versions 4.5, 5.x
					



Note

					For step by step instructions on how to publish a Camel project to Red Hat JBoss Fuse, see Red Hat JBoss Fuse Tooling Tutorials, To Publish a Fuse Project to Red Hat JBoss Fuse.
				

Adding a Server



Overview




					For the tooling to manage a server, you need to add the server to the Servers list. Once added, the server appears in Servers panel, where you can connect to it and publish your Fuse projects.
				
Note

						If adding a Red Hat JBoss Fuse 6.0 or 6.1 server, it's recommended that you edit its installDir/etc/users.properties file and add user information, in the form of user=password,role, to enable the tooling to establish an SSH connection to the server.
					


Procedure




					You can add a new server to the Servers panel in three ways:
				
	
							In Servers panel, click the link No servers are available. Click this link to create a new server....
						
Note

								This link appears in Servers panel only when no server has been defined.
							


	
							Right-click in Servers panel to open the context menu, then select New → Server.
						

	
							On the menu bar, select File → New → Other → Server → Server.
						



	
							In the Define a New Server dialog, expand the JBoss Fuse node to expose the list of available server options:
						
[image: Procedure]


	
							Click the server you want to add.
						

	
							In Server's host name, accept the default (localhost).
						
Note

								The address of localhost is 0.0.0.0.
							


	
							In Server name, accept the default, or enter a different name for the runtime server.
						

	
							Click Next > to open the server's Runtime definition page:
						
[image: Procedure]

Note

								If the server is not already installed on your machine, you can install it now by clicking the link Download and install runtime... and following the site's download instructions. Depending on the site, you may be required to provide valid credentials before you can continue the download process.
							


	
							Accept the default for Name.
						

	
							In Home Directory, enter the path where the server runtime is installed, or click Browse to find and select it.
						

	
							Select the runtime JRE from the drop-down menu next to Execution Environment.
						

							If the version you want does not appear on the list, click the Environments button and select the version from that list. The JRE version you select must be installed on your machine.
						
Note

								JBoss Fuse 6.2 requires either JRE versions 1.7 or 1.8.
							


	
							Leave the Alternate JRE option as is.
						

	
							Click Next > to save the server's runtime definition and open its Configuration details page:
						
[image: Procedure]


	
							Accept the default for SSH Port (8101).
						

							The runtime uses the SSH port to connect to the server's Karaf shell. If this default is incorrect for your setup, you can discover the correct port number by looking in the server's installDir/etc/org.apache.karaf.shell.cfg file.
						

	
							In User Name, enter the name used to log into the server.
						

							In the case of Red Hat JBoss Fuse, this is a user name stored in the Red Hat JBoss Fuse installDir/etc/users.properties file.
						
Note

								If the default user has been activated (uncommented) in the /etc/users.properties file, the tooling autofills User Name and Password with the default user's name and password, as shown in Step 10. The default user is already activated in JBoss Fuse 6.2, but not in JBoss Fuse 6.0 or 6.1.
							


							If one has not been set, you can either add one to that file using the format user=password,role (for example, joe=secret,Administrator), or you can set one using the karaf jaas command set: 
							
	
										jaas:realms—to list the realms
									

	
										jaas:manage --index 1—to edit the first (server) realm
									

	
										jaas:useradd <username> <password>—to add a user and associated password
									

	
										jaas:roleadd <username> Administrator—to specify the new user's role
									

	
										jaas:update—to update the realm with the new user information
									





						

							If a jaas realm has already been selected for the server, you can discover the user name by issuing the command JBossFuse:karaf@root>jaas:users.
						

	
							In Password, enter the password required for User Name to log into the server.
						

	
							Click Finish.
						

							The server runtime will appear in Servers panel. For example:
						
[image: Procedure]


							Expanding the server node exposes the server's JMX node:
						
[image: Procedure]





Related topics



	 Define a New Server 
	 New Server Configuration 
	 Add and Remove 



Starting a Server



Overview




					When you start a configured server, the tooling opens the server's remote management console in a Shell panel. This allows you to easily manage the container while testing your application.
				

Procedure




					To start a server:
				
	
							In the Servers panel, select the server you want to start.
						

	
							Click 
							[image: run button]
							 .
						
	
									Console view opens and displays a message asking you to wait while the container is starting; for example:
								
[image: Procedure]

Note

										If you did not properly configure the user name and password for opening the remote console, a dialog opens asking you to enter the proper credentials. See the section called “Adding a Server”.
									


	
									After the container has started up, Shell view opens to display the container's management console; for example:
								
[image: Procedure]


	
									The running server appears in Servers panel:
								
[image: Procedure]


	
									The running server also appears in JMX Navigator under Server Connections:
								
[image: Procedure]









Connecting to a Running Server



Overview




					After you start up a configured server, it appears in Servers panel and in JMX Navigator, under the ServerConnections node. You may need to expand the Server Connections node to see the server.
				

					To publish and test your Fuse project application on the running server, you must first connect to it. You can connect to a running server either in Servers panel or in JMX Navigator.
				
Note

						Servers panel and JMX Navigator are synchronized with regards to server connections, so connecting to a server in Servers panel also connects it in JMX Navigator, and vice versa.
					


Connecting to a running server in Servers panel



	
							In Servers panel, expand the server runtime to expose its JMX[Disconnected] node.
						

	
							Double-click the JMX[Disconnected] node:
						
[image: Connecting to a running server in Servers panel]





Connecting to a running server in JMX Navigator



	
							In JMX Navigator, select the server to which you want to connect under the Server Connections node.
						

	
							Double-click it:
						
[image: Connecting to a running server in JMX Navigator]





Viewing bundles installed on the connected server



	
							In either the Servers panel or JMX Navigator, expand the server runtime tree to expose the Bundles node, and select it.
						

	
							The tooling populates Properties view with a list of bundles that are installed on the server:
						
[image: Viewing bundles installed on the connected server]


							Using Properties view's Search tool, you can search for bundles by their Symbolic Name or by their Identifier, if you know it. As you type in the symbolic name or the identifier, the list updates, showing only the bundles that match the current search string.
						
Note

								The Symbolic Name is the artifactId that you gave the project when you first created it. You can find the artifactId in the project's pom.xmlfile.
							






Disconnecting from a Server



Overview




					When you are done testing your application, you can disconnect from the server without stopping it.
				
Note

						Servers panel and JMX Navigator are synchronized with regards to server connections, so disconnecting from a server in Servers panel also disconnects it in JMX Navigator, and vice versa.
					


Disconnecting from a server in Servers panel



	
							In Servers panel, expand the server runtime to expose its JMX[Connected] node.
						

	
							Right-click the JMX[Connected] node to open the context menu, and then select Disconnect.
						
[image: Disconnecting from a server in Servers panel]





Disconnecting from a server in JMX Navigator



	
							In JMX Navigator, select the server from which you want to disconnect.
						

	
							Right-click it to open the context menu, and then select Disconnect.
						
[image: Disconnecting from a server in JMX Navigator]






Stopping a Server



Overview




					You can shut down a server in one of two ways:
				
	
							from Servers panel
						

	
							from the server's remote console in Shell view
						




Using Servers panel




					To stop a server:
				
	
							In Servers panel, select the server you want to stop.
						

	
							Click 
							[image: stop button]
							 .
						




Using the remote console




					To stop a server:
				
	
							Open the Shell view hosting the server's remote console.
						

	
							Type CTRL+D.
						





Deleting a Server



Overview




					When you are finished with a configured server, or if you misconfigure a server, it is easy to delete it and it's configuration.
				

Deleting a server



	
							In Servers panel, right-click the server you want to delete to open the context menu.
						

	
							Select Delete.
						

	
							Click OK.
						




Deleting the server's configuration



	
							On the menu bar, click JBoss Developer Studio → Preferences → Server.
						
Note

								On Linux and Windows machines, you access Preferences through the Window menu.
							


	
							Expand the Server folder, and then select Runtime Environments to open the Server Runtime Environments page.
						

	
							From the list, select the runtime environment of the server that you previously deleted from Servers panel, and then click Remove.
						

	
							Click OK.
						






Chapter 28. Publishing Fuse Projects to a Server

Abstract

						You deploy Fuse projects into a server runtime using the Eclipse publishing mechanism. To do so, you must have defined and added the server to the Servers panel in Fuse Integration perspective (for details, see Chapter 27, Managing servers. For a step-by-step demonstration, see Red Hat JBoss Fuse Tooling Tutorials, To Publish a Fuse Project to Red Hat JBoss Fuse.
					




Overview




				You can set up supported servers to publish assigned Fuse projects automatically or to publish them only when you manually invoke the publish command.
			

				Each server runtime added to the Servers panel has its own Overview page that contains its configuration, connection, and publishing details:
			
[image: Overview]


				You may need to expand Publishing to expose the server runtime publishing options and default settings:
			
	
						Never publish automatically—You must select this option to manually publish projects.
					
Important

							You must also disable the If server started, publish changes immediately option on the server's Add and Remove page (for details see, the section called “Publishing Fuse projects manually”.
						


	
						Automatically publish when resources change—[default] Enable this option to automatically publish or republish a Fuse project when you save changes made to it. How quickly projects are published depends on the Publishing interval (default is 15 seconds).
					

	
						Automatically publish after a build event—For Fuse projects, works the same as Automatically publish when resources change.
					




Publishing Fuse projects automatically when resources change




				The default publishing option for server runtimes is Automatically publish when resources change.
			
	
						If necessary, start up the server runtime to which you want to publish a Fuse project. For details, see the section called “Starting a Server”.
					

	
						In the Servers panel, double-click the server runtime to open its Overview page.
					

	
						Expand Publishing, and then select Automatically publish when resources change.
					

	
						To increase or decrease the interval between publishing cycles, click the radio button next to Publishing interval (in seconds) up or down, as appropriate.
					

	
						In the Servers panel, right-click the server runtime to open the context menu, and then select Add and Remove.
					
[image: Publishing Fuse projects automatically when resources change]


						All resources available for publishing appear in the Available column.
					

	
						To assign a resource (in this case, the wildThing Fuse project) to the server runtime: 
						
	
									double-click it, or
								

	
									select it, and click Add >.
								





					

						The selected resource moves to the Configured column:
					
[image: Publishing Fuse projects automatically when resources change]


						At this stage, the time at which the assigned resource would actually be published would depend on whether the server runtime was running and on the Publishing interval setting. However, if the server was stopped, you would have to manually publish the project after you started the server (for details, see the section called “Publishing Fuse projects manually”).
					

	
						Click the If server started, publish changes immediately option to enable it:
					
[image: Publishing Fuse projects automatically when resources change]


						This option ensures that the configured project is published immediately once you click Finish. The Automatically publish when resources change option on the server runtime Overview page ensures that the configured project is republished whenever changes made to the local project are saved.
					

	
						Click Finish.
					

						The project appears in the Servers panel under the server runtime node, and the server runtime status reports [Started,Publishing...]:
					
[image: Publishing Fuse projects automatically when resources change]


						When publishing is done, the status of both the server runtime and the project report [Started,Synchronized]:
					
[image: Publishing Fuse projects automatically when resources change]

Note

							For a server runtime, Synchronized means that all published resources on the server are identical to their local counterparts. For a published resource, Synchronized means that it is identical to its local counterpart.
						





Publishing Fuse projects manually





			
	
						If necessary, start up the server runtime to which you want to publish a Fuse project. For details, see the section called “Starting a Server”.
					

	
						In the Servers panel, double-click the server runtime to open its Overview page.
					

	
						Expand Publishing, and then select Never publish automatically.
					

	
						If the Fuse project has already been assigned to the server runtime, make sure the If server started, publish changes immediately option is disabled.
					
	
								In the Servers panel, right-click the server runtime to open the context menu.
							

	
								Click Add and Remove... to open the server's Add and Remove page.
							

	
								If the If server started, publish changes immediately option is enabled, disable it.
							

	
								Skip to Step 6.
							



	
						If the Fuse project has not been assigned to the server runtime, assign it now.
					
	
								Follow Step 5 through Step 6 in the section called “Publishing Fuse projects automatically when resources change”.
							

	
								Do not enable the If server started, publish changes immediately option.
							



	
						Click Finish.
					

						The project appears in the Servers panel under the server runtime node, and the server runtime status reports [Started]:
					
[image: Publishing Fuse projects manually]


	
						In the Servers panel, right-click the project's node (in this case, the Fuse project wildThing) to open the context menu:
					
[image: Publishing Fuse projects manually]


	
						Select Full Publish.
					

						During the publishing operation, the status of both the server runtime and the project report [Started,Republish]:
					
[image: Publishing Fuse projects manually]


						When publishing is done, the status of both the server runtime and the project report [Started,Synchronized]:
					
[image: Publishing Fuse projects manually]

Note

							The tooling does not support the Incremental Publish option. Clicking Incremental Publish results in a full publish.
						





Verifying the project was published to the server




				After you have published a Fuse project to a server runtime, you can connect to the server and check that the project's bundle was installed on it.
			
	
						Connect to the server runtime. For details see the section called “Connecting to a running server in Servers panel”
					

	
						In the Servers panel, expand the server runtime tree to expose the Bundles node and select it.
					

						The tooling populates Properties view with a list of bundles that are installed on the server:
					
[image: Verifying the project was published to the server]


	
						To find your project's bundle, either scroll down to the bottom of the list, or start typing the bundle's symbolic name in Properties view's Search box.
					

						The bundle's symbolic name is the artifactId you gave the project when you created it. You can find the artifactId at the very beginning of the project's pom.xml file. To open it in the tooling's XML editor, click pom.xml in Project Explorer, and then click the pom.xml tab in the XML editor.
					




Related topics



	 Red Hat JBoss Fuse Tooling Tutorials, To Publish a Fuse Project to Red Hat JBoss Fuse



Part VI. Working with Fabrics





				A fabric is a distributed configuration, provisioning, and clustering mechanism for developing, testing, and running  projects on multiple computers in an on-premises or public Cloud. You can view and edit fabrics, and the containers, versions, and profiles of which they consist. You can also create and delete containers and profiles, but you can only create versions.
			

				For in-depth information on Fabric8, see the Fabric Guide and Cloud Computing with Fabric on the Red Hat Customer Portal
			

				To open Fabric8 perspective (Chapter 4, Fabric8 Perspective), click 
				[image: Working with Fabrics]
				 on the right side of the JBoss Developer Studio tool bar, and then select Fabric8 from the list of available perspectives.
			
Warning

					The Fabric8 Tooling feature has now been deprecated. Red Hat support for this feature will be discontinued from JBoss Fuse version 6.2. However, this feature will be removed completely after JBoss Fuse 7.0 release.
				



Chapter 29. Setting up a Fabric Environment




				The tooling provides an environment for developing and debugging fabric applications. Use the tooling to build a mock-up of your actual fabric into which you can deploy your application to test and debug it.
			
Overview




				To set up a fabric environment, you must have access to an existing fabric.
			
Note

					With Red Hat JBoss Fuse and the JBoss Server Extensions feature installed, you can start up Red Hat JBoss Fuse and create a fabric from inside the tooling. See Chapter 27, Managing servers
				


				Setting up a fabric environment involves several basic steps: 
				
	
							Providing the details for connecting to an existing fabric
						

	
							Connecting to the fabric
						

	
							Creating the containers that will host the various components of your distributed integration application
						

	
							Assigning each container one or more profiles, which provision containers by deploying and installing specified applications.
						





			
Note

					For cloud applications, unless the cloud already has a fabric registry agent running on it, you must create one yourself before you can include it to your fabric environment. For details, see Chapter 34, Creating a Fabric in the Cloud.
				


Opening the fabric perspective




				To set up a fabric environment, you must switch to the Fabric8 perspective, by selecting Window → Open Perspective → Other... → Fabric8, or clicking 
				[image: new perspective button]
				 in the Perspectives tab, and selecting Fabric8.
			

Related topics



	 Chapter 30, Specifying and Connecting to a Fabric 



Chapter 30. Specifying and Connecting to a Fabric




				Before you can view and edit your fabric, you must add it to the Fabric Explorer view. You can add multiple fabrics in Fabric8 perspective and connect to them concurrently.
			
Adding fabric details



Overview




					For the tooling to connect to a fabric, you must provide certain details about the fabric.
				

Procedure




					To specify the details for connecting to a fabric:
				
	
							In Fabric Explorer, right-click Fabrics to open the context menu, and then select Add Fabric details to open the Fabric Details wizard, as shown in Figure 30.1.
						
Figure 30.1. Fabric Details wizard
[image: defaults for connecting to a local fabric]



	
							In Name, enter the name of the fabric to which you want to connect. The name you enter identifies the fabric whose location you specify in Jolokia URL, and this name will appear in Fabric Explorer.
						

							The default Name is Local Fabric.
						

	
							In Jolokia URL, enter the url, in the form http://hostname:port/jolokia/, of the fabric to which you want to connect. This URL specifies the location of a fabric registry agent, whose default port is 8181.
						

							The default URL is http://localhost:8181/jolokia/.
						

	
							In User name, enter the name used to log into the specified fabric.
						

							This is the user name that was either specified when the fabric was created or is defined in the Red Hat JBoss Fuse installDir/etc/users.properties file. In that file, user information is specified using this format: user=password,role (for example, admin=admin,Administrator).
						

							You can discover the user name by issuing the command JBossFuse:karaf@root>jaas:users, if the Jaas realm has been selected for the fabric.
						

	
							In Password, enter the password required for User name to log into the specified fabric.
						

							This is the password that was either specified for User name when the fabric was created or is defined in the Red Hat JBoss Fuse installDir/etc/users.properties file.
						

	
							In Zookeeper Password, enter the password required for logging into the specified fabric's zookeeper registry.
						

							This is the password that was either specified when the fabric was created or is the password of the first user defined in the Red Hat JBoss Fuse installDir/etc/users.properties file.
						

							You can discover the Zookeeper password by issuing the command JBossFuse:karaf@root>fabric:ensemble-password.
						

	
							Click OK.
						

							The fabric's name appears in Fabric Explorer as a node beneath Fabrics.
						
Note

								Before you can view or modify a fabric's containers, profiles or versions, you must connect to the fabric. For details see the section called “Connecting to a fabric”
							





Related topics



	 the section called “Deleting a fabric's details” 



Connecting to a fabric



Overview




					The tooling connects to a fabric using the connection information you specified for it in the Fabric Details dialog.
				

Procedure




					To connect to a fabric:
				
	
							In Fabric Explorer, select the fabric to which you want to connect, then right-click it to open the context menu.
						

	
							Select Connect.
						

							An expand arrow ( 
							[image: expand tree arrow]
							 ) appears next to the fabric you selected in Fabric Explorer.
						

	
							Click ( 
							[image: expand tree arrow]
							 ) to expand the fabric's tree and browse its containers, profiles, and versions.
						

							From here, you can create and deploy new containers or modify existing ones by assigning them new profiles or modified versions of existing profiles.
						




Related topics



	the section called “Adding fabric details”



Disconnecting from a fabric



Overview




					Typically, you'd disconnect from a fabric without stopping its containers since they usually run application services. In this case, the containers will continue to run, unless stopped using the tooling or the Red Hat JBoss Fuse console command line.
				

Procedure



	
							In Fabric Explorer, select the fabric from which you want to disconnect, then right-click it to open the context menu.
						

	
							Select Disconnect.
						

							The tooling closes the connection with the selected fabric.
						





Editing a fabric's details



Overview




					When any of the details for connecting to your fabric change, you need to update the details in the tooling.
				
Important

						Before you edit a fabric's details, disconnect from the fabric.
					


Procedure



	
							In Fabric Explorer, select the fabric whose details you want to edit, and right-click it to open the context menu.
						

	
							Select Edit Fabric details to open the Fabric Details dialog, as shown in Figure 30.1, “Fabric Details wizard”.
						

	
							In Name, enter a new name for the fabric, if necessary.
						

	
							In Jolokia URL, enter the new url of the fabric, if necessary.
						

	
							In User name, enter a name with which the new user will log into the selected fabric, if necessary.
						

	
							In Password, enter the new password to use for logging into the selected fabric, if necessary.
						

	
							Click OK.
						





Deleting a fabric's details



Overview




					To remove a fabric from Fabric Explorer, you delete its details.
				

Procedure



	
							In Fabric Explorer, select the fabric whose details you want to delete, then right-click it to open the context menu.
						

	
							Select Delete Fabric details.
						

							The tooling closes the connection with the selected fabric, and then deletes the fabric's details.
						




Related topics



	the section called “Adding fabric details”




Chapter 31. Working with Fabric Containers



Creating a new child container



Overview




					A child container is created on the server where its parent is.
				

Procedure




					To create a new child container:
				
	
							If necessary, in Fabric Explorer, expand the tree of the selected fabric in which you want to create the new child container.
						

	
							Right-click the target parent container to open the context menu, and then select Create a new child container.
						
Figure 31.1. Create Child Container wizard
[image: create a new child container page]



	
							In Container name, enter a name for the new child container.
						

							We recommend that you replace the default name with a meaningful name that identifies the container's role or function.
						

	
							If multiple versions exist, you can select one from the Version drop-down list. Otherwise, accept the default value.
						

	
							Under Profiles, click the checkbox next to the profile or profiles you want to assign to the new child container.
						

							Profiles determine the function of containers; what applications they run. You can assign multiple profiles to a container, as long as the applications they install do not conflict with one another.
						
Important

								Do not assign a base profile (one ending in -base) to a container.
							


	
							Click OK.
						

							The new child container appears in Fabric Explorer as a node under Containers
						
Note

								Selecting the new container in Fabric Explorer populates its Profiles and Profile Details pages in Properties viewer.
							





Related topics



	the section called “Creating a new profile”
	the section called “Creating a new version of a profile”



Creating a container on a remote host



Overview




					To create a container on a remote host, the remote host machine must be ssh-enabled. 
				
Note

						Creating a container via ssh on a remote Windows machine is not supported.
					


Procedure




					To create a new container on a remote machine:
				
	
							If necessary, in Fabric Explorer, expand the tree of the fabric for which you want to create the new remote container.
						

	
							Right-click Containers to open the context menu, and then select Create a new container via SSH.
						
Figure 31.2. Create Container via SSH wizard
[image: defaults for a new remote container]


Note

								An error icon ( 
								[image: error icon]
								 ) marks required fields that lack a valid value, and the dialog banner displays the number of errors detected.
							


	
							In Container name, enter a name for the new container.
						

							We recommend that you replace the default name with a meaningful name that identifies the container's role or function.
						

	
							If multiple versions exist, you can select one from the Version drop-down list. Otherwise, accept the default value.
						

	
							In Host, enter the name or the IP address of the remote host.
						

	
							In User name, enter the name of a user authorized to log into the remote host.
						

	
							In Password, enter the password for User name.
						

	
							In Path, accept the default (~/containers/), or enter the path of the new container's location on the remote host.
						

	
							In Port, accept the default port number (22), or enter a new port number to use for establishing an ssh connection on the remote host.
						

	
							In SSH retries, accept the default (1), or enter the maximum number of retries to attempt at establishing an ssh connection on the remote host.
						

	
							In Retry delay, accept the default (1), or enter the delay, in milliseconds, between retry attempts.
						

	
							Under Profiles, click the checkbox next to the profile or profiles you want to assign to the container.
						

							Profiles determine the function of a container; what applications it runs. You can assign multiple profiles to a container, as long as the applications they install do not conflict with one another.
						
Important

								Do not assign a base profile (one ending in -base) to a container.
							


	
							Click OK.
						

							The new container appears in Fabric Explorer as a container node under Containers
						

							Selecting the new container in Fabric Explorers populates its Profiles and Profile Details pages in Properties viewer.
						




Related topics



	the section called “Creating a new profile”
	the section called “Creating a new version of a profile”



Creating a new container on a cloud



Overview




					To create a container on a cloud, you need to specify the cloud's connection details and then create the container.
				

Procedure




					To create a new container on a cloud:
				
	
							In Fabric Explorer, if necessary, expand the tree of the fabric for which you want to create the new container on the cloud. Right-click Containers to open the context menu.
						

	
							Select Create a new container on the cloud to open the Create Container in a Cloud wizard.
						
Figure 31.3. Create Container in a Cloud/Choose the Cloud page
[image: choose the cloud page]


Note

								Unless the connection details for a cloud have already been added to the tooling, this dialog opens devoid of selections. You can add a cloud's connection details now by clicking Add Cloud details and following the procedure in the section called “Adding cloud details”.
							


	
							Select a cloud from the list, and click Next to open the New Containers Details page.
						
Figure 31.4. New Containers Details page
[image: enter details of the new cloud container]


Note

								An error icon ( 
								[image: error icon]
								 ) marks required fields that lack a valid value, and the dialog banner displays the number of errors detected.
							


	
							In Container name, enter a name for the new container.
						

							We recommend that you replace the default name with a meaningful name that identifies the container's role or function.
						

	
							If multiple versions exist, you can select one from the Version drop-down list. Otherwise, accept the default version.
						

	
							In Group, accept the default (fabric), or enter the group in which to start up the new container.
						

	
							In User, accept the default (admin), or enter the name of another user who is authorized to log into the new cloud container.
						

							This is the user that was either specified when the fabric was created or is defined in the Red Hat JBoss Fuse installDir/etc/users.properties file (see the section called “Adding fabric details”).
						

	
							In Password, enter the pasword required for User to log into the new cloud container.
						

							This is the password that was specified for User when the fabric was created or is defined for the user in the Red Hat JBoss Fuse installDir/etc/users.properties file.
						

	
							In Zookeeper Password, accept the default generated password for logging into the cloud container's zookeeper registry, or enter the zookeeper password that was used when the fabric was created.
						

							You can discover the zookeeper password by issuing the commmand JBossFuse:karaf@root>fabric:ensemble-password.
						

	
							In Hardware ID, select from the drop-down list the ID of the hardware archetype to use.
						

							Hardware archetypes specify the amount of memory and compute power available for running applications on machine images.
						
Important

								The next three fields provide two methods for specifying the software configuration (operating system, application server, and applications) you want to use. Either select an OS Family (and optionally a version), or select an Image ID.
							


	
							In OS Family, select from the drop-down list the family name of the operating system you want to use.
						

							If you select an OS Family, do not also select an Image ID.
						

	
							In OS Version, optionally select from the drop-down list the version for the operating system you selected.
						

	
							If you selected an OS Family, skip this step. Otherwise, in Image ID, select from the drop-down list the ID of the image template to use for the software configuration.
						
Note

								The tooling starts an instance of the image in the cloud, and then installs a fabric agent and provisions the new agent with the selected profiles. Depending on the cloud provider, instantiation and provisioning could take some time.
							


	
							Under Profiles, select the profile or profiles you want to assign to the container.
						

							Profiles determine the function of containers—what applications they run. You can assign a container multiple profiles, as long as the applications they install do not conflict with one another.
						
Important

								Do not assign a base profile (one ending in -base) to a container.
							


	
							Click OK.
						

							The new container appears in Fabric Explorer as a container node under Containers
						
Note

								Selecting the new container in Fabric Explorer populates its Profiles and Profile Details pages in Properties viewer.
							





Related topics



	Chapter 34, Creating a Fabric in the Cloud
	the section called “Creating a new profile”
	the section called “Creating a new version of a profile”



Starting a container



Overview




					When you create a container, it starts up automatically and continues to run until stopped by some event, planned or otherwise. You can manually restart a stopped container.
				

Procedure




					To start a container:
				
	
							If necessary, in Fabric Explorer, expand the tree of the fabric whose container you want to start.
						

	
							Select the container and right-click it to open the context menu.
						

	
							Click Start Container.
						
Note

								To check whether the tooling started the container, click Containers in Fabric Explorer, and open the Properties view. You should see something similar to Figure 31.5, where mycamelExample was started and provisioned successfully.
							

Figure 31.5. Container status in Properties view
[image: checking the status of containers]



							The status indicators in the Status column of the Properties view indicate the startup state of the container, as shown Table 31.1:
						
Table 31.1. Container startup status
	Icon	Meaning
	 [image: gray dot]
										 	 Container stopped
	 [image: yellow dot]
										 	 Container started; analysis and provisioning in progress
	 [image: green dot]
										 	 Container started and provisioned successfully
	 [image: red dot]
										 	 Failure occurred during startup or provisioning







Related topics



	the section called “Stopping a container”



Changing a Container's Profiles



Overview




					A container's profiles determine what the container is hosting. If you want to change what is deployed in a container or how it is configured, you change the profiles deployed to it.
				
Important

						The profile or profiles you select will override the entire list of profiles currently deployed in the selected container.
					


Procedure




					To change the profiles deployed to a container:
				
	
							Select the container.
						

	
							In the Properties view, select the Profiles tab.
						

	
							From the list, select the profile or profiles you want to deploy to the container by highlighting them.
						
Note

								To select multiple profiles, hold down the CTRL key while you select them.
							






Stopping a container



Overview




					There are times when you might want to stop then restart a container; for example, to recycle a hung container, force a container to reprovision itself, or to reclaim CPU cycles.
				

Procedure




					To stop a container:
				
	
							If necessary, in Fabric Explorer, expand the tree of the fabric whose container you want to stop.
						

	
							Select the container and right-click it to open the context menu.
						

	
							Click Stop Container.
						
Note

								To check whether the tooling stopped the container, click Containers in Fabric Explorer, and open the Properties view. You should see something similar to Figure 31.6, where myRoute was stopped successfully.
							

Figure 31.6. Container status in Properties view
[image: checking the status of containers]



							For information on the meaning of the status indicators that might appear in the Status column of the Properties view, see Table 31.1, “Container startup status”.
						




Related topics



	the section called “Starting a container”
	the section called “Deleting a container”



Deleting a container



Overview




					When a container becomes obsolete—no longer used in the fabric integration project—you may want to delete it. Before you do so, make sure no other container in the project depends on it. Deleting a container terminates the container and its processes and removes its configuration from the fabric.
				
Note

						To delete a container, it must be running in the fabric.
					


Procedure




					To delete a container:
				
	
							If necessary, in Fabric Explorer, expand the tree of the fabric whose container you want to delete.
						

	
							Click Containers to populate Properties view with a list of the fabric's containers.
						

	
							In Properties view, select the container you want to delete, and then click 
							[image: delete button]
							 on the right-hand side of the toolbar.
						
Figure 31.7. Container selected for deletion in Properties view
[image: selecting container for deletion]



	
							In the Destroy Container(s) dialog, click OK to delete the selected container.
						

							The tooling displays a message that removal is in progress. In Properties view, the container's status briefly changes to stopped, and then the container disappears from the list.
						

	
							In Fabric Explorer, open the fabric's context menu, and click Refresh to update Containers and remove the deleted container from the tree.
						
Note

								If you have the Red Hat JBoss Fuse console open in Shell view, you can verify that the container and its configuration have been removed from the fabric by entering at the command line fabric:container-list.
							





Related topics



	the section called “Stopping a container”
	the section called “Creating a new child container”
	the section called “Creating a container on a remote host”
	the section called “Creating a new container on a cloud”




Chapter 32. Working with Fabric Profiles




				Profiles are applied to fabric containers, and they determine the function and behavior of their containers. A profile consists of code and configurations, which specify the type of service or application a container runs. The code may come from OSGi bundles  and Karaf features pulled from repositories, also specified in the profile. Defined hierarchically, profiles can be set up to inherit from other profiles, building on their parents' definitions.
			
Creating a new profile



Overview




					The tooling provides access to numerous profiles, each of which imparts specific functionality and behaviors to the containers to which it's assigned. But you may want to create new profiles that inherit from these base profiles, so you can override, for example, configuration details. You may also want to create your own profiles to deploy your own code. To do so, you create a new profile based on an existing one, and then change its configuration and properties to generate the specific behaviors you want to deploy to the target containers.
				
Note

						This procedure creates a brand new profile. If you want to create a new version of an existing profile to incrementally test changes to deployed containers, see Chapter 33, Working with Versions
					


Procedure




					To create a new profile:
				
	
							In Fabric Explorer, expand the fabric in which you want to create a new profile.
						

	
							Expand the fabric's tree to the level of the profiles, as shown in Figure 32.1.
						
Figure 32.1. Accessing the profiles
[image: accessing profiles in Fabric Navigator]



	
							Select the profile on which you want to base the new profile, and right-click it to open the context menu.
						
Important

								Because the selected profile is the parent of the new profile, the new profile inherits the selected profile's configurations, properties, features, repositories and bundles as well as those of the selected profile's ancestors. However, a child's configurations override an ancestor's when their configuration files have the same name.
							

Note

								Neither configuration files nor properties are visible within the tooling, but you can view them in the Red Hat JBoss Fuse Management Console. For details, see the Red Hat JBoss Fuse Management Console documentation at https://access.redhat.com/documentation/en-US/Red_Hat_JBoss_Fuse/.
							


	
							Select Create a new Profile.
						
Figure 32.2. Create Profile dialog
[image: naming the profile]



	
							In Profile name, enter a name for the new profile.
						

							Use a name that is descriptive of the new profile's function.
						

	
							Click OK to create and save the new profile.
						

							The new profile is added to the list of profiles in Fabric Explorer, under its parent profile.
						

	
							In Fabric Explorer, select the new profile to populate the Properties editor with the new profile's properties information and profile details.
						

	
							In the Properties editor, click the Details tab.
						
Figure 32.3. Profiles page
[image: configuring new profile details]



							On the Profiles page, you can add, delete, or edit features, the repositories from which features are downloaded, and bundles. You can also add or remove parent profiles. Profiles can have multiple parents, and they inherit the qualities of each
						

							Features are files that aggregate references to interdependent or related bundles that together define a feature. Typically, you'd use bundles only if the feature they define is not already included in a features file. For more information on bundles and features, see Deploying Features.
						

							Child profiles inherit everything (configurations, properties, features, repositories, and bundles) from their immediate parents and from all of their parents' ancestors. When the child's and any ancestor's configuration file have the same name, the child's configuration file replaces the ancestor's file. Otherwise, configurations are cumulative.
						
Note

								The Profiles page displays only the features, repositories, and bundles added by the child profile, not those contributed by the profile's parents or other ancestors. The Parents pane shows (highlighted) the profile's immediate parents only.
							


	
							Make the changes you want to the new profile to configure it.
						

							Changes are automatically saved as you make them.
						
Note

								In Fuse Integration perspective, you can easily add a Fuse project to the new profile by dragging it from Project Explorer and dropping it onto the new profile in Fabric Explorer. When you do, the fabric tooling builds the project, runs all tests, installs the project in the new profile, and uploads the profile into the fabric's internal Maven repository. Because profiles are stored in a fabric's internal repository, they cannot be shared across other fabrics.
							

Important

								If you drop your project on a fabric container, rather than on a profile, the next time that container is provisioned, your project is wiped out.
							


							You can now assign the new profile to a container.
						

	
							In Fabric Explorer, select the container to which you want to assign the new profile.
						

							The fabric tooling populates the Properties editor with the container's properties information and profile details.
						

	
							Open the container's Details tab, and then select the new profile in the Profiles list.
						

							Repeat Step 10 and Step 11 for each container to which you want to assign the new profile.
						




Related topics



	 the section called “Creating a new version of a profile” 



Deleting a profile



Overview




					When a profile is inactive—no longer assigned to any container in the fabric—you can safely delete it.
				

Procedure




					To delete an inactive profile:
				
	
							In Fabric Explorer, expand the fabric which contains the profile you want to delete.
						

	
							Expand the fabric's tree to the level of versions, and then expand the version that contains the target profile.
						

	
							Select the target profile, and right-click it to open the context menu.
						

	
							Select Delete Profile.
						






Chapter 33. Working with Versions




				Versioning provides the means for safely rolling out upgrades of the profiles deployed and running in containers across a fabric. Using versioning, you can make incremental updates to existing profiles, and then test them out on small groups of containers. When you've completed and tested the final versions, you can confidently deploy them to their target containers in the fabric.
			
Creating a new version of a profile



Overview




					A version is simply the collection of all profiles associated with a fabric. When you create a new version, you are copying all of the profiles from the most recent version—the base version—into the new version. Once that's done, you can upgrade the profiles in the new version by modifying them.
				

Creating a new version




					To create a new version:
				
	
							In Fabric Explorer, select the fabric in which you want to create a new version.
						

	
							Expand the fabric's tree to the level of Versions, shown in the section called “Creating a new profile”.
						

	
							Select Versions, and then right-click it to open the context menu.
						

	
							Select Create Version.
						

	
							In the Create Version wizard, enter a new version or accept the default value.
						

							The default version is always a minor increment of the highest-numbered version. So, if the highest-numbered version is 1.3, the new version will default to 1.4, and all of the profiles in version 1.3 will be copied into version 1.4.
						
Important

								Version names are important! The tooling sorts version names based on the numeric version string, according to major.minor numbering, to determine the version on which to base a new one. You can safely add a text description to a version name as long as you append it to the end of the generated default name like this: 1.3<.description>. If you abandon the default naming convention and use a textual name instead (for example, Patch051312), the next version you create will be based, not on the last version (Patch051312), but on the highest-numbered version determined by dot syntax.
							


	
							Click OK.
						

							The tooling copies all of the base version's profiles into the new version and displays the new version in Fabric Explorer, directly under the base version.
						




Modifying profiles in the new version




					To modify a profile in the new version:
				
	
							In Fabric Explorer, expand the newly created version.
						

	
							Select a profile that you want to modify.
						

							The tooling populates the Properties editor with the profile's details for you to edit.
						

	
							In the Properties editor, click the Details tab to access the Profiles page.
						

	
							Make the changes you want to the new profile to configure it.
						

							Changes are automatically saved as you make them.
						


						




Related topics



	the section called “Creating a new profile”



Setting a container's version



Overview




					After you've created a new version, you can assign it to selected containers. This feature enables you to easily roll out upgraded profiles in a controlled and orderly way.
				
Important

						Setting a container's version immediately provisions the container with the profiles from the selected version.
					


Procedure




					To set a container's version:
				
	
							In Fabric Explorer, select the container whose profiles you want to change.
						

	
							Right-click it to open the context menu, and then select Select Version.
						

							The Select Version submenu lists all available versions.
						

	
							Click the version you want to assign the selected container.
						

							The container is immediately provisioned with the new version of any profile assigned to it.
						






Chapter 34. Creating a Fabric in the Cloud




				To create a fabric on a cloud, you need to 
				
	
							Have established an account with a cloud provider
						

	
							Provide the tooling the account details for connecting to the cloud
						

	
							Specify the details required for creating the fabric and the machine image on which it will run
						





			
Adding cloud details



Overview




					To connect to a cloud, the tooling needs the relevant access and authorization information. This information was provided to you or a system administrator by the cloud provider, when the account was set up.
				

Procedure




					To add a cloud's access details:
				
	
							In Fabric Explorer, right-click Clouds to open the context menu, and then select Add Cloud details.
						
Figure 34.1. Cloud Details wizard
[image: Cloud access details wizard]


Note

								An error icon ( 
								[image: error icon]
								 ) marks required fields that lack a valid value, and the dialog banner displays the number of errors detected.
							


	
							In Name, enter a name for the cloud.
						
Important

								The next three fields provide two methods for specifying the provider's information. You select either a provider's name, or you select both an API and its endpoint.
							


	
							In Provider name, select the name of the cloud provider from the drop-down list.
						

							If you select a provider name, the tooling autofills Api name and Endpoint with the selected provider's information, so you can skip to Step 6.
						

	
							In Api name, select from the drop-down list the name of the API you want to use.
						

							This list displays only APIs that have been installed on your local machine or environment.
						

	
							In Endpoint, enter the uri of the web service that exposes the API you selected in Step 4.
						

							If you have an on-premises, private cloud installed, you need to get this uri from the cloud administrator.
						

	
							In Identity, enter the account identifier supplied by the cloud provider.
						

							For example, for Amazon Elastic Compute Cloud (EC2) accounts, you'd enter the Access Key ID.
						

	
							In Credential, enter the account password supplied by the cloud provider.
						

							For example, for Amazon Elastic Compute Cloud (EC2) accounts, you'd enter the Secret Access Key.
						

	
							In Owner, for EC2 only, enter the id assigned to a custom image.
						

							This option is EC2-specific and applies only to custom images. To query or use a custom image, you must enter the owner id assigned to it by EC2; otherwise, the image will not appear in the list of instances.
						




					If you entered valid access details, the tooling connects to the cloud whose access details you specified and loads the provider's images. Once that's done, the name you entered in Step 2 appears as a node under Clouds in Fabric Explorer.
				

Related topics



	 the section called “Creating a new container on a cloud” 



Specifying fabric details




					After you've added the access information that the tooling needs to connect to a cloud, you can create a fabric on the cloud. This procedure assumes that you have already added the cloud details.
				
Overview




					Creating a fabric on a cloud involves creating on the cloud a container that contains a fabric registry and specifying the machine image on which you want to create and run it.
				

Procedure




					To create a fabric on a cloud:
				
	
							In Fabric Explorer, right-click Fabrics to open the context menu, and then select Create Fabric in the cloud.
						

	
							On the Create Fabric in the cloud wizard's Choose the Cloud page, select the cloud from the list, and then click Next to open the wizard's Fabric Details page.
						
Figure 34.2. Fabric Details page
[image: Fabric details page]


Note

								An error icon ( 
								[image: error icon]
								 ) marks required fields that lack a valid value, and the dialog banner displays the number of errors detected.
							


							You may have to wait a few seconds while the tooling retrieves the location, hardware, and image IDs from your cloud provider to populate the wizard's corresponding fields.
						

	
							In Fabric Name, accept the default name, or enter a different name for the new fabric.
						

	
							In Container name, accept the default name, or enter a different name for the new container that will host the fabric registry.
						

	
							In Group, accept the default name, or enter a different name for the group in which to start up the new fabric registry container.
						

	
							In User, accept the default user name, or enter a different user name to use for logging into the new fabric registry container.
						

	
							In Password, enter the password required for User to log into the specified fabric.
						

	
							In Zookeeper Password, accept the default, generated password for logging into the cloud fabric's zookeeper registry, or enter a different password.
						

	
							In Location ID, select from the drop-down list the ID of the region in which the machines you want to use are located.
						

	
							In Hardware ID, select from the drop-down list the ID of the hardware archetype you want to use.
						

							Hardware archetypes specify the amount of memory and compute power available for running applications on machine images.
						
Important

								The next three fields provide two methods for specifying the software configuration (operating system, application server, and applications) you want to use. Either select an OS Family (and optionally a version), or select an Image ID.
							


	
							In OS Family, select from the drop-down list the family name of the operating system you want to use.
						

							If you select an OS Family, do not also select an Image ID.
						

	
							In OS Version, optionally select from the drop-down list the version for the operating system you selected.
						

	
							If you selected an OS Family, skip this step. Otherwise, in Image ID, select from the drop-down list the ID of the image template to use for the software configuration.
						

	
							In Maven proxy URI, accept the default URI, or enter the URI to the Maven proxy repository you want to use.
						

	
							Click Finish.
						

							The tooling creates the container, then provisions it with all of the bundles, features, and profiles required to create a fabric registry. This process can take up to ten minutes. When it's done, the container specified in Step 4 appears in Fabric Explorer as a node under Fabrics.
						
Note

								It's a good idea to access your cloud account and verify that the new fabric registry container is up and running.
							





Related topics



	 the section called “Adding cloud details” 
	 the section called “Creating a new container on a cloud” 




Appendix A. Wizard field references





Name
New Camel XML File — Creates a new XML file for editing routes with the route editor

Properties

					Table A.1 describes the properties you can specify.
				
Table A.1. New Camel XML File properties
	Name	Default	Description
	RouteContainer	 	Specifies the folder into which the new file will be placed.
	File Name	camelContext.xml	Specifies the name of the new routing context file.
	Framework	Spring	Specifies whether the context file is intended to be used in a Spring container or in an OSGi container that supports Blueprint or to be added to into existing camelContexts.



Important

						The Spring framework and the OSGi Blueprint framework require that all Apache Camel files be placed in specific locations under the project's META-INF folder:
					
	
								Spring—projectName /src/main/resources/META-INF/spring/
							

	
								OSGi Blueprint—projectName /src/main/resources/META-INF/blueprint/
							





Related topics
	Chapter 6, Creating a New Camel XML file




Name
New Fuse Project — Creates a new Fuse project

Properties

					Table A.2 describes the properties you can specify.
				
Table A.2. New Fuse IDE project: select project location properties
	Name	Default	Description
	Project Name	 	Specifies the name of the new project.
	Use default Workspace location	Enabled	Specifies whether to create the new project in the default workspace.
	Location	 	Specifies the full path to an alternate workspace when the default workspace location option is disabled.
	Add project(s) to working set	Disabled	Specifies whether to add the new project to one or more established working sets.
	Working set	 	Specifies the working sets in which to add the new project when the working set option is enabled.




Related topics
	Chapter 5, Creating a New Fuse Project




Name
New Fuse Project — Creates a new Fuse project

Properties

					Table A.3 describes the properties you can specify.
				
Table A.3. New Fuse project: select project archetype and specify its details properties
	Name	Default	Description
	Archetype	 	Specifies the Maven archetype to use to create the new project.
	Group ID	 	Specifies the group ID Maven uses when generating the new project. This ID is mapped to the POM file's groupId element.
	Artifact ID	 	Specifies the artifact ID Maven uses when generating the new project. This ID is mapped to the POM file's artifactId element.
	Version	1.0.0-SNAPSHOT	Specifies the version name Maven uses when generating the new project. You can accept the default version name, or enter a new one. This value is mapped to the POM file's version element. 
	Package	<groupID>.<artifactID>	Specifies the package name for the generated artifacts. You can accept the default package name, or enter a new one.




Related topics
	Chapter 5, Creating a New Fuse Project




Name
New Fuse Message — Creates a new message to use in route tracing.

Properties

					Table A.4 describes the properties you can specify.
				
Table A.4. Fuse Message File properties
	Name	Default	Description
	Parent Folder	The selected folder	Specifies the folder into which the new message file will be placed.
	File Name	message.xml	Specifies the name of the new message file.




Related topics
	the section called “Creating test messages for route tracing”




Name
New Camel JUnit Test Case — Configures the JUnit artifacts created to test a Apache Camel route.

Properties

					Table A.5 describes the properties you can specify.
				
Table A.5. New Camel JUnit properties
	Name	Default	Description
	Source Folder	project/src/test/java	Specifies the folder into which the JUnit code is placed.
	Package	Name of the package when the project was created	Specifies the package name for the JUnit code.
	Camel XML file under test	Selected context file, or blank if other than a context file is selected	Specifies the Camel XML file containing the routes to be tested.
	Name	classname based on the selected context file (for example, CamelContextXMLTest), or empty if none selected	Specifies the name of the JUnit class.
	Method stubs	 	Specifies the JUnit method stubs to include in the generated test class.
	Generate comments	 	Specifies whether to generate comments in the new test class.




Related topics
	Chapter 8, Creating a new Apache Camel JUnit test case




Name
Test Endpoints — Lists the endpoints that can be tested by a JUnit test case.

Properties

					Table A.6 describes the properties you can specify.
				
Table A.6. Test Endpoint properties
	Name	Default	Description
	Available endpoints	all	Specifies the endpoints to test in the Camel JUnit test case.




Related topics
	Chapter 8, Creating a new Apache Camel JUnit test case




Name
Define a New Server — Defines a new server instance.

Properties

					Table A.7 describes the properties you can specify.
				
Table A.7. New Server properties
	Name	Default	Description
	Server type	 	Specifies the type of server to define.
	Server's host name	 	Specifies the name of the machine running the server.
	Server name	 	Specifies the name of the server.
	Server runtime environment	Selected server's runtime	Specifies the runtime environment of the server.




Related topics
	the section called “Adding a Server”




Name
New Server Configuration — Configures access details for the server.

Properties

					Table A.8 describes the properties you can specify.
				
Table A.8. Server Configuration details properties
	Name	Default	Description
	Host Name	For localhost, 0.0.0.0	Specifies the address of the machine running the server.
	Port Name	8101	Specifies the port used to contact the server.
	User Name	 	[Optional] Specifies the name of a user authorized to access the server remotely. 
	Password	 	[Optional] Specifies the password the authorized user must enter to access the server remotely.




Related topics
	the section called “Adding a Server”




Name
Add and Remove — Specifies the resources available to a server.

Properties

					Table A.9 describes the properties you can specify.
				
Table A.9. Add and Remove properties
	Name	Description
	Available	Specifies the resources that are available to the server.
	Configured	Specifies the resources that the server is configured to use.




Related topics
	the section called “Adding a Server”




Name
Fabric Details — Specifies information needed to connect to a fabric.

Properties

					Table A.10 describes the properties you can specify.
				
Table A.10. Fabric Details properties
	Name	Default	Description
	Name	Local Fabric	Specifies the name of the fabric to connect to.
	Jolokia URL	https://localhost:8181/jolokia	Specifies the url, in the form of https://hostname:port/jolokia, of the specified fabric.
	User name	 	Specifies the name of a user that has login privileges.
	Password	 	Specifies the password of the specified user.
	Zookeeper Password	 	Specifies the password for accessing the fabric registry.




Related topics
	the section called “Adding fabric details”
	the section called “Editing a fabric's details”




Name
Create Child Container — Specifies information needed to create a container on the local host.

Properties

					Table A.11 describes the properties you can specify.
				
Table A.11. Create Child Container properties
	Name	Default	Description
	Container name	Container#	Specifies the name of the new container.
	Version	The highest-numbered version according to major.minor numbering	Specifies the version of the profiles to use.
	Profiles	 	Specifies the profile(s) to install in the new container.




Related topics
	the section called “Creating a new child container”




Name
Create Container via SSH — Specifies information needed to create a container on a remote host.

Properties

					Table A.12 describes the properties you can specify.
				
Table A.12. Create Container via SSH properties
	Name	Default	Description
	Container name	Container#	Specifies the name of the new container.
	Version	The highest-numbered version according to major.minor numbering	Specifies the version of the profiles to use.
	Host	 	Specifies the name or the IP address of the remote host.
	User name	 	Specifies the name of a user authorized to login to the remote host.
	Password	 	Specifies the password of the specified user.
	Path	~/containers	Specifies the path of the new container's location on the remote host.
	Port	22	Specifies the port number to use for establishing an ssh connection on the remote host.
	SSH retries	1	Specifies the maximum number of retries to attempt at establishing an ssh connection on the remote host.
	Retry delay	1	Specifies the delay, in milliseconds, between retry attempts.
	Profiles	 	Specifies the profile(s) to install in the new container.




Related topics
	the section called “Creating a container on a remote host”




Name
Create Container in a Cloud — Specifies information needed to create a container in a cloud.

Properties

					Table A.13 describes the properties you can specify.
				
Table A.13. Create Container in a Cloud:New Containers details properties
	Name	Default	Description
	Container name	Container#	Specifies the name of the new container.
	Version	The highest-numbered version according to major.minor numbering	Specifies the version of the profiles to use.
	Group	fabric	Specifies the name of the group in which to start up the new container.
	User	admin	Specifies the name of a user authorized to login to the new container.
	Location ID	 	Selects the region in which the machines you want to use are located.
	Hardware ID	 	Selects the hardware archetype to use.
	OS Family	 	Selects the general operating system to use.
	OS Version	 	Selects the version of the operating system you selected.
	Image ID	 	Selects a specific image template to use for the software configuration.
	Profiles	 	Specifies the profile(s) to install in the new container.




Related topics
	the section called “Creating a new container on a cloud”




Name
Create Version — Specifies the identifier for the new version of the fabric's profiles.

Properties

					Table A.14 describes the properties you can specify.
				
Table A.14. Create Version properties
	Name	Default	Description
	Create a new version for rolling upgrades to Profiles	The highest-numbered version according to major.minor numbering	Specifies the identifier for the new version of fabric's profiles.




Related topics
	the section called “Creating a new version of a profile”




Name
Cloud Details — Specifies information needed to connect to a cloud.

Properties

					Table A.15 describes the properties you can specify.
				
Table A.15. Cloud Details properties
	Name	Default	Description
	Name	 	Specifies the name of the cloud to connect to.
	Provider name	 	Selects the cloud provider.
	Api name	 	Selects the API to use on the specified cloud.
	Endpoint	 	Specifies the cloud endpoint uri.
	Identity	 	Specifies the account identifier (supplied by the cloud provider).
	Credential	 	Specifies the account password (supplied by the cloud provider).
	Owner	 	Specifies the name of the account owner.




Related topics
	the section called “Adding cloud details”




Name
Create Fabric in the Cloud — Specifies information needed to create a fabric in a cloud.

Properties

					Table A.16 describes the properties you can specify.
				
Table A.16. Create Fabric in a Cloud:Fabric details properties
	Name	Default	Description
	Fabric name	Cloud Fabric	Specifies the name of the new fabric.
	Container name	Registry	Specifies the name of the fabric registry container.
	Group	fabric	Specifies the name of the group in which to start up the fabric registry container.
	User	admin	Specifies the name of a user authorized to login to the fabric registry container.
	Password	 	Specifies the user's password for logging into the the fabric.
	Zookeeper Password	****************	Specifies the zookeeper password for logging into the cloud fabric's zookeeper registry.
	Location ID	 	Selects the region in which the machines you want to use are located.
	Hardware ID	 	Selects the hardware archetype to use.
	OS Family	 	Selects the general operating system to use.
	OS Version	 	Selects the version of the operating system you selected.
	Image ID	 	Selects a specific image template to use for the software configuration.
	Maven proxy URI	http://repo.fusesource.com/nexus/content/groups/ea	Specifies the Maven proxy repository to use.




Related topics
	the section called “Specifying fabric details”




Name
New Camel XML File — Creates a new XML file for editing routes with the route editor

Properties

					Table A.1 describes the properties you can specify.
				
Table A.1. New Camel XML File properties
	Name	Default	Description
	RouteContainer	 	Specifies the folder into which the new file will be placed.
	File Name	camelContext.xml	Specifies the name of the new routing context file.
	Framework	Spring	Specifies whether the context file is intended to be used in a Spring container or in an OSGi container that supports Blueprint or to be added to into existing camelContexts.



Important

						The Spring framework and the OSGi Blueprint framework require that all Apache Camel files be placed in specific locations under the project's META-INF folder:
					
	
								Spring—projectName /src/main/resources/META-INF/spring/
							

	
								OSGi Blueprint—projectName /src/main/resources/META-INF/blueprint/
							





Related topics
	Chapter 6, Creating a New Camel XML file




Name
New Fuse Project — Creates a new Fuse project

Properties

					Table A.2 describes the properties you can specify.
				
Table A.2. New Fuse IDE project: select project location properties
	Name	Default	Description
	Project Name	 	Specifies the name of the new project.
	Use default Workspace location	Enabled	Specifies whether to create the new project in the default workspace.
	Location	 	Specifies the full path to an alternate workspace when the default workspace location option is disabled.
	Add project(s) to working set	Disabled	Specifies whether to add the new project to one or more established working sets.
	Working set	 	Specifies the working sets in which to add the new project when the working set option is enabled.




Related topics
	Chapter 5, Creating a New Fuse Project




Name
New Fuse Project — Creates a new Fuse project

Properties

					Table A.3 describes the properties you can specify.
				
Table A.3. New Fuse project: select project archetype and specify its details properties
	Name	Default	Description
	Archetype	 	Specifies the Maven archetype to use to create the new project.
	Group ID	 	Specifies the group ID Maven uses when generating the new project. This ID is mapped to the POM file's groupId element.
	Artifact ID	 	Specifies the artifact ID Maven uses when generating the new project. This ID is mapped to the POM file's artifactId element.
	Version	1.0.0-SNAPSHOT	Specifies the version name Maven uses when generating the new project. You can accept the default version name, or enter a new one. This value is mapped to the POM file's version element. 
	Package	<groupID>.<artifactID>	Specifies the package name for the generated artifacts. You can accept the default package name, or enter a new one.




Related topics
	Chapter 5, Creating a New Fuse Project




Name
New Fuse Message — Creates a new message to use in route tracing.

Properties

					Table A.4 describes the properties you can specify.
				
Table A.4. Fuse Message File properties
	Name	Default	Description
	Parent Folder	The selected folder	Specifies the folder into which the new message file will be placed.
	File Name	message.xml	Specifies the name of the new message file.




Related topics
	the section called “Creating test messages for route tracing”




Name
New Camel JUnit Test Case — Configures the JUnit artifacts created to test a Apache Camel route.

Properties

					Table A.5 describes the properties you can specify.
				
Table A.5. New Camel JUnit properties
	Name	Default	Description
	Source Folder	project/src/test/java	Specifies the folder into which the JUnit code is placed.
	Package	Name of the package when the project was created	Specifies the package name for the JUnit code.
	Camel XML file under test	Selected context file, or blank if other than a context file is selected	Specifies the Camel XML file containing the routes to be tested.
	Name	classname based on the selected context file (for example, CamelContextXMLTest), or empty if none selected	Specifies the name of the JUnit class.
	Method stubs	 	Specifies the JUnit method stubs to include in the generated test class.
	Generate comments	 	Specifies whether to generate comments in the new test class.




Related topics
	Chapter 8, Creating a new Apache Camel JUnit test case




Name
Test Endpoints — Lists the endpoints that can be tested by a JUnit test case.

Properties

					Table A.6 describes the properties you can specify.
				
Table A.6. Test Endpoint properties
	Name	Default	Description
	Available endpoints	all	Specifies the endpoints to test in the Camel JUnit test case.




Related topics
	Chapter 8, Creating a new Apache Camel JUnit test case




Name
Define a New Server — Defines a new server instance.

Properties

					Table A.7 describes the properties you can specify.
				
Table A.7. New Server properties
	Name	Default	Description
	Server type	 	Specifies the type of server to define.
	Server's host name	 	Specifies the name of the machine running the server.
	Server name	 	Specifies the name of the server.
	Server runtime environment	Selected server's runtime	Specifies the runtime environment of the server.




Related topics
	the section called “Adding a Server”




Name
New Server Configuration — Configures access details for the server.

Properties

					Table A.8 describes the properties you can specify.
				
Table A.8. Server Configuration details properties
	Name	Default	Description
	Host Name	For localhost, 0.0.0.0	Specifies the address of the machine running the server.
	Port Name	8101	Specifies the port used to contact the server.
	User Name	 	[Optional] Specifies the name of a user authorized to access the server remotely. 
	Password	 	[Optional] Specifies the password the authorized user must enter to access the server remotely.




Related topics
	the section called “Adding a Server”




Name
Add and Remove — Specifies the resources available to a server.

Properties

					Table A.9 describes the properties you can specify.
				
Table A.9. Add and Remove properties
	Name	Description
	Available	Specifies the resources that are available to the server.
	Configured	Specifies the resources that the server is configured to use.




Related topics
	the section called “Adding a Server”




Name
Fabric Details — Specifies information needed to connect to a fabric.

Properties

					Table A.10 describes the properties you can specify.
				
Table A.10. Fabric Details properties
	Name	Default	Description
	Name	Local Fabric	Specifies the name of the fabric to connect to.
	Jolokia URL	https://localhost:8181/jolokia	Specifies the url, in the form of https://hostname:port/jolokia, of the specified fabric.
	User name	 	Specifies the name of a user that has login privileges.
	Password	 	Specifies the password of the specified user.
	Zookeeper Password	 	Specifies the password for accessing the fabric registry.




Related topics
	the section called “Adding fabric details”
	the section called “Editing a fabric's details”




Name
Create Child Container — Specifies information needed to create a container on the local host.

Properties

					Table A.11 describes the properties you can specify.
				
Table A.11. Create Child Container properties
	Name	Default	Description
	Container name	Container#	Specifies the name of the new container.
	Version	The highest-numbered version according to major.minor numbering	Specifies the version of the profiles to use.
	Profiles	 	Specifies the profile(s) to install in the new container.




Related topics
	the section called “Creating a new child container”




Name
Create Container via SSH — Specifies information needed to create a container on a remote host.

Properties

					Table A.12 describes the properties you can specify.
				
Table A.12. Create Container via SSH properties
	Name	Default	Description
	Container name	Container#	Specifies the name of the new container.
	Version	The highest-numbered version according to major.minor numbering	Specifies the version of the profiles to use.
	Host	 	Specifies the name or the IP address of the remote host.
	User name	 	Specifies the name of a user authorized to login to the remote host.
	Password	 	Specifies the password of the specified user.
	Path	~/containers	Specifies the path of the new container's location on the remote host.
	Port	22	Specifies the port number to use for establishing an ssh connection on the remote host.
	SSH retries	1	Specifies the maximum number of retries to attempt at establishing an ssh connection on the remote host.
	Retry delay	1	Specifies the delay, in milliseconds, between retry attempts.
	Profiles	 	Specifies the profile(s) to install in the new container.




Related topics
	the section called “Creating a container on a remote host”




Name
Create Container in a Cloud — Specifies information needed to create a container in a cloud.

Properties

					Table A.13 describes the properties you can specify.
				
Table A.13. Create Container in a Cloud:New Containers details properties
	Name	Default	Description
	Container name	Container#	Specifies the name of the new container.
	Version	The highest-numbered version according to major.minor numbering	Specifies the version of the profiles to use.
	Group	fabric	Specifies the name of the group in which to start up the new container.
	User	admin	Specifies the name of a user authorized to login to the new container.
	Location ID	 	Selects the region in which the machines you want to use are located.
	Hardware ID	 	Selects the hardware archetype to use.
	OS Family	 	Selects the general operating system to use.
	OS Version	 	Selects the version of the operating system you selected.
	Image ID	 	Selects a specific image template to use for the software configuration.
	Profiles	 	Specifies the profile(s) to install in the new container.




Related topics
	the section called “Creating a new container on a cloud”




Name
Create Version — Specifies the identifier for the new version of the fabric's profiles.

Properties

					Table A.14 describes the properties you can specify.
				
Table A.14. Create Version properties
	Name	Default	Description
	Create a new version for rolling upgrades to Profiles	The highest-numbered version according to major.minor numbering	Specifies the identifier for the new version of fabric's profiles.




Related topics
	the section called “Creating a new version of a profile”




Name
Cloud Details — Specifies information needed to connect to a cloud.

Properties

					Table A.15 describes the properties you can specify.
				
Table A.15. Cloud Details properties
	Name	Default	Description
	Name	 	Specifies the name of the cloud to connect to.
	Provider name	 	Selects the cloud provider.
	Api name	 	Selects the API to use on the specified cloud.
	Endpoint	 	Specifies the cloud endpoint uri.
	Identity	 	Specifies the account identifier (supplied by the cloud provider).
	Credential	 	Specifies the account password (supplied by the cloud provider).
	Owner	 	Specifies the name of the account owner.




Related topics
	the section called “Adding cloud details”




Name
Create Fabric in the Cloud — Specifies information needed to create a fabric in a cloud.

Properties

					Table A.16 describes the properties you can specify.
				
Table A.16. Create Fabric in a Cloud:Fabric details properties
	Name	Default	Description
	Fabric name	Cloud Fabric	Specifies the name of the new fabric.
	Container name	Registry	Specifies the name of the fabric registry container.
	Group	fabric	Specifies the name of the group in which to start up the fabric registry container.
	User	admin	Specifies the name of a user authorized to login to the fabric registry container.
	Password	 	Specifies the user's password for logging into the the fabric.
	Zookeeper Password	****************	Specifies the zookeeper password for logging into the cloud fabric's zookeeper registry.
	Location ID	 	Selects the region in which the machines you want to use are located.
	Hardware ID	 	Selects the hardware archetype to use.
	OS Family	 	Selects the general operating system to use.
	OS Version	 	Selects the version of the operating system you selected.
	Image ID	 	Selects a specific image template to use for the software configuration.
	Maven proxy URI	http://repo.fusesource.com/nexus/content/groups/ea	Specifies the Maven proxy repository to use.




Related topics
	the section called “Specifying fabric details”



Appendix B. Tooling preferences





Name
Editor — Sets the default value for some route editor properties.

Properties

					Table B.1 describes the properties you can specify.
				
Table B.1. Editor Properties
	Name	Default	Description
	Language	Simple	Specifies the default expression language used by the route editor.
	ID values	Enabled	Determines whether ID values are used to label EIP nodes on the route editor's canvas.
	Layout direction	Right	Specifies the direction in which routes are laid out on the route editor's canvas.
	Diagram grid	Enabled	Determines whether a grid overly is displayed in the background on the route editor's canvas.




Related topics
	the section called “Configuring the route editor”




Name
Colors — Sets the default colors for diagrammatic components of Route editor.

Properties

					Table B.2 describes the properties you can specify.
				
Table B.2. Colors Properties
	Name	Description
	Route Editor Diagram Grid Color	Specifies the default color for the diagram grid.
	Route Editor Diagram Connection Color	Specifies the default color for the connection in the diagram.
	Route Editor Diagram Text Color	Specifies the default color for the text in the diagram.
	Route Editor Diagram Figure Background	Specifies the default color of EIP node background.
	Route Editor Diagram Figure Foreground	Specifies the default color of EIP node foreground.




Related topics
	the section called “Configuring the route editor”




Name
Editor — Sets the default value for some route editor properties.

Properties

					Table B.1 describes the properties you can specify.
				
Table B.1. Editor Properties
	Name	Default	Description
	Language	Simple	Specifies the default expression language used by the route editor.
	ID values	Enabled	Determines whether ID values are used to label EIP nodes on the route editor's canvas.
	Layout direction	Right	Specifies the direction in which routes are laid out on the route editor's canvas.
	Diagram grid	Enabled	Determines whether a grid overly is displayed in the background on the route editor's canvas.




Related topics
	the section called “Configuring the route editor”




Name
Colors — Sets the default colors for diagrammatic components of Route editor.

Properties

					Table B.2 describes the properties you can specify.
				
Table B.2. Colors Properties
	Name	Description
	Route Editor Diagram Grid Color	Specifies the default color for the diagram grid.
	Route Editor Diagram Connection Color	Specifies the default color for the connection in the diagram.
	Route Editor Diagram Text Color	Specifies the default color for the text in the diagram.
	Route Editor Diagram Figure Background	Specifies the default color of EIP node background.
	Route Editor Diagram Figure Foreground	Specifies the default color of EIP node foreground.




Related topics
	the section called “Configuring the route editor”
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# Highlight.js

Highlight.js — это подсветчик синтаксиса, написанный на JavaScript. Он работает
и в браузере, и на сервере. Он работает с практически любой HTML разметкой, не
зависит от каких-либо фреймворков и умеет автоматически определять язык.


## Начало работы

Минимум, что нужно сделать для использования highlight.js на веб-странице — это
подключить библиотеку, CSS-стили и вызывать [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

Библиотека найдёт и раскрасит код внутри тегов `<pre><code>`, попытавшись
автоматически определить язык. Когда автоопределение не срабатывает, можно явно
указать язык в атрибуте class:

```html
<pre><code class="html">...</code></pre>
```

Список поддерживаемых классов языков доступен в [справочнике по классам][8].
Класс также можно предваоить префиксами `language-` или `lang-`.

Чтобы отключить подсветку для какого-то блока, используйте класс `nohighlight`:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Инициализация вручную

Чтобы иметь чуть больше контроля за инициализацией подсветки, вы можете
использовать функции [`highlightBlock`][2] и [`configure`][3]. Таким образом
можно управлять тем, *что* подсвечивать и *когда*.

Вот пример инициализация, эквивалентной вызову [`initHighlightingOnLoad`][1], но
с использованием jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

Вы можете использовать любые теги разметки вместо `<pre><code>`. Если
используете контейнер, не сохраняющий переводы строк, вам нужно сказать
highlight.js использовать для них тег `<br>`:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

Другие опции можно найти в документации функции [`configure`][3].


## Установка библиотеки

Highlight.js можно использовать в браузере прямо с CDN хостинга или скачать
индивидуальную сборку, а также установив модуль на сервере. На
[страница загрузки][4] подробно описаны все варианты.

Обратите внимание, что библиотека не предназначена для использования в виде
исходного кода на GitHub, а требует отдельной сборки. Если вам не подходит ни
один из готовых вариантов, читайте [документацию по сборке][5].


## Лицензия

Highlight.js распространяется под лицензией BSD. Подробнее читайте файл
[LICENSE][10].


## Ссылки

Официальный сайт билиотеки расположен по адресу <https://highlightjs.org/>.

Более подробная документация по API и другим темам расположена на
<http://highlightjs.readthedocs.org/>.

Авторы и контрибьютора перечислена в файле [AUTHORS.ru.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.ru.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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/*! jQuery v1.7.1 jquery.com | jquery.org/license */
(function(a,b){function cy(a){return f.isWindow(a)?a:a.nodeType===9?a.defaultView||a.parentWindow:!1}function cv(a){if(!ck[a]){var b=c.body,d=f("<"+a+">").appendTo(b),e=d.css("display");d.remove();if(e==="none"||e===""){cl||(cl=c.createElement("iframe"),cl.frameBorder=cl.width=cl.height=0),b.appendChild(cl);if(!cm||!cl.createElement)cm=(cl.contentWindow||cl.contentDocument).document,cm.write((c.compatMode==="CSS1Compat"?"<!doctype html>":"")+"<html><body>"),cm.close();d=cm.createElement(a),cm.body.appendChild(d),e=f.css(d,"display"),b.removeChild(cl)}ck[a]=e}return ck[a]}function cu(a,b){var c={};f.each(cq.concat.apply([],cq.slice(0,b)),function(){c[this]=a});return c}function ct(){cr=b}function cs(){setTimeout(ct,0);return cr=f.now()}function cj(){try{return new a.ActiveXObject("Microsoft.XMLHTTP")}catch(b){}}function ci(){try{return new a.XMLHttpRequest}catch(b){}}function cc(a,c){a.dataFilter&&(c=a.dataFilter(c,a.dataType));var d=a.dataTypes,e={},g,h,i=d.length,j,k=d[0],l,m,n,o,p;for(g=1;g<i;g++){if(g===1)for(h in a.converters)typeof h=="string"&&(e[h.toLowerCase()]=a.converters[h]);l=k,k=d[g];if(k==="*")k=l;else if(l!=="*"&&l!==k){m=l+" "+k,n=e[m]||e["* "+k];if(!n){p=b;for(o in e){j=o.split(" ");if(j[0]===l||j[0]==="*"){p=e[j[1]+" "+k];if(p){o=e[o],o===!0?n=p:p===!0&&(n=o);break}}}}!n&&!p&&f.error("No conversion from "+m.replace(" "," to ")),n!==!0&&(c=n?n(c):p(o(c)))}}return c}function cb(a,c,d){var e=a.contents,f=a.dataTypes,g=a.responseFields,h,i,j,k;for(i in g)i in d&&(c[g[i]]=d[i]);while(f[0]==="*")f.shift(),h===b&&(h=a.mimeType||c.getResponseHeader("content-type"));if(h)for(i in e)if(e[i]&&e[i].test(h)){f.unshift(i);break}if(f[0]in d)j=f[0];else{for(i in d){if(!f[0]||a.converters[i+" "+f[0]]){j=i;break}k||(k=i)}j=j||k}if(j){j!==f[0]&&f.unshift(j);return d[j]}}function ca(a,b,c,d){if(f.isArray(b))f.each(b,function(b,e){c||bE.test(a)?d(a,e):ca(a+"["+(typeof e=="object"||f.isArray(e)?b:"")+"]",e,c,d)});else if(!c&&b!=null&&typeof b=="object")for(var e in b)ca(a+"["+e+"]",b[e],c,d);else d(a,b)}function b_(a,c){var d,e,g=f.ajaxSettings.flatOptions||{};for(d in c)c[d]!==b&&((g[d]?a:e||(e={}))[d]=c[d]);e&&f.extend(!0,a,e)}function b$(a,c,d,e,f,g){f=f||c.dataTypes[0],g=g||{},g[f]=!0;var h=a[f],i=0,j=h?h.length:0,k=a===bT,l;for(;i<j&&(k||!l);i++)l=h[i](c,d,e),typeof l=="string"&&(!k||g[l]?l=b:(c.dataTypes.unshift(l),l=b$(a,c,d,e,l,g)));(k||!l)&&!g["*"]&&(l=b$(a,c,d,e,"*",g));return l}function bZ(a){return function(b,c){typeof b!="string"&&(c=b,b="*");if(f.isFunction(c)){var d=b.toLowerCase().split(bP),e=0,g=d.length,h,i,j;for(;e<g;e++)h=d[e],j=/^\+/.test(h),j&&(h=h.substr(1)||"*"),i=a[h]=a[h]||[],i[j?"unshift":"push"](c)}}}function bC(a,b,c){var d=b==="width"?a.offsetWidth:a.offsetHeight,e=b==="width"?bx:by,g=0,h=e.length;if(d>0){if(c!=="border")for(;g<h;g++)c||(d-=parseFloat(f.css(a,"padding"+e[g]))||0),c==="margin"?d+=parseFloat(f.css(a,c+e[g]))||0:d-=parseFloat(f.css(a,"border"+e[g]+"Width"))||0;return d+"px"}d=bz(a,b,b);if(d<0||d==null)d=a.style[b]||0;d=parseFloat(d)||0;if(c)for(;g<h;g++)d+=parseFloat(f.css(a,"padding"+e[g]))||0,c!=="padding"&&(d+=parseFloat(f.css(a,"border"+e[g]+"Width"))||0),c==="margin"&&(d+=parseFloat(f.css(a,c+e[g]))||0);return d+"px"}function bp(a,b){b.src?f.ajax({url:b.src,async:!1,dataType:"script"}):f.globalEval((b.text||b.textContent||b.innerHTML||"").replace(bf,"/*$0*/")),b.parentNode&&b.parentNode.removeChild(b)}function bo(a){var b=c.createElement("div");bh.appendChild(b),b.innerHTML=a.outerHTML;return b.firstChild}function bn(a){var b=(a.nodeName||"").toLowerCase();b==="input"?bm(a):b!=="script"&&typeof a.getElementsByTagName!="undefined"&&f.grep(a.getElementsByTagName("input"),bm)}function bm(a){if(a.type==="checkbox"||a.type==="radio")a.defaultChecked=a.checked}function bl(a){return typeof a.getElementsByTagName!="undefined"?a.getElementsByTagName("*"):typeof a.querySelectorAll!="undefined"?a.querySelectorAll("*"):[]}function bk(a,b){var c;if(b.nodeType===1){b.clearAttributes&&b.clearAttributes(),b.mergeAttributes&&b.mergeAttributes(a),c=b.nodeName.toLowerCase();if(c==="object")b.outerHTML=a.outerHTML;else if(c!=="input"||a.type!=="checkbox"&&a.type!=="radio"){if(c==="option")b.selected=a.defaultSelected;else if(c==="input"||c==="textarea")b.defaultValue=a.defaultValue}else a.checked&&(b.defaultChecked=b.checked=a.checked),b.value!==a.value&&(b.value=a.value);b.removeAttribute(f.expando)}}function bj(a,b){if(b.nodeType===1&&!!f.hasData(a)){var c,d,e,g=f._data(a),h=f._data(b,g),i=g.events;if(i){delete h.handle,h.events={};for(c in i)for(d=0,e=i[c].length;d<e;d++)f.event.add(b,c+(i[c][d].namespace?".":"")+i[c][d].namespace,i[c][d],i[c][d].data)}h.data&&(h.data=f.extend({},h.data))}}function bi(a,b){return f.nodeName(a,"table")?a.getElementsByTagName("tbody")[0]||a.appendChild(a.ownerDocument.createElement("tbody")):a}function U(a){var b=V.split("|"),c=a.createDocumentFragment();if(c.createElement)while(b.length)c.createElement(b.pop());return c}function T(a,b,c){b=b||0;if(f.isFunction(b))return f.grep(a,function(a,d){var e=!!b.call(a,d,a);return e===c});if(b.nodeType)return f.grep(a,function(a,d){return a===b===c});if(typeof b=="string"){var d=f.grep(a,function(a){return a.nodeType===1});if(O.test(b))return f.filter(b,d,!c);b=f.filter(b,d)}return f.grep(a,function(a,d){return f.inArray(a,b)>=0===c})}function S(a){return!a||!a.parentNode||a.parentNode.nodeType===11}function K(){return!0}function J(){return!1}function n(a,b,c){var d=b+"defer",e=b+"queue",g=b+"mark",h=f._data(a,d);h&&(c==="queue"||!f._data(a,e))&&(c==="mark"||!f._data(a,g))&&setTimeout(function(){!f._data(a,e)&&!f._data(a,g)&&(f.removeData(a,d,!0),h.fire())},0)}function m(a){for(var b in a){if(b==="data"&&f.isEmptyObject(a[b]))continue;if(b!=="toJSON")return!1}return!0}function l(a,c,d){if(d===b&&a.nodeType===1){var e="data-"+c.replace(k,"-$1").toLowerCase();d=a.getAttribute(e);if(typeof d=="string"){try{d=d==="true"?!0:d==="false"?!1:d==="null"?null:f.isNumeric(d)?parseFloat(d):j.test(d)?f.parseJSON(d):d}catch(g){}f.data(a,c,d)}else d=b}return d}function h(a){var b=g[a]={},c,d;a=a.split(/\s+/);for(c=0,d=a.length;c<d;c++)b[a[c]]=!0;return b}var c=a.document,d=a.navigator,e=a.location,f=function(){function J(){if(!e.isReady){try{c.documentElement.doScroll("left")}catch(a){setTimeout(J,1);return}e.ready()}}var e=function(a,b){return new e.fn.init(a,b,h)},f=a.jQuery,g=a.$,h,i=/^(?:[^#<]*(<[\w\W]+>)[^>]*$|#([\w\-]*)$)/,j=/\S/,k=/^\s+/,l=/\s+$/,m=/^<(\w+)\s*\/?>(?:<\/\1>)?$/,n=/^[\],:{}\s]*$/,o=/\\(?:["\\\/bfnrt]|u[0-9a-fA-F]{4})/g,p=/"[^"\\\n\r]*"|true|false|null|-?\d+(?:\.\d*)?(?:[eE][+\-]?\d+)?/g,q=/(?:^|:|,)(?:\s*\[)+/g,r=/(webkit)[ \/]([\w.]+)/,s=/(opera)(?:.*version)?[ \/]([\w.]+)/,t=/(msie) ([\w.]+)/,u=/(mozilla)(?:.*? rv:([\w.]+))?/,v=/-([a-z]|[0-9])/ig,w=/^-ms-/,x=function(a,b){return(b+"").toUpperCase()},y=d.userAgent,z,A,B,C=Object.prototype.toString,D=Object.prototype.hasOwnProperty,E=Array.prototype.push,F=Array.prototype.slice,G=String.prototype.trim,H=Array.prototype.indexOf,I={};e.fn=e.prototype={constructor:e,init:function(a,d,f){var g,h,j,k;if(!a)return this;if(a.nodeType){this.context=this[0]=a,this.length=1;return this}if(a==="body"&&!d&&c.body){this.context=c,this[0]=c.body,this.selector=a,this.length=1;return this}if(typeof a=="string"){a.charAt(0)!=="<"||a.charAt(a.length-1)!==">"||a.length<3?g=i.exec(a):g=[null,a,null];if(g&&(g[1]||!d)){if(g[1]){d=d instanceof e?d[0]:d,k=d?d.ownerDocument||d:c,j=m.exec(a),j?e.isPlainObject(d)?(a=[c.createElement(j[1])],e.fn.attr.call(a,d,!0)):a=[k.createElement(j[1])]:(j=e.buildFragment([g[1]],[k]),a=(j.cacheable?e.clone(j.fragment):j.fragment).childNodes);return e.merge(this,a)}h=c.getElementById(g[2]);if(h&&h.parentNode){if(h.id!==g[2])return f.find(a);this.length=1,this[0]=h}this.context=c,this.selector=a;return this}return!d||d.jquery?(d||f).find(a):this.constructor(d).find(a)}if(e.isFunction(a))return f.ready(a);a.selector!==b&&(this.selector=a.selector,this.context=a.context);return e.makeArray(a,this)},selector:"",jquery:"1.7.1",length:0,size:function(){return this.length},toArray:function(){return F.call(this,0)},get:function(a){return a==null?this.toArray():a<0?this[this.length+a]:this[a]},pushStack:function(a,b,c){var d=this.constructor();e.isArray(a)?E.apply(d,a):e.merge(d,a),d.prevObject=this,d.context=this.context,b==="find"?d.selector=this.selector+(this.selector?" ":"")+c:b&&(d.selector=this.selector+"."+b+"("+c+")");return d},each:function(a,b){return e.each(this,a,b)},ready:function(a){e.bindReady(),A.add(a);return this},eq:function(a){a=+a;return a===-1?this.slice(a):this.slice(a,a+1)},first:function(){return this.eq(0)},last:function(){return this.eq(-1)},slice:function(){return this.pushStack(F.apply(this,arguments),"slice",F.call(arguments).join(","))},map:function(a){return this.pushStack(e.map(this,function(b,c){return a.call(b,c,b)}))},end:function(){return this.prevObject||this.constructor(null)},push:E,sort:[].sort,splice:[].splice},e.fn.init.prototype=e.fn,e.extend=e.fn.extend=function(){var a,c,d,f,g,h,i=arguments[0]||{},j=1,k=arguments.length,l=!1;typeof i=="boolean"&&(l=i,i=arguments[1]||{},j=2),typeof i!="object"&&!e.isFunction(i)&&(i={}),k===j&&(i=this,--j);for(;j<k;j++)if((a=arguments[j])!=null)for(c in a){d=i[c],f=a[c];if(i===f)continue;l&&f&&(e.isPlainObject(f)||(g=e.isArray(f)))?(g?(g=!1,h=d&&e.isArray(d)?d:[]):h=d&&e.isPlainObject(d)?d:{},i[c]=e.extend(l,h,f)):f!==b&&(i[c]=f)}return i},e.extend({noConflict:function(b){a.$===e&&(a.$=g),b&&a.jQuery===e&&(a.jQuery=f);return e},isReady:!1,readyWait:1,holdReady:function(a){a?e.readyWait++:e.ready(!0)},ready:function(a){if(a===!0&&!--e.readyWait||a!==!0&&!e.isReady){if(!c.body)return setTimeout(e.ready,1);e.isReady=!0;if(a!==!0&&--e.readyWait>0)return;A.fireWith(c,[e]),e.fn.trigger&&e(c).trigger("ready").off("ready")}},bindReady:function(){if(!A){A=e.Callbacks("once memory");if(c.readyState==="complete")return setTimeout(e.ready,1);if(c.addEventListener)c.addEventListener("DOMContentLoaded",B,!1),a.addEventListener("load",e.ready,!1);else if(c.attachEvent){c.attachEvent("onreadystatechange",B),a.attachEvent("onload",e.ready);var b=!1;try{b=a.frameElement==null}catch(d){}c.documentElement.doScroll&&b&&J()}}},isFunction:function(a){return e.type(a)==="function"},isArray:Array.isArray||function(a){return e.type(a)==="array"},isWindow:function(a){return a&&typeof a=="object"&&"setInterval"in a},isNumeric:function(a){return!isNaN(parseFloat(a))&&isFinite(a)},type:function(a){return a==null?String(a):I[C.call(a)]||"object"},isPlainObject:function(a){if(!a||e.type(a)!=="object"||a.nodeType||e.isWindow(a))return!1;try{if(a.constructor&&!D.call(a,"constructor")&&!D.call(a.constructor.prototype,"isPrototypeOf"))return!1}catch(c){return!1}var d;for(d in a);return d===b||D.call(a,d)},isEmptyObject:function(a){for(var b in a)return!1;return!0},error:function(a){throw new Error(a)},parseJSON:function(b){if(typeof b!="string"||!b)return null;b=e.trim(b);if(a.JSON&&a.JSON.parse)return a.JSON.parse(b);if(n.test(b.replace(o,"@").replace(p,"]").replace(q,"")))return(new Function("return "+b))();e.error("Invalid JSON: "+b)},parseXML:function(c){var d,f;try{a.DOMParser?(f=new DOMParser,d=f.parseFromString(c,"text/xml")):(d=new ActiveXObject("Microsoft.XMLDOM"),d.async="false",d.loadXML(c))}catch(g){d=b}(!d||!d.documentElement||d.getElementsByTagName("parsererror").length)&&e.error("Invalid XML: "+c);return d},noop:function(){},globalEval:function(b){b&&j.test(b)&&(a.execScript||function(b){a.eval.call(a,b)})(b)},camelCase:function(a){return a.replace(w,"ms-").replace(v,x)},nodeName:function(a,b){return a.nodeName&&a.nodeName.toUpperCase()===b.toUpperCase()},each:function(a,c,d){var f,g=0,h=a.length,i=h===b||e.isFunction(a);if(d){if(i){for(f in a)if(c.apply(a[f],d)===!1)break}else for(;g<h;)if(c.apply(a[g++],d)===!1)break}else if(i){for(f in a)if(c.call(a[f],f,a[f])===!1)break}else for(;g<h;)if(c.call(a[g],g,a[g++])===!1)break;return a},trim:G?function(a){return a==null?"":G.call(a)}:function(a){return a==null?"":(a+"").replace(k,"").replace(l,"")},makeArray:function(a,b){var c=b||[];if(a!=null){var d=e.type(a);a.length==null||d==="string"||d==="function"||d==="regexp"||e.isWindow(a)?E.call(c,a):e.merge(c,a)}return c},inArray:function(a,b,c){var d;if(b){if(H)return H.call(b,a,c);d=b.length,c=c?c<0?Math.max(0,d+c):c:0;for(;c<d;c++)if(c in b&&b[c]===a)return c}return-1},merge:function(a,c){var d=a.length,e=0;if(typeof c.length=="number")for(var f=c.length;e<f;e++)a[d++]=c[e];else while(c[e]!==b)a[d++]=c[e++];a.length=d;return a},grep:function(a,b,c){var d=[],e;c=!!c;for(var f=0,g=a.length;f<g;f++)e=!!b(a[f],f),c!==e&&d.push(a[f]);return d},map:function(a,c,d){var f,g,h=[],i=0,j=a.length,k=a instanceof e||j!==b&&typeof j=="number"&&(j>0&&a[0]&&a[j-1]||j===0||e.isArray(a));if(k)for(;i<j;i++)f=c(a[i],i,d),f!=null&&(h[h.length]=f);else for(g in a)f=c(a[g],g,d),f!=null&&(h[h.length]=f);return h.concat.apply([],h)},guid:1,proxy:function(a,c){if(typeof c=="string"){var d=a[c];c=a,a=d}if(!e.isFunction(a))return b;var f=F.call(arguments,2),g=function(){return a.apply(c,f.concat(F.call(arguments)))};g.guid=a.guid=a.guid||g.guid||e.guid++;return g},access:function(a,c,d,f,g,h){var i=a.length;if(typeof c=="object"){for(var j in c)e.access(a,j,c[j],f,g,d);return a}if(d!==b){f=!h&&f&&e.isFunction(d);for(var k=0;k<i;k++)g(a[k],c,f?d.call(a[k],k,g(a[k],c)):d,h);return a}return i?g(a[0],c):b},now:function(){return(new Date).getTime()},uaMatch:function(a){a=a.toLowerCase();var b=r.exec(a)||s.exec(a)||t.exec(a)||a.indexOf("compatible")<0&&u.exec(a)||[];return{browser:b[1]||"",version:b[2]||"0"}},sub:function(){function a(b,c){return new a.fn.init(b,c)}e.extend(!0,a,this),a.superclass=this,a.fn=a.prototype=this(),a.fn.constructor=a,a.sub=this.sub,a.fn.init=function(d,f){f&&f instanceof e&&!(f instanceof a)&&(f=a(f));return e.fn.init.call(this,d,f,b)},a.fn.init.prototype=a.fn;var b=a(c);return a},browser:{}}),e.each("Boolean Number String Function Array Date RegExp Object".split(" "),function(a,b){I["[object "+b+"]"]=b.toLowerCase()}),z=e.uaMatch(y),z.browser&&(e.browser[z.browser]=!0,e.browser.version=z.version),e.browser.webkit&&(e.browser.safari=!0),j.test(" ")&&(k=/^[\s\xA0]+/,l=/[\s\xA0]+$/),h=e(c),c.addEventListener?B=function(){c.removeEventListener("DOMContentLoaded",B,!1),e.ready()}:c.attachEvent&&(B=function(){c.readyState==="complete"&&(c.detachEvent("onreadystatechange",B),e.ready())});return e}(),g={};f.Callbacks=function(a){a=a?g[a]||h(a):{};var c=[],d=[],e,i,j,k,l,m=function(b){var d,e,g,h,i;for(d=0,e=b.length;d<e;d++)g=b[d],h=f.type(g),h==="array"?m(g):h==="function"&&(!a.unique||!o.has(g))&&c.push(g)},n=function(b,f){f=f||[],e=!a.memory||[b,f],i=!0,l=j||0,j=0,k=c.length;for(;c&&l<k;l++)if(c[l].apply(b,f)===!1&&a.stopOnFalse){e=!0;break}i=!1,c&&(a.once?e===!0?o.disable():c=[]:d&&d.length&&(e=d.shift(),o.fireWith(e[0],e[1])))},o={add:function(){if(c){var a=c.length;m(arguments),i?k=c.length:e&&e!==!0&&(j=a,n(e[0],e[1]))}return this},remove:function(){if(c){var b=arguments,d=0,e=b.length;for(;d<e;d++)for(var f=0;f<c.length;f++)if(b[d]===c[f]){i&&f<=k&&(k--,f<=l&&l--),c.splice(f--,1);if(a.unique)break}}return this},has:function(a){if(c){var b=0,d=c.length;for(;b<d;b++)if(a===c[b])return!0}return!1},empty:function(){c=[];return this},disable:function(){c=d=e=b;return this},disabled:function(){return!c},lock:function(){d=b,(!e||e===!0)&&o.disable();return this},locked:function(){return!d},fireWith:function(b,c){d&&(i?a.once||d.push([b,c]):(!a.once||!e)&&n(b,c));return this},fire:function(){o.fireWith(this,arguments);return this},fired:function(){return!!e}};return o};var i=[].slice;f.extend({Deferred:function(a){var b=f.Callbacks("once memory"),c=f.Callbacks("once memory"),d=f.Callbacks("memory"),e="pending",g={resolve:b,reject:c,notify:d},h={done:b.add,fail:c.add,progress:d.add,state:function(){return e},isResolved:b.fired,isRejected:c.fired,then:function(a,b,c){i.done(a).fail(b).progress(c);return this},always:function(){i.done.apply(i,arguments).fail.apply(i,arguments);return this},pipe:function(a,b,c){return f.Deferred(function(d){f.each({done:[a,"resolve"],fail:[b,"reject"],progress:[c,"notify"]},function(a,b){var c=b[0],e=b[1],g;f.isFunction(c)?i[a](function(){g=c.apply(this,arguments),g&&f.isFunction(g.promise)?g.promise().then(d.resolve,d.reject,d.notify):d[e+"With"](this===i?d:this,[g])}):i[a](d[e])})}).promise()},promise:function(a){if(a==null)a=h;else for(var b in h)a[b]=h[b];return a}},i=h.promise({}),j;for(j in g)i[j]=g[j].fire,i[j+"With"]=g[j].fireWith;i.done(function(){e="resolved"},c.disable,d.lock).fail(function(){e="rejected"},b.disable,d.lock),a&&a.call(i,i);return i},when:function(a){function m(a){return function(b){e[a]=arguments.length>1?i.call(arguments,0):b,j.notifyWith(k,e)}}function l(a){return function(c){b[a]=arguments.length>1?i.call(arguments,0):c,--g||j.resolveWith(j,b)}}var b=i.call(arguments,0),c=0,d=b.length,e=Array(d),g=d,h=d,j=d<=1&&a&&f.isFunction(a.promise)?a:f.Deferred(),k=j.promise();if(d>1){for(;c<d;c++)b[c]&&b[c].promise&&f.isFunction(b[c].promise)?b[c].promise().then(l(c),j.reject,m(c)):--g;g||j.resolveWith(j,b)}else j!==a&&j.resolveWith(j,d?[a]:[]);return k}}),f.support=function(){var b,d,e,g,h,i,j,k,l,m,n,o,p,q=c.createElement("div"),r=c.documentElement;q.setAttribute("className","t"),q.innerHTML="   <link/><table></table><a href='/a' style='top:1px;float:left;opacity:.55;'>a</a><input type='checkbox'/>",d=q.getElementsByTagName("*"),e=q.getElementsByTagName("a")[0];if(!d||!d.length||!e)return{};g=c.createElement("select"),h=g.appendChild(c.createElement("option")),i=q.getElementsByTagName("input")[0],b={leadingWhitespace:q.firstChild.nodeType===3,tbody:!q.getElementsByTagName("tbody").length,htmlSerialize:!!q.getElementsByTagName("link").length,style:/top/.test(e.getAttribute("style")),hrefNormalized:e.getAttribute("href")==="/a",opacity:/^0.55/.test(e.style.opacity),cssFloat:!!e.style.cssFloat,checkOn:i.value==="on",optSelected:h.selected,getSetAttribute:q.className!=="t",enctype:!!c.createElement("form").enctype,html5Clone:c.createElement("nav").cloneNode(!0).outerHTML!=="<:nav></:nav>",submitBubbles:!0,changeBubbles:!0,focusinBubbles:!1,deleteExpando:!0,noCloneEvent:!0,inlineBlockNeedsLayout:!1,shrinkWrapBlocks:!1,reliableMarginRight:!0},i.checked=!0,b.noCloneChecked=i.cloneNode(!0).checked,g.disabled=!0,b.optDisabled=!h.disabled;try{delete q.test}catch(s){b.deleteExpando=!1}!q.addEventListener&&q.attachEvent&&q.fireEvent&&(q.attachEvent("onclick",function(){b.noCloneEvent=!1}),q.cloneNode(!0).fireEvent("onclick")),i=c.createElement("input"),i.value="t",i.setAttribute("type","radio"),b.radioValue=i.value==="t",i.setAttribute("checked","checked"),q.appendChild(i),k=c.createDocumentFragment(),k.appendChild(q.lastChild),b.checkClone=k.cloneNode(!0).cloneNode(!0).lastChild.checked,b.appendChecked=i.checked,k.removeChild(i),k.appendChild(q),q.innerHTML="",a.getComputedStyle&&(j=c.createElement("div"),j.style.width="0",j.style.marginRight="0",q.style.width="2px",q.appendChild(j),b.reliableMarginRight=(parseInt((a.getComputedStyle(j,null)||{marginRight:0}).marginRight,10)||0)===0);if(q.attachEvent)for(o in{submit:1,change:1,focusin:1})n="on"+o,p=n in q,p||(q.setAttribute(n,"return;"),p=typeof q[n]=="function"),b[o+"Bubbles"]=p;k.removeChild(q),k=g=h=j=q=i=null,f(function(){var a,d,e,g,h,i,j,k,m,n,o,r=c.getElementsByTagName("body")[0];!r||(j=1,k="position:absolute;top:0;left:0;width:1px;height:1px;margin:0;",m="visibility:hidden;border:0;",n="style='"+k+"border:5px solid #000;padding:0;'",o="<div "+n+"><div></div></div>"+"<table "+n+" cellpadding='0' cellspacing='0'>"+"<tr><td></td></tr></table>",a=c.createElement("div"),a.style.cssText=m+"width:0;height:0;position:static;top:0;margin-top:"+j+"px",r.insertBefore(a,r.firstChild),q=c.createElement("div"),a.appendChild(q),q.innerHTML="<table><tr><td style='padding:0;border:0;display:none'></td><td>t</td></tr></table>",l=q.getElementsByTagName("td"),p=l[0].offsetHeight===0,l[0].style.display="",l[1].style.display="none",b.reliableHiddenOffsets=p&&l[0].offsetHeight===0,q.innerHTML="",q.style.width=q.style.paddingLeft="1px",f.boxModel=b.boxModel=q.offsetWidth===2,typeof q.style.zoom!="undefined"&&(q.style.display="inline",q.style.zoom=1,b.inlineBlockNeedsLayout=q.offsetWidth===2,q.style.display="",q.innerHTML="<div style='width:4px;'></div>",b.shrinkWrapBlocks=q.offsetWidth!==2),q.style.cssText=k+m,q.innerHTML=o,d=q.firstChild,e=d.firstChild,h=d.nextSibling.firstChild.firstChild,i={doesNotAddBorder:e.offsetTop!==5,doesAddBorderForTableAndCells:h.offsetTop===5},e.style.position="fixed",e.style.top="20px",i.fixedPosition=e.offsetTop===20||e.offsetTop===15,e.style.position=e.style.top="",d.style.overflow="hidden",d.style.position="relative",i.subtractsBorderForOverflowNotVisible=e.offsetTop===-5,i.doesNotIncludeMarginInBodyOffset=r.offsetTop!==j,r.removeChild(a),q=a=null,f.extend(b,i))});return b}();var j=/^(?:\{.*\}|\[.*\])$/,k=/([A-Z])/g;f.extend({cache:{},uuid:0,expando:"jQuery"+(f.fn.jquery+Math.random()).replace(/\D/g,""),noData:{embed:!0,object:"clsid:D27CDB6E-AE6D-11cf-96B8-444553540000",applet:!0},hasData:function(a){a=a.nodeType?f.cache[a[f.expando]]:a[f.expando];return!!a&&!m(a)},data:function(a,c,d,e){if(!!f.acceptData(a)){var g,h,i,j=f.expando,k=typeof c=="string",l=a.nodeType,m=l?f.cache:a,n=l?a[j]:a[j]&&j,o=c==="events";if((!n||!m[n]||!o&&!e&&!m[n].data)&&k&&d===b)return;n||(l?a[j]=n=++f.uuid:n=j),m[n]||(m[n]={},l||(m[n].toJSON=f.noop));if(typeof c=="object"||typeof c=="function")e?m[n]=f.extend(m[n],c):m[n].data=f.extend(m[n].data,c);g=h=m[n],e||(h.data||(h.data={}),h=h.data),d!==b&&(h[f.camelCase(c)]=d);if(o&&!h[c])return g.events;k?(i=h[c],i==null&&(i=h[f.camelCase(c)])):i=h;return i}},removeData:function(a,b,c){if(!!f.acceptData(a)){var d,e,g,h=f.expando,i=a.nodeType,j=i?f.cache:a,k=i?a[h]:h;if(!j[k])return;if(b){d=c?j[k]:j[k].data;if(d){f.isArray(b)||(b in d?b=[b]:(b=f.camelCase(b),b in d?b=[b]:b=b.split(" ")));for(e=0,g=b.length;e<g;e++)delete d[b[e]];if(!(c?m:f.isEmptyObject)(d))return}}if(!c){delete j[k].data;if(!m(j[k]))return}f.support.deleteExpando||!j.setInterval?delete j[k]:j[k]=null,i&&(f.support.deleteExpando?delete a[h]:a.removeAttribute?a.removeAttribute(h):a[h]=null)}},_data:function(a,b,c){return f.data(a,b,c,!0)},acceptData:function(a){if(a.nodeName){var b=f.noData[a.nodeName.toLowerCase()];if(b)return b!==!0&&a.getAttribute("classid")===b}return!0}}),f.fn.extend({data:function(a,c){var d,e,g,h=null;if(typeof a=="undefined"){if(this.length){h=f.data(this[0]);if(this[0].nodeType===1&&!f._data(this[0],"parsedAttrs")){e=this[0].attributes;for(var i=0,j=e.length;i<j;i++)g=e[i].name,g.indexOf("data-")===0&&(g=f.camelCase(g.substring(5)),l(this[0],g,h[g]));f._data(this[0],"parsedAttrs",!0)}}return h}if(typeof a=="object")return this.each(function(){f.data(this,a)});d=a.split("."),d[1]=d[1]?"."+d[1]:"";if(c===b){h=this.triggerHandler("getData"+d[1]+"!",[d[0]]),h===b&&this.length&&(h=f.data(this[0],a),h=l(this[0],a,h));return h===b&&d[1]?this.data(d[0]):h}return this.each(function(){var b=f(this),e=[d[0],c];b.triggerHandler("setData"+d[1]+"!",e),f.data(this,a,c),b.triggerHandler("changeData"+d[1]+"!",e)})},removeData:function(a){return this.each(function(){f.removeData(this,a)})}}),f.extend({_mark:function(a,b){a&&(b=(b||"fx")+"mark",f._data(a,b,(f._data(a,b)||0)+1))},_unmark:function(a,b,c){a!==!0&&(c=b,b=a,a=!1);if(b){c=c||"fx";var d=c+"mark",e=a?0:(f._data(b,d)||1)-1;e?f._data(b,d,e):(f.removeData(b,d,!0),n(b,c,"mark"))}},queue:function(a,b,c){var d;if(a){b=(b||"fx")+"queue",d=f._data(a,b),c&&(!d||f.isArray(c)?d=f._data(a,b,f.makeArray(c)):d.push(c));return d||[]}},dequeue:function(a,b){b=b||"fx";var c=f.queue(a,b),d=c.shift(),e={};d==="inprogress"&&(d=c.shift()),d&&(b==="fx"&&c.unshift("inprogress"),f._data(a,b+".run",e),d.call(a,function(){f.dequeue(a,b)},e)),c.length||(f.removeData(a,b+"queue "+b+".run",!0),n(a,b,"queue"))}}),f.fn.extend({queue:function(a,c){typeof a!="string"&&(c=a,a="fx");if(c===b)return f.queue(this[0],a);return this.each(function(){var b=f.queue(this,a,c);a==="fx"&&b[0]!=="inprogress"&&f.dequeue(this,a)})},dequeue:function(a){return this.each(function(){f.dequeue(this,a)})},delay:function(a,b){a=f.fx?f.fx.speeds[a]||a:a,b=b||"fx";return this.queue(b,function(b,c){var d=setTimeout(b,a);c.stop=function(){clearTimeout(d)}})},clearQueue:function(a){return this.queue(a||"fx",[])},promise:function(a,c){function m(){--h||d.resolveWith(e,[e])}typeof a!="string"&&(c=a,a=b),a=a||"fx";var d=f.Deferred(),e=this,g=e.length,h=1,i=a+"defer",j=a+"queue",k=a+"mark",l;while(g--)if(l=f.data(e[g],i,b,!0)||(f.data(e[g],j,b,!0)||f.data(e[g],k,b,!0))&&f.data(e[g],i,f.Callbacks("once memory"),!0))h++,l.add(m);m();return d.promise()}});var o=/[\n\t\r]/g,p=/\s+/,q=/\r/g,r=/^(?:button|input)$/i,s=/^(?:button|input|object|select|textarea)$/i,t=/^a(?:rea)?$/i,u=/^(?:autofocus|autoplay|async|checked|controls|defer|disabled|hidden|loop|multiple|open|readonly|required|scoped|selected)$/i,v=f.support.getSetAttribute,w,x,y;f.fn.extend({attr:function(a,b){return f.access(this,a,b,!0,f.attr)},removeAttr:function(a){return this.each(function(){f.removeAttr(this,a)})},prop:function(a,b){return f.access(this,a,b,!0,f.prop)},removeProp:function(a){a=f.propFix[a]||a;return this.each(function(){try{this[a]=b,delete this[a]}catch(c){}})},addClass:function(a){var b,c,d,e,g,h,i;if(f.isFunction(a))return this.each(function(b){f(this).addClass(a.call(this,b,this.className))});if(a&&typeof a=="string"){b=a.split(p);for(c=0,d=this.length;c<d;c++){e=this[c];if(e.nodeType===1)if(!e.className&&b.length===1)e.className=a;else{g=" "+e.className+" ";for(h=0,i=b.length;h<i;h++)~g.indexOf(" "+b[h]+" ")||(g+=b[h]+" ");e.className=f.trim(g)}}}return this},removeClass:function(a){var c,d,e,g,h,i,j;if(f.isFunction(a))return this.each(function(b){f(this).removeClass(a.call(this,b,this.className))});if(a&&typeof a=="string"||a===b){c=(a||"").split(p);for(d=0,e=this.length;d<e;d++){g=this[d];if(g.nodeType===1&&g.className)if(a){h=(" "+g.className+" ").replace(o," ");for(i=0,j=c.length;i<j;i++)h=h.replace(" "+c[i]+" "," ");g.className=f.trim(h)}else g.className=""}}return this},toggleClass:function(a,b){var c=typeof a,d=typeof b=="boolean";if(f.isFunction(a))return this.each(function(c){f(this).toggleClass(a.call(this,c,this.className,b),b)});return this.each(function(){if(c==="string"){var e,g=0,h=f(this),i=b,j=a.split(p);while(e=j[g++])i=d?i:!h.hasClass(e),h[i?"addClass":"removeClass"](e)}else if(c==="undefined"||c==="boolean")this.className&&f._data(this,"__className__",this.className),this.className=this.className||a===!1?"":f._data(this,"__className__")||""})},hasClass:function(a){var b=" "+a+" ",c=0,d=this.length;for(;c<d;c++)if(this[c].nodeType===1&&(" "+this[c].className+" ").replace(o," ").indexOf(b)>-1)return!0;return!1},val:function(a){var c,d,e,g=this[0];{if(!!arguments.length){e=f.isFunction(a);return this.each(function(d){var g=f(this),h;if(this.nodeType===1){e?h=a.call(this,d,g.val()):h=a,h==null?h="":typeof h=="number"?h+="":f.isArray(h)&&(h=f.map(h,function(a){return a==null?"":a+""})),c=f.valHooks[this.nodeName.toLowerCase()]||f.valHooks[this.type];if(!c||!("set"in c)||c.set(this,h,"value")===b)this.value=h}})}if(g){c=f.valHooks[g.nodeName.toLowerCase()]||f.valHooks[g.type];if(c&&"get"in c&&(d=c.get(g,"value"))!==b)return d;d=g.value;return typeof d=="string"?d.replace(q,""):d==null?"":d}}}}),f.extend({valHooks:{option:{get:function(a){var b=a.attributes.value;return!b||b.specified?a.value:a.text}},select:{get:function(a){var b,c,d,e,g=a.selectedIndex,h=[],i=a.options,j=a.type==="select-one";if(g<0)return null;c=j?g:0,d=j?g+1:i.length;for(;c<d;c++){e=i[c];if(e.selected&&(f.support.optDisabled?!e.disabled:e.getAttribute("disabled")===null)&&(!e.parentNode.disabled||!f.nodeName(e.parentNode,"optgroup"))){b=f(e).val();if(j)return b;h.push(b)}}if(j&&!h.length&&i.length)return f(i[g]).val();return h},set:function(a,b){var c=f.makeArray(b);f(a).find("option").each(function(){this.selected=f.inArray(f(this).val(),c)>=0}),c.length||(a.selectedIndex=-1);return c}}},attrFn:{val:!0,css:!0,html:!0,text:!0,data:!0,width:!0,height:!0,offset:!0},attr:function(a,c,d,e){var g,h,i,j=a.nodeType;if(!!a&&j!==3&&j!==8&&j!==2){if(e&&c in f.attrFn)return f(a)[c](d);if(typeof a.getAttribute=="undefined")return f.prop(a,c,d);i=j!==1||!f.isXMLDoc(a),i&&(c=c.toLowerCase(),h=f.attrHooks[c]||(u.test(c)?x:w));if(d!==b){if(d===null){f.removeAttr(a,c);return}if(h&&"set"in h&&i&&(g=h.set(a,d,c))!==b)return g;a.setAttribute(c,""+d);return d}if(h&&"get"in h&&i&&(g=h.get(a,c))!==null)return g;g=a.getAttribute(c);return g===null?b:g}},removeAttr:function(a,b){var c,d,e,g,h=0;if(b&&a.nodeType===1){d=b.toLowerCase().split(p),g=d.length;for(;h<g;h++)e=d[h],e&&(c=f.propFix[e]||e,f.attr(a,e,""),a.removeAttribute(v?e:c),u.test(e)&&c in a&&(a[c]=!1))}},attrHooks:{type:{set:function(a,b){if(r.test(a.nodeName)&&a.parentNode)f.error("type property can't be changed");else if(!f.support.radioValue&&b==="radio"&&f.nodeName(a,"input")){var c=a.value;a.setAttribute("type",b),c&&(a.value=c);return b}}},value:{get:function(a,b){if(w&&f.nodeName(a,"button"))return w.get(a,b);return b in a?a.value:null},set:function(a,b,c){if(w&&f.nodeName(a,"button"))return w.set(a,b,c);a.value=b}}},propFix:{tabindex:"tabIndex",readonly:"readOnly","for":"htmlFor","class":"className",maxlength:"maxLength",cellspacing:"cellSpacing",cellpadding:"cellPadding",rowspan:"rowSpan",colspan:"colSpan",usemap:"useMap",frameborder:"frameBorder",contenteditable:"contentEditable"},prop:function(a,c,d){var e,g,h,i=a.nodeType;if(!!a&&i!==3&&i!==8&&i!==2){h=i!==1||!f.isXMLDoc(a),h&&(c=f.propFix[c]||c,g=f.propHooks[c]);return d!==b?g&&"set"in g&&(e=g.set(a,d,c))!==b?e:a[c]=d:g&&"get"in g&&(e=g.get(a,c))!==null?e:a[c]}},propHooks:{tabIndex:{get:function(a){var c=a.getAttributeNode("tabindex");return c&&c.specified?parseInt(c.value,10):s.test(a.nodeName)||t.test(a.nodeName)&&a.href?0:b}}}}),f.attrHooks.tabindex=f.propHooks.tabIndex,x={get:function(a,c){var d,e=f.prop(a,c);return e===!0||typeof e!="boolean"&&(d=a.getAttributeNode(c))&&d.nodeValue!==!1?c.toLowerCase():b},set:function(a,b,c){var d;b===!1?f.removeAttr(a,c):(d=f.propFix[c]||c,d in a&&(a[d]=!0),a.setAttribute(c,c.toLowerCase()));return c}},v||(y={name:!0,id:!0},w=f.valHooks.button={get:function(a,c){var d;d=a.getAttributeNode(c);return d&&(y[c]?d.nodeValue!=="":d.specified)?d.nodeValue:b},set:function(a,b,d){var e=a.getAttributeNode(d);e||(e=c.createAttribute(d),a.setAttributeNode(e));return e.nodeValue=b+""}},f.attrHooks.tabindex.set=w.set,f.each(["width","height"],function(a,b){f.attrHooks[b]=f.extend(f.attrHooks[b],{set:function(a,c){if(c===""){a.setAttribute(b,"auto");return c}}})}),f.attrHooks.contenteditable={get:w.get,set:function(a,b,c){b===""&&(b="false"),w.set(a,b,c)}}),f.support.hrefNormalized||f.each(["href","src","width","height"],function(a,c){f.attrHooks[c]=f.extend(f.attrHooks[c],{get:function(a){var d=a.getAttribute(c,2);return d===null?b:d}})}),f.support.style||(f.attrHooks.style={get:function(a){return a.style.cssText.toLowerCase()||b},set:function(a,b){return a.style.cssText=""+b}}),f.support.optSelected||(f.propHooks.selected=f.extend(f.propHooks.selected,{get:function(a){var b=a.parentNode;b&&(b.selectedIndex,b.parentNode&&b.parentNode.selectedIndex);return null}})),f.support.enctype||(f.propFix.enctype="encoding"),f.support.checkOn||f.each(["radio","checkbox"],function(){f.valHooks[this]={get:function(a){return a.getAttribute("value")===null?"on":a.value}}}),f.each(["radio","checkbox"],function(){f.valHooks[this]=f.extend(f.valHooks[this],{set:function(a,b){if(f.isArray(b))return a.checked=f.inArray(f(a).val(),b)>=0}})});var z=/^(?:textarea|input|select)$/i,A=/^([^\.]*)?(?:\.(.+))?$/,B=/\bhover(\.\S+)?\b/,C=/^key/,D=/^(?:mouse|contextmenu)|click/,E=/^(?:focusinfocus|focusoutblur)$/,F=/^(\w*)(?:#([\w\-]+))?(?:\.([\w\-]+))?$/,G=function(a){var b=F.exec(a);b&&(b[1]=(b[1]||"").toLowerCase(),b[3]=b[3]&&new RegExp("(?:^|\\s)"+b[3]+"(?:\\s|$)"));return b},H=function(a,b){var c=a.attributes||{};return(!b[1]||a.nodeName.toLowerCase()===b[1])&&(!b[2]||(c.id||{}).value===b[2])&&(!b[3]||b[3].test((c["class"]||{}).value))},I=function(a){return f.event.special.hover?a:a.replace(B,"mouseenter$1 mouseleave$1")};
f.event={add:function(a,c,d,e,g){var h,i,j,k,l,m,n,o,p,q,r,s;if(!(a.nodeType===3||a.nodeType===8||!c||!d||!(h=f._data(a)))){d.handler&&(p=d,d=p.handler),d.guid||(d.guid=f.guid++),j=h.events,j||(h.events=j={}),i=h.handle,i||(h.handle=i=function(a){return typeof f!="undefined"&&(!a||f.event.triggered!==a.type)?f.event.dispatch.apply(i.elem,arguments):b},i.elem=a),c=f.trim(I(c)).split(" ");for(k=0;k<c.length;k++){l=A.exec(c[k])||[],m=l[1],n=(l[2]||"").split(".").sort(),s=f.event.special[m]||{},m=(g?s.delegateType:s.bindType)||m,s=f.event.special[m]||{},o=f.extend({type:m,origType:l[1],data:e,handler:d,guid:d.guid,selector:g,quick:G(g),namespace:n.join(".")},p),r=j[m];if(!r){r=j[m]=[],r.delegateCount=0;if(!s.setup||s.setup.call(a,e,n,i)===!1)a.addEventListener?a.addEventListener(m,i,!1):a.attachEvent&&a.attachEvent("on"+m,i)}s.add&&(s.add.call(a,o),o.handler.guid||(o.handler.guid=d.guid)),g?r.splice(r.delegateCount++,0,o):r.push(o),f.event.global[m]=!0}a=null}},global:{},remove:function(a,b,c,d,e){var g=f.hasData(a)&&f._data(a),h,i,j,k,l,m,n,o,p,q,r,s;if(!!g&&!!(o=g.events)){b=f.trim(I(b||"")).split(" ");for(h=0;h<b.length;h++){i=A.exec(b[h])||[],j=k=i[1],l=i[2];if(!j){for(j in o)f.event.remove(a,j+b[h],c,d,!0);continue}p=f.event.special[j]||{},j=(d?p.delegateType:p.bindType)||j,r=o[j]||[],m=r.length,l=l?new RegExp("(^|\\.)"+l.split(".").sort().join("\\.(?:.*\\.)?")+"(\\.|$)"):null;for(n=0;n<r.length;n++)s=r[n],(e||k===s.origType)&&(!c||c.guid===s.guid)&&(!l||l.test(s.namespace))&&(!d||d===s.selector||d==="**"&&s.selector)&&(r.splice(n--,1),s.selector&&r.delegateCount--,p.remove&&p.remove.call(a,s));r.length===0&&m!==r.length&&((!p.teardown||p.teardown.call(a,l)===!1)&&f.removeEvent(a,j,g.handle),delete o[j])}f.isEmptyObject(o)&&(q=g.handle,q&&(q.elem=null),f.removeData(a,["events","handle"],!0))}},customEvent:{getData:!0,setData:!0,changeData:!0},trigger:function(c,d,e,g){if(!e||e.nodeType!==3&&e.nodeType!==8){var h=c.type||c,i=[],j,k,l,m,n,o,p,q,r,s;if(E.test(h+f.event.triggered))return;h.indexOf("!")>=0&&(h=h.slice(0,-1),k=!0),h.indexOf(".")>=0&&(i=h.split("."),h=i.shift(),i.sort());if((!e||f.event.customEvent[h])&&!f.event.global[h])return;c=typeof c=="object"?c[f.expando]?c:new f.Event(h,c):new f.Event(h),c.type=h,c.isTrigger=!0,c.exclusive=k,c.namespace=i.join("."),c.namespace_re=c.namespace?new RegExp("(^|\\.)"+i.join("\\.(?:.*\\.)?")+"(\\.|$)"):null,o=h.indexOf(":")<0?"on"+h:"";if(!e){j=f.cache;for(l in j)j[l].events&&j[l].events[h]&&f.event.trigger(c,d,j[l].handle.elem,!0);return}c.result=b,c.target||(c.target=e),d=d!=null?f.makeArray(d):[],d.unshift(c),p=f.event.special[h]||{};if(p.trigger&&p.trigger.apply(e,d)===!1)return;r=[[e,p.bindType||h]];if(!g&&!p.noBubble&&!f.isWindow(e)){s=p.delegateType||h,m=E.test(s+h)?e:e.parentNode,n=null;for(;m;m=m.parentNode)r.push([m,s]),n=m;n&&n===e.ownerDocument&&r.push([n.defaultView||n.parentWindow||a,s])}for(l=0;l<r.length&&!c.isPropagationStopped();l++)m=r[l][0],c.type=r[l][1],q=(f._data(m,"events")||{})[c.type]&&f._data(m,"handle"),q&&q.apply(m,d),q=o&&m[o],q&&f.acceptData(m)&&q.apply(m,d)===!1&&c.preventDefault();c.type=h,!g&&!c.isDefaultPrevented()&&(!p._default||p._default.apply(e.ownerDocument,d)===!1)&&(h!=="click"||!f.nodeName(e,"a"))&&f.acceptData(e)&&o&&e[h]&&(h!=="focus"&&h!=="blur"||c.target.offsetWidth!==0)&&!f.isWindow(e)&&(n=e[o],n&&(e[o]=null),f.event.triggered=h,e[h](),f.event.triggered=b,n&&(e[o]=n));return c.result}},dispatch:function(c){c=f.event.fix(c||a.event);var d=(f._data(this,"events")||{})[c.type]||[],e=d.delegateCount,g=[].slice.call(arguments,0),h=!c.exclusive&&!c.namespace,i=[],j,k,l,m,n,o,p,q,r,s,t;g[0]=c,c.delegateTarget=this;if(e&&!c.target.disabled&&(!c.button||c.type!=="click")){m=f(this),m.context=this.ownerDocument||this;for(l=c.target;l!=this;l=l.parentNode||this){o={},q=[],m[0]=l;for(j=0;j<e;j++)r=d[j],s=r.selector,o[s]===b&&(o[s]=r.quick?H(l,r.quick):m.is(s)),o[s]&&q.push(r);q.length&&i.push({elem:l,matches:q})}}d.length>e&&i.push({elem:this,matches:d.slice(e)});for(j=0;j<i.length&&!c.isPropagationStopped();j++){p=i[j],c.currentTarget=p.elem;for(k=0;k<p.matches.length&&!c.isImmediatePropagationStopped();k++){r=p.matches[k];if(h||!c.namespace&&!r.namespace||c.namespace_re&&c.namespace_re.test(r.namespace))c.data=r.data,c.handleObj=r,n=((f.event.special[r.origType]||{}).handle||r.handler).apply(p.elem,g),n!==b&&(c.result=n,n===!1&&(c.preventDefault(),c.stopPropagation()))}}return c.result},props:"attrChange attrName relatedNode srcElement altKey bubbles cancelable ctrlKey currentTarget eventPhase metaKey relatedTarget shiftKey target timeStamp view which".split(" "),fixHooks:{},keyHooks:{props:"char charCode key keyCode".split(" "),filter:function(a,b){a.which==null&&(a.which=b.charCode!=null?b.charCode:b.keyCode);return a}},mouseHooks:{props:"button buttons clientX clientY fromElement offsetX offsetY pageX pageY screenX screenY toElement".split(" "),filter:function(a,d){var e,f,g,h=d.button,i=d.fromElement;a.pageX==null&&d.clientX!=null&&(e=a.target.ownerDocument||c,f=e.documentElement,g=e.body,a.pageX=d.clientX+(f&&f.scrollLeft||g&&g.scrollLeft||0)-(f&&f.clientLeft||g&&g.clientLeft||0),a.pageY=d.clientY+(f&&f.scrollTop||g&&g.scrollTop||0)-(f&&f.clientTop||g&&g.clientTop||0)),!a.relatedTarget&&i&&(a.relatedTarget=i===a.target?d.toElement:i),!a.which&&h!==b&&(a.which=h&1?1:h&2?3:h&4?2:0);return a}},fix:function(a){if(a[f.expando])return a;var d,e,g=a,h=f.event.fixHooks[a.type]||{},i=h.props?this.props.concat(h.props):this.props;a=f.Event(g);for(d=i.length;d;)e=i[--d],a[e]=g[e];a.target||(a.target=g.srcElement||c),a.target.nodeType===3&&(a.target=a.target.parentNode),a.metaKey===b&&(a.metaKey=a.ctrlKey);return h.filter?h.filter(a,g):a},special:{ready:{setup:f.bindReady},load:{noBubble:!0},focus:{delegateType:"focusin"},blur:{delegateType:"focusout"},beforeunload:{setup:function(a,b,c){f.isWindow(this)&&(this.onbeforeunload=c)},teardown:function(a,b){this.onbeforeunload===b&&(this.onbeforeunload=null)}}},simulate:function(a,b,c,d){var e=f.extend(new f.Event,c,{type:a,isSimulated:!0,originalEvent:{}});d?f.event.trigger(e,null,b):f.event.dispatch.call(b,e),e.isDefaultPrevented()&&c.preventDefault()}},f.event.handle=f.event.dispatch,f.removeEvent=c.removeEventListener?function(a,b,c){a.removeEventListener&&a.removeEventListener(b,c,!1)}:function(a,b,c){a.detachEvent&&a.detachEvent("on"+b,c)},f.Event=function(a,b){if(!(this instanceof f.Event))return new f.Event(a,b);a&&a.type?(this.originalEvent=a,this.type=a.type,this.isDefaultPrevented=a.defaultPrevented||a.returnValue===!1||a.getPreventDefault&&a.getPreventDefault()?K:J):this.type=a,b&&f.extend(this,b),this.timeStamp=a&&a.timeStamp||f.now(),this[f.expando]=!0},f.Event.prototype={preventDefault:function(){this.isDefaultPrevented=K;var a=this.originalEvent;!a||(a.preventDefault?a.preventDefault():a.returnValue=!1)},stopPropagation:function(){this.isPropagationStopped=K;var a=this.originalEvent;!a||(a.stopPropagation&&a.stopPropagation(),a.cancelBubble=!0)},stopImmediatePropagation:function(){this.isImmediatePropagationStopped=K,this.stopPropagation()},isDefaultPrevented:J,isPropagationStopped:J,isImmediatePropagationStopped:J},f.each({mouseenter:"mouseover",mouseleave:"mouseout"},function(a,b){f.event.special[a]={delegateType:b,bindType:b,handle:function(a){var c=this,d=a.relatedTarget,e=a.handleObj,g=e.selector,h;if(!d||d!==c&&!f.contains(c,d))a.type=e.origType,h=e.handler.apply(this,arguments),a.type=b;return h}}}),f.support.submitBubbles||(f.event.special.submit={setup:function(){if(f.nodeName(this,"form"))return!1;f.event.add(this,"click._submit keypress._submit",function(a){var c=a.target,d=f.nodeName(c,"input")||f.nodeName(c,"button")?c.form:b;d&&!d._submit_attached&&(f.event.add(d,"submit._submit",function(a){this.parentNode&&!a.isTrigger&&f.event.simulate("submit",this.parentNode,a,!0)}),d._submit_attached=!0)})},teardown:function(){if(f.nodeName(this,"form"))return!1;f.event.remove(this,"._submit")}}),f.support.changeBubbles||(f.event.special.change={setup:function(){if(z.test(this.nodeName)){if(this.type==="checkbox"||this.type==="radio")f.event.add(this,"propertychange._change",function(a){a.originalEvent.propertyName==="checked"&&(this._just_changed=!0)}),f.event.add(this,"click._change",function(a){this._just_changed&&!a.isTrigger&&(this._just_changed=!1,f.event.simulate("change",this,a,!0))});return!1}f.event.add(this,"beforeactivate._change",function(a){var b=a.target;z.test(b.nodeName)&&!b._change_attached&&(f.event.add(b,"change._change",function(a){this.parentNode&&!a.isSimulated&&!a.isTrigger&&f.event.simulate("change",this.parentNode,a,!0)}),b._change_attached=!0)})},handle:function(a){var b=a.target;if(this!==b||a.isSimulated||a.isTrigger||b.type!=="radio"&&b.type!=="checkbox")return a.handleObj.handler.apply(this,arguments)},teardown:function(){f.event.remove(this,"._change");return z.test(this.nodeName)}}),f.support.focusinBubbles||f.each({focus:"focusin",blur:"focusout"},function(a,b){var d=0,e=function(a){f.event.simulate(b,a.target,f.event.fix(a),!0)};f.event.special[b]={setup:function(){d++===0&&c.addEventListener(a,e,!0)},teardown:function(){--d===0&&c.removeEventListener(a,e,!0)}}}),f.fn.extend({on:function(a,c,d,e,g){var h,i;if(typeof a=="object"){typeof c!="string"&&(d=c,c=b);for(i in a)this.on(i,c,d,a[i],g);return this}d==null&&e==null?(e=c,d=c=b):e==null&&(typeof c=="string"?(e=d,d=b):(e=d,d=c,c=b));if(e===!1)e=J;else if(!e)return this;g===1&&(h=e,e=function(a){f().off(a);return h.apply(this,arguments)},e.guid=h.guid||(h.guid=f.guid++));return this.each(function(){f.event.add(this,a,e,d,c)})},one:function(a,b,c,d){return this.on.call(this,a,b,c,d,1)},off:function(a,c,d){if(a&&a.preventDefault&&a.handleObj){var e=a.handleObj;f(a.delegateTarget).off(e.namespace?e.type+"."+e.namespace:e.type,e.selector,e.handler);return this}if(typeof a=="object"){for(var g in a)this.off(g,c,a[g]);return this}if(c===!1||typeof c=="function")d=c,c=b;d===!1&&(d=J);return this.each(function(){f.event.remove(this,a,d,c)})},bind:function(a,b,c){return this.on(a,null,b,c)},unbind:function(a,b){return this.off(a,null,b)},live:function(a,b,c){f(this.context).on(a,this.selector,b,c);return this},die:function(a,b){f(this.context).off(a,this.selector||"**",b);return this},delegate:function(a,b,c,d){return this.on(b,a,c,d)},undelegate:function(a,b,c){return arguments.length==1?this.off(a,"**"):this.off(b,a,c)},trigger:function(a,b){return this.each(function(){f.event.trigger(a,b,this)})},triggerHandler:function(a,b){if(this[0])return f.event.trigger(a,b,this[0],!0)},toggle:function(a){var b=arguments,c=a.guid||f.guid++,d=0,e=function(c){var e=(f._data(this,"lastToggle"+a.guid)||0)%d;f._data(this,"lastToggle"+a.guid,e+1),c.preventDefault();return b[e].apply(this,arguments)||!1};e.guid=c;while(d<b.length)b[d++].guid=c;return this.click(e)},hover:function(a,b){return this.mouseenter(a).mouseleave(b||a)}}),f.each("blur focus focusin focusout load resize scroll unload click dblclick mousedown mouseup mousemove mouseover mouseout mouseenter mouseleave change select submit keydown keypress keyup error contextmenu".split(" "),function(a,b){f.fn[b]=function(a,c){c==null&&(c=a,a=null);return arguments.length>0?this.on(b,null,a,c):this.trigger(b)},f.attrFn&&(f.attrFn[b]=!0),C.test(b)&&(f.event.fixHooks[b]=f.event.keyHooks),D.test(b)&&(f.event.fixHooks[b]=f.event.mouseHooks)}),function(){function x(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}if(j.nodeType===1){g||(j[d]=c,j.sizset=h);if(typeof b!="string"){if(j===b){k=!0;break}}else if(m.filter(b,[j]).length>0){k=j;break}}j=j[a]}e[h]=k}}}function w(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}j.nodeType===1&&!g&&(j[d]=c,j.sizset=h);if(j.nodeName.toLowerCase()===b){k=j;break}j=j[a]}e[h]=k}}}var a=/((?:\((?:\([^()]+\)|[^()]+)+\)|\[(?:\[[^\[\]]*\]|['"][^'"]*['"]|[^\[\]'"]+)+\]|\\.|[^ >+~,(\[\\]+)+|[>+~])(\s*,\s*)?((?:.|\r|\n)*)/g,d="sizcache"+(Math.random()+"").replace(".",""),e=0,g=Object.prototype.toString,h=!1,i=!0,j=/\\/g,k=/\r\n/g,l=/\W/;[0,0].sort(function(){i=!1;return 0});var m=function(b,d,e,f){e=e||[],d=d||c;var h=d;if(d.nodeType!==1&&d.nodeType!==9)return[];if(!b||typeof b!="string")return e;var i,j,k,l,n,q,r,t,u=!0,v=m.isXML(d),w=[],x=b;do{a.exec(""),i=a.exec(x);if(i){x=i[3],w.push(i[1]);if(i[2]){l=i[3];break}}}while(i);if(w.length>1&&p.exec(b))if(w.length===2&&o.relative[w[0]])j=y(w[0]+w[1],d,f);else{j=o.relative[w[0]]?[d]:m(w.shift(),d);while(w.length)b=w.shift(),o.relative[b]&&(b+=w.shift()),j=y(b,j,f)}else{!f&&w.length>1&&d.nodeType===9&&!v&&o.match.ID.test(w[0])&&!o.match.ID.test(w[w.length-1])&&(n=m.find(w.shift(),d,v),d=n.expr?m.filter(n.expr,n.set)[0]:n.set[0]);if(d){n=f?{expr:w.pop(),set:s(f)}:m.find(w.pop(),w.length===1&&(w[0]==="~"||w[0]==="+")&&d.parentNode?d.parentNode:d,v),j=n.expr?m.filter(n.expr,n.set):n.set,w.length>0?k=s(j):u=!1;while(w.length)q=w.pop(),r=q,o.relative[q]?r=w.pop():q="",r==null&&(r=d),o.relative[q](k,r,v)}else k=w=[]}k||(k=j),k||m.error(q||b);if(g.call(k)==="[object Array]")if(!u)e.push.apply(e,k);else if(d&&d.nodeType===1)for(t=0;k[t]!=null;t++)k[t]&&(k[t]===!0||k[t].nodeType===1&&m.contains(d,k[t]))&&e.push(j[t]);else for(t=0;k[t]!=null;t++)k[t]&&k[t].nodeType===1&&e.push(j[t]);else s(k,e);l&&(m(l,h,e,f),m.uniqueSort(e));return e};m.uniqueSort=function(a){if(u){h=i,a.sort(u);if(h)for(var b=1;b<a.length;b++)a[b]===a[b-1]&&a.splice(b--,1)}return a},m.matches=function(a,b){return m(a,null,null,b)},m.matchesSelector=function(a,b){return m(b,null,null,[a]).length>0},m.find=function(a,b,c){var d,e,f,g,h,i;if(!a)return[];for(e=0,f=o.order.length;e<f;e++){h=o.order[e];if(g=o.leftMatch[h].exec(a)){i=g[1],g.splice(1,1);if(i.substr(i.length-1)!=="\\"){g[1]=(g[1]||"").replace(j,""),d=o.find[h](g,b,c);if(d!=null){a=a.replace(o.match[h],"");break}}}}d||(d=typeof b.getElementsByTagName!="undefined"?b.getElementsByTagName("*"):[]);return{set:d,expr:a}},m.filter=function(a,c,d,e){var f,g,h,i,j,k,l,n,p,q=a,r=[],s=c,t=c&&c[0]&&m.isXML(c[0]);while(a&&c.length){for(h in o.filter)if((f=o.leftMatch[h].exec(a))!=null&&f[2]){k=o.filter[h],l=f[1],g=!1,f.splice(1,1);if(l.substr(l.length-1)==="\\")continue;s===r&&(r=[]);if(o.preFilter[h]){f=o.preFilter[h](f,s,d,r,e,t);if(!f)g=i=!0;else if(f===!0)continue}if(f)for(n=0;(j=s[n])!=null;n++)j&&(i=k(j,f,n,s),p=e^i,d&&i!=null?p?g=!0:s[n]=!1:p&&(r.push(j),g=!0));if(i!==b){d||(s=r),a=a.replace(o.match[h],"");if(!g)return[];break}}if(a===q)if(g==null)m.error(a);else break;q=a}return s},m.error=function(a){throw new Error("Syntax error, unrecognized expression: "+a)};var n=m.getText=function(a){var b,c,d=a.nodeType,e="";if(d){if(d===1||d===9){if(typeof a.textContent=="string")return a.textContent;if(typeof a.innerText=="string")return a.innerText.replace(k,"");for(a=a.firstChild;a;a=a.nextSibling)e+=n(a)}else if(d===3||d===4)return a.nodeValue}else for(b=0;c=a[b];b++)c.nodeType!==8&&(e+=n(c));return e},o=m.selectors={order:["ID","NAME","TAG"],match:{ID:/#((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,CLASS:/\.((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,NAME:/\[name=['"]*((?:[\w\u00c0-\uFFFF\-]|\\.)+)['"]*\]/,ATTR:/\[\s*((?:[\w\u00c0-\uFFFF\-]|\\.)+)\s*(?:(\S?=)\s*(?:(['"])(.*?)\3|(#?(?:[\w\u00c0-\uFFFF\-]|\\.)*)|)|)\s*\]/,TAG:/^((?:[\w\u00c0-\uFFFF\*\-]|\\.)+)/,CHILD:/:(only|nth|last|first)-child(?:\(\s*(even|odd|(?:[+\-]?\d+|(?:[+\-]?\d*)?n\s*(?:[+\-]\s*\d+)?))\s*\))?/,POS:/:(nth|eq|gt|lt|first|last|even|odd)(?:\((\d*)\))?(?=[^\-]|$)/,PSEUDO:/:((?:[\w\u00c0-\uFFFF\-]|\\.)+)(?:\((['"]?)((?:\([^\)]+\)|[^\(\)]*)+)\2\))?/},leftMatch:{},attrMap:{"class":"className","for":"htmlFor"},attrHandle:{href:function(a){return a.getAttribute("href")},type:function(a){return a.getAttribute("type")}},relative:{"+":function(a,b){var c=typeof b=="string",d=c&&!l.test(b),e=c&&!d;d&&(b=b.toLowerCase());for(var f=0,g=a.length,h;f<g;f++)if(h=a[f]){while((h=h.previousSibling)&&h.nodeType!==1);a[f]=e||h&&h.nodeName.toLowerCase()===b?h||!1:h===b}e&&m.filter(b,a,!0)},">":function(a,b){var c,d=typeof b=="string",e=0,f=a.length;if(d&&!l.test(b)){b=b.toLowerCase();for(;e<f;e++){c=a[e];if(c){var g=c.parentNode;a[e]=g.nodeName.toLowerCase()===b?g:!1}}}else{for(;e<f;e++)c=a[e],c&&(a[e]=d?c.parentNode:c.parentNode===b);d&&m.filter(b,a,!0)}},"":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("parentNode",b,f,a,d,c)},"~":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("previousSibling",b,f,a,d,c)}},find:{ID:function(a,b,c){if(typeof b.getElementById!="undefined"&&!c){var d=b.getElementById(a[1]);return d&&d.parentNode?[d]:[]}},NAME:function(a,b){if(typeof b.getElementsByName!="undefined"){var c=[],d=b.getElementsByName(a[1]);for(var e=0,f=d.length;e<f;e++)d[e].getAttribute("name")===a[1]&&c.push(d[e]);return c.length===0?null:c}},TAG:function(a,b){if(typeof b.getElementsByTagName!="undefined")return b.getElementsByTagName(a[1])}},preFilter:{CLASS:function(a,b,c,d,e,f){a=" "+a[1].replace(j,"")+" ";if(f)return a;for(var g=0,h;(h=b[g])!=null;g++)h&&(e^(h.className&&(" "+h.className+" ").replace(/[\t\n\r]/g," ").indexOf(a)>=0)?c||d.push(h):c&&(b[g]=!1));return!1},ID:function(a){return a[1].replace(j,"")},TAG:function(a,b){return a[1].replace(j,"").toLowerCase()},CHILD:function(a){if(a[1]==="nth"){a[2]||m.error(a[0]),a[2]=a[2].replace(/^\+|\s*/g,"");var b=/(-?)(\d*)(?:n([+\-]?\d*))?/.exec(a[2]==="even"&&"2n"||a[2]==="odd"&&"2n+1"||!/\D/.test(a[2])&&"0n+"+a[2]||a[2]);a[2]=b[1]+(b[2]||1)-0,a[3]=b[3]-0}else a[2]&&m.error(a[0]);a[0]=e++;return a},ATTR:function(a,b,c,d,e,f){var g=a[1]=a[1].replace(j,"");!f&&o.attrMap[g]&&(a[1]=o.attrMap[g]),a[4]=(a[4]||a[5]||"").replace(j,""),a[2]==="~="&&(a[4]=" "+a[4]+" ");return a},PSEUDO:function(b,c,d,e,f){if(b[1]==="not")if((a.exec(b[3])||"").length>1||/^\w/.test(b[3]))b[3]=m(b[3],null,null,c);else{var g=m.filter(b[3],c,d,!0^f);d||e.push.apply(e,g);return!1}else if(o.match.POS.test(b[0])||o.match.CHILD.test(b[0]))return!0;return b},POS:function(a){a.unshift(!0);return a}},filters:{enabled:function(a){return a.disabled===!1&&a.type!=="hidden"},disabled:function(a){return a.disabled===!0},checked:function(a){return a.checked===!0},selected:function(a){a.parentNode&&a.parentNode.selectedIndex;return a.selected===!0},parent:function(a){return!!a.firstChild},empty:function(a){return!a.firstChild},has:function(a,b,c){return!!m(c[3],a).length},header:function(a){return/h\d/i.test(a.nodeName)},text:function(a){var b=a.getAttribute("type"),c=a.type;return a.nodeName.toLowerCase()==="input"&&"text"===c&&(b===c||b===null)},radio:function(a){return a.nodeName.toLowerCase()==="input"&&"radio"===a.type},checkbox:function(a){return a.nodeName.toLowerCase()==="input"&&"checkbox"===a.type},file:function(a){return a.nodeName.toLowerCase()==="input"&&"file"===a.type},password:function(a){return a.nodeName.toLowerCase()==="input"&&"password"===a.type},submit:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"submit"===a.type},image:function(a){return a.nodeName.toLowerCase()==="input"&&"image"===a.type},reset:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"reset"===a.type},button:function(a){var b=a.nodeName.toLowerCase();return b==="input"&&"button"===a.type||b==="button"},input:function(a){return/input|select|textarea|button/i.test(a.nodeName)},focus:function(a){return a===a.ownerDocument.activeElement}},setFilters:{first:function(a,b){return b===0},last:function(a,b,c,d){return b===d.length-1},even:function(a,b){return b%2===0},odd:function(a,b){return b%2===1},lt:function(a,b,c){return b<c[3]-0},gt:function(a,b,c){return b>c[3]-0},nth:function(a,b,c){return c[3]-0===b},eq:function(a,b,c){return c[3]-0===b}},filter:{PSEUDO:function(a,b,c,d){var e=b[1],f=o.filters[e];if(f)return f(a,c,b,d);if(e==="contains")return(a.textContent||a.innerText||n([a])||"").indexOf(b[3])>=0;if(e==="not"){var g=b[3];for(var h=0,i=g.length;h<i;h++)if(g[h]===a)return!1;return!0}m.error(e)},CHILD:function(a,b){var c,e,f,g,h,i,j,k=b[1],l=a;switch(k){case"only":case"first":while(l=l.previousSibling)if(l.nodeType===1)return!1;if(k==="first")return!0;l=a;case"last":while(l=l.nextSibling)if(l.nodeType===1)return!1;return!0;case"nth":c=b[2],e=b[3];if(c===1&&e===0)return!0;f=b[0],g=a.parentNode;if(g&&(g[d]!==f||!a.nodeIndex)){i=0;for(l=g.firstChild;l;l=l.nextSibling)l.nodeType===1&&(l.nodeIndex=++i);g[d]=f}j=a.nodeIndex-e;return c===0?j===0:j%c===0&&j/c>=0}},ID:function(a,b){return a.nodeType===1&&a.getAttribute("id")===b},TAG:function(a,b){return b==="*"&&a.nodeType===1||!!a.nodeName&&a.nodeName.toLowerCase()===b},CLASS:function(a,b){return(" "+(a.className||a.getAttribute("class"))+" ").indexOf(b)>-1},ATTR:function(a,b){var c=b[1],d=m.attr?m.attr(a,c):o.attrHandle[c]?o.attrHandle[c](a):a[c]!=null?a[c]:a.getAttribute(c),e=d+"",f=b[2],g=b[4];return d==null?f==="!=":!f&&m.attr?d!=null:f==="="?e===g:f==="*="?e.indexOf(g)>=0:f==="~="?(" "+e+" ").indexOf(g)>=0:g?f==="!="?e!==g:f==="^="?e.indexOf(g)===0:f==="$="?e.substr(e.length-g.length)===g:f==="|="?e===g||e.substr(0,g.length+1)===g+"-":!1:e&&d!==!1},POS:function(a,b,c,d){var e=b[2],f=o.setFilters[e];if(f)return f(a,c,b,d)}}},p=o.match.POS,q=function(a,b){return"\\"+(b-0+1)};for(var r in o.match)o.match[r]=new RegExp(o.match[r].source+/(?![^\[]*\])(?![^\(]*\))/.source),o.leftMatch[r]=new RegExp(/(^(?:.|\r|\n)*?)/.source+o.match[r].source.replace(/\\(\d+)/g,q));var s=function(a,b){a=Array.prototype.slice.call(a,0);if(b){b.push.apply(b,a);return b}return a};try{Array.prototype.slice.call(c.documentElement.childNodes,0)[0].nodeType}catch(t){s=function(a,b){var c=0,d=b||[];if(g.call(a)==="[object Array]")Array.prototype.push.apply(d,a);else if(typeof a.length=="number")for(var e=a.length;c<e;c++)d.push(a[c]);else for(;a[c];c++)d.push(a[c]);return d}}var u,v;c.documentElement.compareDocumentPosition?u=function(a,b){if(a===b){h=!0;return 0}if(!a.compareDocumentPosition||!b.compareDocumentPosition)return a.compareDocumentPosition?-1:1;return a.compareDocumentPosition(b)&4?-1:1}:(u=function(a,b){if(a===b){h=!0;return 0}if(a.sourceIndex&&b.sourceIndex)return a.sourceIndex-b.sourceIndex;var c,d,e=[],f=[],g=a.parentNode,i=b.parentNode,j=g;if(g===i)return v(a,b);if(!g)return-1;if(!i)return 1;while(j)e.unshift(j),j=j.parentNode;j=i;while(j)f.unshift(j),j=j.parentNode;c=e.length,d=f.length;for(var k=0;k<c&&k<d;k++)if(e[k]!==f[k])return v(e[k],f[k]);return k===c?v(a,f[k],-1):v(e[k],b,1)},v=function(a,b,c){if(a===b)return c;var d=a.nextSibling;while(d){if(d===b)return-1;d=d.nextSibling}return 1}),function(){var a=c.createElement("div"),d="script"+(new Date).getTime(),e=c.documentElement;a.innerHTML="<a name='"+d+"'/>",e.insertBefore(a,e.firstChild),c.getElementById(d)&&(o.find.ID=function(a,c,d){if(typeof c.getElementById!="undefined"&&!d){var e=c.getElementById(a[1]);return e?e.id===a[1]||typeof e.getAttributeNode!="undefined"&&e.getAttributeNode("id").nodeValue===a[1]?[e]:b:[]}},o.filter.ID=function(a,b){var c=typeof a.getAttributeNode!="undefined"&&a.getAttributeNode("id");return a.nodeType===1&&c&&c.nodeValue===b}),e.removeChild(a),e=a=null}(),function(){var a=c.createElement("div");a.appendChild(c.createComment("")),a.getElementsByTagName("*").length>0&&(o.find.TAG=function(a,b){var c=b.getElementsByTagName(a[1]);if(a[1]==="*"){var d=[];for(var e=0;c[e];e++)c[e].nodeType===1&&d.push(c[e]);c=d}return c}),a.innerHTML="<a href='#'></a>",a.firstChild&&typeof a.firstChild.getAttribute!="undefined"&&a.firstChild.getAttribute("href")!=="#"&&(o.attrHandle.href=function(a){return a.getAttribute("href",2)}),a=null}(),c.querySelectorAll&&function(){var a=m,b=c.createElement("div"),d="__sizzle__";b.innerHTML="<p class='TEST'></p>";if(!b.querySelectorAll||b.querySelectorAll(".TEST").length!==0){m=function(b,e,f,g){e=e||c;if(!g&&!m.isXML(e)){var h=/^(\w+$)|^\.([\w\-]+$)|^#([\w\-]+$)/.exec(b);if(h&&(e.nodeType===1||e.nodeType===9)){if(h[1])return s(e.getElementsByTagName(b),f);if(h[2]&&o.find.CLASS&&e.getElementsByClassName)return s(e.getElementsByClassName(h[2]),f)}if(e.nodeType===9){if(b==="body"&&e.body)return s([e.body],f);if(h&&h[3]){var i=e.getElementById(h[3]);if(!i||!i.parentNode)return s([],f);if(i.id===h[3])return s([i],f)}try{return s(e.querySelectorAll(b),f)}catch(j){}}else if(e.nodeType===1&&e.nodeName.toLowerCase()!=="object"){var k=e,l=e.getAttribute("id"),n=l||d,p=e.parentNode,q=/^\s*[+~]/.test(b);l?n=n.replace(/'/g,"\\$&"):e.setAttribute("id",n),q&&p&&(e=e.parentNode);try{if(!q||p)return s(e.querySelectorAll("[id='"+n+"'] "+b),f)}catch(r){}finally{l||k.removeAttribute("id")}}}return a(b,e,f,g)};for(var e in a)m[e]=a[e];b=null}}(),function(){var a=c.documentElement,b=a.matchesSelector||a.mozMatchesSelector||a.webkitMatchesSelector||a.msMatchesSelector;if(b){var d=!b.call(c.createElement("div"),"div"),e=!1;try{b.call(c.documentElement,"[test!='']:sizzle")}catch(f){e=!0}m.matchesSelector=function(a,c){c=c.replace(/\=\s*([^'"\]]*)\s*\]/g,"='$1']");if(!m.isXML(a))try{if(e||!o.match.PSEUDO.test(c)&&!/!=/.test(c)){var f=b.call(a,c);if(f||!d||a.document&&a.document.nodeType!==11)return f}}catch(g){}return m(c,null,null,[a]).length>0}}}(),function(){var a=c.createElement("div");a.innerHTML="<div class='test e'></div><div class='test'></div>";if(!!a.getElementsByClassName&&a.getElementsByClassName("e").length!==0){a.lastChild.className="e";if(a.getElementsByClassName("e").length===1)return;o.order.splice(1,0,"CLASS"),o.find.CLASS=function(a,b,c){if(typeof b.getElementsByClassName!="undefined"&&!c)return b.getElementsByClassName(a[1])},a=null}}(),c.documentElement.contains?m.contains=function(a,b){return a!==b&&(a.contains?a.contains(b):!0)}:c.documentElement.compareDocumentPosition?m.contains=function(a,b){return!!(a.compareDocumentPosition(b)&16)}:m.contains=function(){return!1},m.isXML=function(a){var b=(a?a.ownerDocument||a:0).documentElement;return b?b.nodeName!=="HTML":!1};var y=function(a,b,c){var d,e=[],f="",g=b.nodeType?[b]:b;while(d=o.match.PSEUDO.exec(a))f+=d[0],a=a.replace(o.match.PSEUDO,"");a=o.relative[a]?a+"*":a;for(var h=0,i=g.length;h<i;h++)m(a,g[h],e,c);return m.filter(f,e)};m.attr=f.attr,m.selectors.attrMap={},f.find=m,f.expr=m.selectors,f.expr[":"]=f.expr.filters,f.unique=m.uniqueSort,f.text=m.getText,f.isXMLDoc=m.isXML,f.contains=m.contains}();var L=/Until$/,M=/^(?:parents|prevUntil|prevAll)/,N=/,/,O=/^.[^:#\[\.,]*$/,P=Array.prototype.slice,Q=f.expr.match.POS,R={children:!0,contents:!0,next:!0,prev:!0};f.fn.extend({find:function(a){var b=this,c,d;if(typeof a!="string")return f(a).filter(function(){for(c=0,d=b.length;c<d;c++)if(f.contains(b[c],this))return!0});var e=this.pushStack("","find",a),g,h,i;for(c=0,d=this.length;c<d;c++){g=e.length,f.find(a,this[c],e);if(c>0)for(h=g;h<e.length;h++)for(i=0;i<g;i++)if(e[i]===e[h]){e.splice(h--,1);break}}return e},has:function(a){var b=f(a);return this.filter(function(){for(var a=0,c=b.length;a<c;a++)if(f.contains(this,b[a]))return!0})},not:function(a){return this.pushStack(T(this,a,!1),"not",a)},filter:function(a){return this.pushStack(T(this,a,!0),"filter",a)},is:function(a){return!!a&&(typeof a=="string"?Q.test(a)?f(a,this.context).index(this[0])>=0:f.filter(a,this).length>0:this.filter(a).length>0)},closest:function(a,b){var c=[],d,e,g=this[0];if(f.isArray(a)){var h=1;while(g&&g.ownerDocument&&g!==b){for(d=0;d<a.length;d++)f(g).is(a[d])&&c.push({selector:a[d],elem:g,level:h});g=g.parentNode,h++}return c}var i=Q.test(a)||typeof a!="string"?f(a,b||this.context):0;for(d=0,e=this.length;d<e;d++){g=this[d];while(g){if(i?i.index(g)>-1:f.find.matchesSelector(g,a)){c.push(g);break}g=g.parentNode;if(!g||!g.ownerDocument||g===b||g.nodeType===11)break}}c=c.length>1?f.unique(c):c;return this.pushStack(c,"closest",a)},index:function(a){if(!a)return this[0]&&this[0].parentNode?this.prevAll().length:-1;if(typeof a=="string")return f.inArray(this[0],f(a));return f.inArray(a.jquery?a[0]:a,this)},add:function(a,b){var c=typeof a=="string"?f(a,b):f.makeArray(a&&a.nodeType?[a]:a),d=f.merge(this.get(),c);return this.pushStack(S(c[0])||S(d[0])?d:f.unique(d))},andSelf:function(){return this.add(this.prevObject)}}),f.each({parent:function(a){var b=a.parentNode;return b&&b.nodeType!==11?b:null},parents:function(a){return f.dir(a,"parentNode")},parentsUntil:function(a,b,c){return f.dir(a,"parentNode",c)},next:function(a){return f.nth(a,2,"nextSibling")},prev:function(a){return f.nth(a,2,"previousSibling")},nextAll:function(a){return f.dir(a,"nextSibling")},prevAll:function(a){return f.dir(a,"previousSibling")},nextUntil:function(a,b,c){return f.dir(a,"nextSibling",c)},prevUntil:function(a,b,c){return f.dir(a,"previousSibling",c)},siblings:function(a){return f.sibling(a.parentNode.firstChild,a)},children:function(a){return f.sibling(a.firstChild)},contents:function(a){return f.nodeName(a,"iframe")?a.contentDocument||a.contentWindow.document:f.makeArray(a.childNodes)}},function(a,b){f.fn[a]=function(c,d){var e=f.map(this,b,c);L.test(a)||(d=c),d&&typeof d=="string"&&(e=f.filter(d,e)),e=this.length>1&&!R[a]?f.unique(e):e,(this.length>1||N.test(d))&&M.test(a)&&(e=e.reverse());return this.pushStack(e,a,P.call(arguments).join(","))}}),f.extend({filter:function(a,b,c){c&&(a=":not("+a+")");return b.length===1?f.find.matchesSelector(b[0],a)?[b[0]]:[]:f.find.matches(a,b)},dir:function(a,c,d){var e=[],g=a[c];while(g&&g.nodeType!==9&&(d===b||g.nodeType!==1||!f(g).is(d)))g.nodeType===1&&e.push(g),g=g[c];return e},nth:function(a,b,c,d){b=b||1;var e=0;for(;a;a=a[c])if(a.nodeType===1&&++e===b)break;return a},sibling:function(a,b){var c=[];for(;a;a=a.nextSibling)a.nodeType===1&&a!==b&&c.push(a);return c}});var V="abbr|article|aside|audio|canvas|datalist|details|figcaption|figure|footer|header|hgroup|mark|meter|nav|output|progress|section|summary|time|video",W=/ jQuery\d+="(?:\d+|null)"/g,X=/^\s+/,Y=/<(?!area|br|col|embed|hr|img|input|link|meta|param)(([\w:]+)[^>]*)\/>/ig,Z=/<([\w:]+)/,$=/<tbody/i,_=/<|&#?\w+;/,ba=/<(?:script|style)/i,bb=/<(?:script|object|embed|option|style)/i,bc=new RegExp("<(?:"+V+")","i"),bd=/checked\s*(?:[^=]|=\s*.checked.)/i,be=/\/(java|ecma)script/i,bf=/^\s*<!(?:\[CDATA\[|\-\-)/,bg={option:[1,"<select multiple='multiple'>","</select>"],legend:[1,"<fieldset>","</fieldset>"],thead:[1,"<table>","</table>"],tr:[2,"<table><tbody>","</tbody></table>"],td:[3,"<table><tbody><tr>","</tr></tbody></table>"],col:[2,"<table><tbody></tbody><colgroup>","</colgroup></table>"],area:[1,"<map>","</map>"],_default:[0,"",""]},bh=U(c);bg.optgroup=bg.option,bg.tbody=bg.tfoot=bg.colgroup=bg.caption=bg.thead,bg.th=bg.td,f.support.htmlSerialize||(bg._default=[1,"div<div>","</div>"]),f.fn.extend({text:function(a){if(f.isFunction(a))return this.each(function(b){var c=f(this);c.text(a.call(this,b,c.text()))});if(typeof a!="object"&&a!==b)return this.empty().append((this[0]&&this[0].ownerDocument||c).createTextNode(a));return f.text(this)},wrapAll:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapAll(a.call(this,b))});if(this[0]){var b=f(a,this[0].ownerDocument).eq(0).clone(!0);this[0].parentNode&&b.insertBefore(this[0]),b.map(function(){var a=this;while(a.firstChild&&a.firstChild.nodeType===1)a=a.firstChild;return a}).append(this)}return this},wrapInner:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapInner(a.call(this,b))});return this.each(function(){var b=f(this),c=b.contents();c.length?c.wrapAll(a):b.append(a)})},wrap:function(a){var b=f.isFunction(a);return this.each(function(c){f(this).wrapAll(b?a.call(this,c):a)})},unwrap:function(){return this.parent().each(function(){f.nodeName(this,"body")||f(this).replaceWith(this.childNodes)}).end()},append:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.appendChild(a)})},prepend:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.insertBefore(a,this.firstChild)})},before:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this)});if(arguments.length){var a=f.clean(arguments);a.push.apply(a,this.toArray());return this.pushStack(a,"before",arguments)}},after:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this.nextSibling)});if(arguments.length){var a=this.pushStack(this,"after",arguments);a.push.apply(a,f.clean(arguments));return a}},remove:function(a,b){for(var c=0,d;(d=this[c])!=null;c++)if(!a||f.filter(a,[d]).length)!b&&d.nodeType===1&&(f.cleanData(d.getElementsByTagName("*")),f.cleanData([d])),d.parentNode&&d.parentNode.removeChild(d);return this},empty:function()
{for(var a=0,b;(b=this[a])!=null;a++){b.nodeType===1&&f.cleanData(b.getElementsByTagName("*"));while(b.firstChild)b.removeChild(b.firstChild)}return this},clone:function(a,b){a=a==null?!1:a,b=b==null?a:b;return this.map(function(){return f.clone(this,a,b)})},html:function(a){if(a===b)return this[0]&&this[0].nodeType===1?this[0].innerHTML.replace(W,""):null;if(typeof a=="string"&&!ba.test(a)&&(f.support.leadingWhitespace||!X.test(a))&&!bg[(Z.exec(a)||["",""])[1].toLowerCase()]){a=a.replace(Y,"<$1></$2>");try{for(var c=0,d=this.length;c<d;c++)this[c].nodeType===1&&(f.cleanData(this[c].getElementsByTagName("*")),this[c].innerHTML=a)}catch(e){this.empty().append(a)}}else f.isFunction(a)?this.each(function(b){var c=f(this);c.html(a.call(this,b,c.html()))}):this.empty().append(a);return this},replaceWith:function(a){if(this[0]&&this[0].parentNode){if(f.isFunction(a))return this.each(function(b){var c=f(this),d=c.html();c.replaceWith(a.call(this,b,d))});typeof a!="string"&&(a=f(a).detach());return this.each(function(){var b=this.nextSibling,c=this.parentNode;f(this).remove(),b?f(b).before(a):f(c).append(a)})}return this.length?this.pushStack(f(f.isFunction(a)?a():a),"replaceWith",a):this},detach:function(a){return this.remove(a,!0)},domManip:function(a,c,d){var e,g,h,i,j=a[0],k=[];if(!f.support.checkClone&&arguments.length===3&&typeof j=="string"&&bd.test(j))return this.each(function(){f(this).domManip(a,c,d,!0)});if(f.isFunction(j))return this.each(function(e){var g=f(this);a[0]=j.call(this,e,c?g.html():b),g.domManip(a,c,d)});if(this[0]){i=j&&j.parentNode,f.support.parentNode&&i&&i.nodeType===11&&i.childNodes.length===this.length?e={fragment:i}:e=f.buildFragment(a,this,k),h=e.fragment,h.childNodes.length===1?g=h=h.firstChild:g=h.firstChild;if(g){c=c&&f.nodeName(g,"tr");for(var l=0,m=this.length,n=m-1;l<m;l++)d.call(c?bi(this[l],g):this[l],e.cacheable||m>1&&l<n?f.clone(h,!0,!0):h)}k.length&&f.each(k,bp)}return this}}),f.buildFragment=function(a,b,d){var e,g,h,i,j=a[0];b&&b[0]&&(i=b[0].ownerDocument||b[0]),i.createDocumentFragment||(i=c),a.length===1&&typeof j=="string"&&j.length<512&&i===c&&j.charAt(0)==="<"&&!bb.test(j)&&(f.support.checkClone||!bd.test(j))&&(f.support.html5Clone||!bc.test(j))&&(g=!0,h=f.fragments[j],h&&h!==1&&(e=h)),e||(e=i.createDocumentFragment(),f.clean(a,i,e,d)),g&&(f.fragments[j]=h?e:1);return{fragment:e,cacheable:g}},f.fragments={},f.each({appendTo:"append",prependTo:"prepend",insertBefore:"before",insertAfter:"after",replaceAll:"replaceWith"},function(a,b){f.fn[a]=function(c){var d=[],e=f(c),g=this.length===1&&this[0].parentNode;if(g&&g.nodeType===11&&g.childNodes.length===1&&e.length===1){e[b](this[0]);return this}for(var h=0,i=e.length;h<i;h++){var j=(h>0?this.clone(!0):this).get();f(e[h])[b](j),d=d.concat(j)}return this.pushStack(d,a,e.selector)}}),f.extend({clone:function(a,b,c){var d,e,g,h=f.support.html5Clone||!bc.test("<"+a.nodeName)?a.cloneNode(!0):bo(a);if((!f.support.noCloneEvent||!f.support.noCloneChecked)&&(a.nodeType===1||a.nodeType===11)&&!f.isXMLDoc(a)){bk(a,h),d=bl(a),e=bl(h);for(g=0;d[g];++g)e[g]&&bk(d[g],e[g])}if(b){bj(a,h);if(c){d=bl(a),e=bl(h);for(g=0;d[g];++g)bj(d[g],e[g])}}d=e=null;return h},clean:function(a,b,d,e){var g;b=b||c,typeof b.createElement=="undefined"&&(b=b.ownerDocument||b[0]&&b[0].ownerDocument||c);var h=[],i;for(var j=0,k;(k=a[j])!=null;j++){typeof k=="number"&&(k+="");if(!k)continue;if(typeof k=="string")if(!_.test(k))k=b.createTextNode(k);else{k=k.replace(Y,"<$1></$2>");var l=(Z.exec(k)||["",""])[1].toLowerCase(),m=bg[l]||bg._default,n=m[0],o=b.createElement("div");b===c?bh.appendChild(o):U(b).appendChild(o),o.innerHTML=m[1]+k+m[2];while(n--)o=o.lastChild;if(!f.support.tbody){var p=$.test(k),q=l==="table"&&!p?o.firstChild&&o.firstChild.childNodes:m[1]==="<table>"&&!p?o.childNodes:[];for(i=q.length-1;i>=0;--i)f.nodeName(q[i],"tbody")&&!q[i].childNodes.length&&q[i].parentNode.removeChild(q[i])}!f.support.leadingWhitespace&&X.test(k)&&o.insertBefore(b.createTextNode(X.exec(k)[0]),o.firstChild),k=o.childNodes}var r;if(!f.support.appendChecked)if(k[0]&&typeof (r=k.length)=="number")for(i=0;i<r;i++)bn(k[i]);else bn(k);k.nodeType?h.push(k):h=f.merge(h,k)}if(d){g=function(a){return!a.type||be.test(a.type)};for(j=0;h[j];j++)if(e&&f.nodeName(h[j],"script")&&(!h[j].type||h[j].type.toLowerCase()==="text/javascript"))e.push(h[j].parentNode?h[j].parentNode.removeChild(h[j]):h[j]);else{if(h[j].nodeType===1){var s=f.grep(h[j].getElementsByTagName("script"),g);h.splice.apply(h,[j+1,0].concat(s))}d.appendChild(h[j])}}return h},cleanData:function(a){var b,c,d=f.cache,e=f.event.special,g=f.support.deleteExpando;for(var h=0,i;(i=a[h])!=null;h++){if(i.nodeName&&f.noData[i.nodeName.toLowerCase()])continue;c=i[f.expando];if(c){b=d[c];if(b&&b.events){for(var j in b.events)e[j]?f.event.remove(i,j):f.removeEvent(i,j,b.handle);b.handle&&(b.handle.elem=null)}g?delete i[f.expando]:i.removeAttribute&&i.removeAttribute(f.expando),delete d[c]}}}});var bq=/alpha\([^)]*\)/i,br=/opacity=([^)]*)/,bs=/([A-Z]|^ms)/g,bt=/^-?\d+(?:px)?$/i,bu=/^-?\d/,bv=/^([\-+])=([\-+.\de]+)/,bw={position:"absolute",visibility:"hidden",display:"block"},bx=["Left","Right"],by=["Top","Bottom"],bz,bA,bB;f.fn.css=function(a,c){if(arguments.length===2&&c===b)return this;return f.access(this,a,c,!0,function(a,c,d){return d!==b?f.style(a,c,d):f.css(a,c)})},f.extend({cssHooks:{opacity:{get:function(a,b){if(b){var c=bz(a,"opacity","opacity");return c===""?"1":c}return a.style.opacity}}},cssNumber:{fillOpacity:!0,fontWeight:!0,lineHeight:!0,opacity:!0,orphans:!0,widows:!0,zIndex:!0,zoom:!0},cssProps:{"float":f.support.cssFloat?"cssFloat":"styleFloat"},style:function(a,c,d,e){if(!!a&&a.nodeType!==3&&a.nodeType!==8&&!!a.style){var g,h,i=f.camelCase(c),j=a.style,k=f.cssHooks[i];c=f.cssProps[i]||i;if(d===b){if(k&&"get"in k&&(g=k.get(a,!1,e))!==b)return g;return j[c]}h=typeof d,h==="string"&&(g=bv.exec(d))&&(d=+(g[1]+1)*+g[2]+parseFloat(f.css(a,c)),h="number");if(d==null||h==="number"&&isNaN(d))return;h==="number"&&!f.cssNumber[i]&&(d+="px");if(!k||!("set"in k)||(d=k.set(a,d))!==b)try{j[c]=d}catch(l){}}},css:function(a,c,d){var e,g;c=f.camelCase(c),g=f.cssHooks[c],c=f.cssProps[c]||c,c==="cssFloat"&&(c="float");if(g&&"get"in g&&(e=g.get(a,!0,d))!==b)return e;if(bz)return bz(a,c)},swap:function(a,b,c){var d={};for(var e in b)d[e]=a.style[e],a.style[e]=b[e];c.call(a);for(e in b)a.style[e]=d[e]}}),f.curCSS=f.css,f.each(["height","width"],function(a,b){f.cssHooks[b]={get:function(a,c,d){var e;if(c){if(a.offsetWidth!==0)return bC(a,b,d);f.swap(a,bw,function(){e=bC(a,b,d)});return e}},set:function(a,b){if(!bt.test(b))return b;b=parseFloat(b);if(b>=0)return b+"px"}}}),f.support.opacity||(f.cssHooks.opacity={get:function(a,b){return br.test((b&&a.currentStyle?a.currentStyle.filter:a.style.filter)||"")?parseFloat(RegExp.$1)/100+"":b?"1":""},set:function(a,b){var c=a.style,d=a.currentStyle,e=f.isNumeric(b)?"alpha(opacity="+b*100+")":"",g=d&&d.filter||c.filter||"";c.zoom=1;if(b>=1&&f.trim(g.replace(bq,""))===""){c.removeAttribute("filter");if(d&&!d.filter)return}c.filter=bq.test(g)?g.replace(bq,e):g+" "+e}}),f(function(){f.support.reliableMarginRight||(f.cssHooks.marginRight={get:function(a,b){var c;f.swap(a,{display:"inline-block"},function(){b?c=bz(a,"margin-right","marginRight"):c=a.style.marginRight});return c}})}),c.defaultView&&c.defaultView.getComputedStyle&&(bA=function(a,b){var c,d,e;b=b.replace(bs,"-$1").toLowerCase(),(d=a.ownerDocument.defaultView)&&(e=d.getComputedStyle(a,null))&&(c=e.getPropertyValue(b),c===""&&!f.contains(a.ownerDocument.documentElement,a)&&(c=f.style(a,b)));return c}),c.documentElement.currentStyle&&(bB=function(a,b){var c,d,e,f=a.currentStyle&&a.currentStyle[b],g=a.style;f===null&&g&&(e=g[b])&&(f=e),!bt.test(f)&&bu.test(f)&&(c=g.left,d=a.runtimeStyle&&a.runtimeStyle.left,d&&(a.runtimeStyle.left=a.currentStyle.left),g.left=b==="fontSize"?"1em":f||0,f=g.pixelLeft+"px",g.left=c,d&&(a.runtimeStyle.left=d));return f===""?"auto":f}),bz=bA||bB,f.expr&&f.expr.filters&&(f.expr.filters.hidden=function(a){var b=a.offsetWidth,c=a.offsetHeight;return b===0&&c===0||!f.support.reliableHiddenOffsets&&(a.style&&a.style.display||f.css(a,"display"))==="none"},f.expr.filters.visible=function(a){return!f.expr.filters.hidden(a)});var bD=/%20/g,bE=/\[\]$/,bF=/\r?\n/g,bG=/#.*$/,bH=/^(.*?):[ \t]*([^\r\n]*)\r?$/mg,bI=/^(?:color|date|datetime|datetime-local|email|hidden|month|number|password|range|search|tel|text|time|url|week)$/i,bJ=/^(?:about|app|app\-storage|.+\-extension|file|res|widget):$/,bK=/^(?:GET|HEAD)$/,bL=/^\/\//,bM=/\?/,bN=/<script\b[^<]*(?:(?!<\/script>)<[^<]*)*<\/script>/gi,bO=/^(?:select|textarea)/i,bP=/\s+/,bQ=/([?&])_=[^&]*/,bR=/^([\w\+\.\-]+:)(?:\/\/([^\/?#:]*)(?::(\d+))?)?/,bS=f.fn.load,bT={},bU={},bV,bW,bX=["*/"]+["*"];try{bV=e.href}catch(bY){bV=c.createElement("a"),bV.href="",bV=bV.href}bW=bR.exec(bV.toLowerCase())||[],f.fn.extend({load:function(a,c,d){if(typeof a!="string"&&bS)return bS.apply(this,arguments);if(!this.length)return this;var e=a.indexOf(" ");if(e>=0){var g=a.slice(e,a.length);a=a.slice(0,e)}var h="GET";c&&(f.isFunction(c)?(d=c,c=b):typeof c=="object"&&(c=f.param(c,f.ajaxSettings.traditional),h="POST"));var i=this;f.ajax({url:a,type:h,dataType:"html",data:c,complete:function(a,b,c){c=a.responseText,a.isResolved()&&(a.done(function(a){c=a}),i.html(g?f("<div>").append(c.replace(bN,"")).find(g):c)),d&&i.each(d,[c,b,a])}});return this},serialize:function(){return f.param(this.serializeArray())},serializeArray:function(){return this.map(function(){return this.elements?f.makeArray(this.elements):this}).filter(function(){return this.name&&!this.disabled&&(this.checked||bO.test(this.nodeName)||bI.test(this.type))}).map(function(a,b){var c=f(this).val();return c==null?null:f.isArray(c)?f.map(c,function(a,c){return{name:b.name,value:a.replace(bF,"\r\n")}}):{name:b.name,value:c.replace(bF,"\r\n")}}).get()}}),f.each("ajaxStart ajaxStop ajaxComplete ajaxError ajaxSuccess ajaxSend".split(" "),function(a,b){f.fn[b]=function(a){return this.on(b,a)}}),f.each(["get","post"],function(a,c){f[c]=function(a,d,e,g){f.isFunction(d)&&(g=g||e,e=d,d=b);return f.ajax({type:c,url:a,data:d,success:e,dataType:g})}}),f.extend({getScript:function(a,c){return f.get(a,b,c,"script")},getJSON:function(a,b,c){return f.get(a,b,c,"json")},ajaxSetup:function(a,b){b?b_(a,f.ajaxSettings):(b=a,a=f.ajaxSettings),b_(a,b);return a},ajaxSettings:{url:bV,isLocal:bJ.test(bW[1]),global:!0,type:"GET",contentType:"application/x-www-form-urlencoded",processData:!0,async:!0,accepts:{xml:"application/xml, text/xml",html:"text/html",text:"text/plain",json:"application/json, text/javascript","*":bX},contents:{xml:/xml/,html:/html/,json:/json/},responseFields:{xml:"responseXML",text:"responseText"},converters:{"* text":a.String,"text html":!0,"text json":f.parseJSON,"text xml":f.parseXML},flatOptions:{context:!0,url:!0}},ajaxPrefilter:bZ(bT),ajaxTransport:bZ(bU),ajax:function(a,c){function w(a,c,l,m){if(s!==2){s=2,q&&clearTimeout(q),p=b,n=m||"",v.readyState=a>0?4:0;var o,r,u,w=c,x=l?cb(d,v,l):b,y,z;if(a>=200&&a<300||a===304){if(d.ifModified){if(y=v.getResponseHeader("Last-Modified"))f.lastModified[k]=y;if(z=v.getResponseHeader("Etag"))f.etag[k]=z}if(a===304)w="notmodified",o=!0;else try{r=cc(d,x),w="success",o=!0}catch(A){w="parsererror",u=A}}else{u=w;if(!w||a)w="error",a<0&&(a=0)}v.status=a,v.statusText=""+(c||w),o?h.resolveWith(e,[r,w,v]):h.rejectWith(e,[v,w,u]),v.statusCode(j),j=b,t&&g.trigger("ajax"+(o?"Success":"Error"),[v,d,o?r:u]),i.fireWith(e,[v,w]),t&&(g.trigger("ajaxComplete",[v,d]),--f.active||f.event.trigger("ajaxStop"))}}typeof a=="object"&&(c=a,a=b),c=c||{};var d=f.ajaxSetup({},c),e=d.context||d,g=e!==d&&(e.nodeType||e instanceof f)?f(e):f.event,h=f.Deferred(),i=f.Callbacks("once memory"),j=d.statusCode||{},k,l={},m={},n,o,p,q,r,s=0,t,u,v={readyState:0,setRequestHeader:function(a,b){if(!s){var c=a.toLowerCase();a=m[c]=m[c]||a,l[a]=b}return this},getAllResponseHeaders:function(){return s===2?n:null},getResponseHeader:function(a){var c;if(s===2){if(!o){o={};while(c=bH.exec(n))o[c[1].toLowerCase()]=c[2]}c=o[a.toLowerCase()]}return c===b?null:c},overrideMimeType:function(a){s||(d.mimeType=a);return this},abort:function(a){a=a||"abort",p&&p.abort(a),w(0,a);return this}};h.promise(v),v.success=v.done,v.error=v.fail,v.complete=i.add,v.statusCode=function(a){if(a){var b;if(s<2)for(b in a)j[b]=[j[b],a[b]];else b=a[v.status],v.then(b,b)}return this},d.url=((a||d.url)+"").replace(bG,"").replace(bL,bW[1]+"//"),d.dataTypes=f.trim(d.dataType||"*").toLowerCase().split(bP),d.crossDomain==null&&(r=bR.exec(d.url.toLowerCase()),d.crossDomain=!(!r||r[1]==bW[1]&&r[2]==bW[2]&&(r[3]||(r[1]==="http:"?80:443))==(bW[3]||(bW[1]==="http:"?80:443)))),d.data&&d.processData&&typeof d.data!="string"&&(d.data=f.param(d.data,d.traditional)),b$(bT,d,c,v);if(s===2)return!1;t=d.global,d.type=d.type.toUpperCase(),d.hasContent=!bK.test(d.type),t&&f.active++===0&&f.event.trigger("ajaxStart");if(!d.hasContent){d.data&&(d.url+=(bM.test(d.url)?"&":"?")+d.data,delete d.data),k=d.url;if(d.cache===!1){var x=f.now(),y=d.url.replace(bQ,"$1_="+x);d.url=y+(y===d.url?(bM.test(d.url)?"&":"?")+"_="+x:"")}}(d.data&&d.hasContent&&d.contentType!==!1||c.contentType)&&v.setRequestHeader("Content-Type",d.contentType),d.ifModified&&(k=k||d.url,f.lastModified[k]&&v.setRequestHeader("If-Modified-Since",f.lastModified[k]),f.etag[k]&&v.setRequestHeader("If-None-Match",f.etag[k])),v.setRequestHeader("Accept",d.dataTypes[0]&&d.accepts[d.dataTypes[0]]?d.accepts[d.dataTypes[0]]+(d.dataTypes[0]!=="*"?", "+bX+"; q=0.01":""):d.accepts["*"]);for(u in d.headers)v.setRequestHeader(u,d.headers[u]);if(d.beforeSend&&(d.beforeSend.call(e,v,d)===!1||s===2)){v.abort();return!1}for(u in{success:1,error:1,complete:1})v[u](d[u]);p=b$(bU,d,c,v);if(!p)w(-1,"No Transport");else{v.readyState=1,t&&g.trigger("ajaxSend",[v,d]),d.async&&d.timeout>0&&(q=setTimeout(function(){v.abort("timeout")},d.timeout));try{s=1,p.send(l,w)}catch(z){if(s<2)w(-1,z);else throw z}}return v},param:function(a,c){var d=[],e=function(a,b){b=f.isFunction(b)?b():b,d[d.length]=encodeURIComponent(a)+"="+encodeURIComponent(b)};c===b&&(c=f.ajaxSettings.traditional);if(f.isArray(a)||a.jquery&&!f.isPlainObject(a))f.each(a,function(){e(this.name,this.value)});else for(var g in a)ca(g,a[g],c,e);return d.join("&").replace(bD,"+")}}),f.extend({active:0,lastModified:{},etag:{}});var cd=f.now(),ce=/(\=)\?(&|$)|\?\?/i;f.ajaxSetup({jsonp:"callback",jsonpCallback:function(){return f.expando+"_"+cd++}}),f.ajaxPrefilter("json jsonp",function(b,c,d){var e=b.contentType==="application/x-www-form-urlencoded"&&typeof b.data=="string";if(b.dataTypes[0]==="jsonp"||b.jsonp!==!1&&(ce.test(b.url)||e&&ce.test(b.data))){var g,h=b.jsonpCallback=f.isFunction(b.jsonpCallback)?b.jsonpCallback():b.jsonpCallback,i=a[h],j=b.url,k=b.data,l="$1"+h+"$2";b.jsonp!==!1&&(j=j.replace(ce,l),b.url===j&&(e&&(k=k.replace(ce,l)),b.data===k&&(j+=(/\?/.test(j)?"&":"?")+b.jsonp+"="+h))),b.url=j,b.data=k,a[h]=function(a){g=[a]},d.always(function(){a[h]=i,g&&f.isFunction(i)&&a[h](g[0])}),b.converters["script json"]=function(){g||f.error(h+" was not called");return g[0]},b.dataTypes[0]="json";return"script"}}),f.ajaxSetup({accepts:{script:"text/javascript, application/javascript, application/ecmascript, application/x-ecmascript"},contents:{script:/javascript|ecmascript/},converters:{"text script":function(a){f.globalEval(a);return a}}}),f.ajaxPrefilter("script",function(a){a.cache===b&&(a.cache=!1),a.crossDomain&&(a.type="GET",a.global=!1)}),f.ajaxTransport("script",function(a){if(a.crossDomain){var d,e=c.head||c.getElementsByTagName("head")[0]||c.documentElement;return{send:function(f,g){d=c.createElement("script"),d.async="async",a.scriptCharset&&(d.charset=a.scriptCharset),d.src=a.url,d.onload=d.onreadystatechange=function(a,c){if(c||!d.readyState||/loaded|complete/.test(d.readyState))d.onload=d.onreadystatechange=null,e&&d.parentNode&&e.removeChild(d),d=b,c||g(200,"success")},e.insertBefore(d,e.firstChild)},abort:function(){d&&d.onload(0,1)}}}});var cf=a.ActiveXObject?function(){for(var a in ch)ch[a](0,1)}:!1,cg=0,ch;f.ajaxSettings.xhr=a.ActiveXObject?function(){return!this.isLocal&&ci()||cj()}:ci,function(a){f.extend(f.support,{ajax:!!a,cors:!!a&&"withCredentials"in a})}(f.ajaxSettings.xhr()),f.support.ajax&&f.ajaxTransport(function(c){if(!c.crossDomain||f.support.cors){var d;return{send:function(e,g){var h=c.xhr(),i,j;c.username?h.open(c.type,c.url,c.async,c.username,c.password):h.open(c.type,c.url,c.async);if(c.xhrFields)for(j in c.xhrFields)h[j]=c.xhrFields[j];c.mimeType&&h.overrideMimeType&&h.overrideMimeType(c.mimeType),!c.crossDomain&&!e["X-Requested-With"]&&(e["X-Requested-With"]="XMLHttpRequest");try{for(j in e)h.setRequestHeader(j,e[j])}catch(k){}h.send(c.hasContent&&c.data||null),d=function(a,e){var j,k,l,m,n;try{if(d&&(e||h.readyState===4)){d=b,i&&(h.onreadystatechange=f.noop,cf&&delete ch[i]);if(e)h.readyState!==4&&h.abort();else{j=h.status,l=h.getAllResponseHeaders(),m={},n=h.responseXML,n&&n.documentElement&&(m.xml=n),m.text=h.responseText;try{k=h.statusText}catch(o){k=""}!j&&c.isLocal&&!c.crossDomain?j=m.text?200:404:j===1223&&(j=204)}}}catch(p){e||g(-1,p)}m&&g(j,k,m,l)},!c.async||h.readyState===4?d():(i=++cg,cf&&(ch||(ch={},f(a).unload(cf)),ch[i]=d),h.onreadystatechange=d)},abort:function(){d&&d(0,1)}}}});var ck={},cl,cm,cn=/^(?:toggle|show|hide)$/,co=/^([+\-]=)?([\d+.\-]+)([a-z%]*)$/i,cp,cq=[["height","marginTop","marginBottom","paddingTop","paddingBottom"],["width","marginLeft","marginRight","paddingLeft","paddingRight"],["opacity"]],cr;f.fn.extend({show:function(a,b,c){var d,e;if(a||a===0)return this.animate(cu("show",3),a,b,c);for(var g=0,h=this.length;g<h;g++)d=this[g],d.style&&(e=d.style.display,!f._data(d,"olddisplay")&&e==="none"&&(e=d.style.display=""),e===""&&f.css(d,"display")==="none"&&f._data(d,"olddisplay",cv(d.nodeName)));for(g=0;g<h;g++){d=this[g];if(d.style){e=d.style.display;if(e===""||e==="none")d.style.display=f._data(d,"olddisplay")||""}}return this},hide:function(a,b,c){if(a||a===0)return this.animate(cu("hide",3),a,b,c);var d,e,g=0,h=this.length;for(;g<h;g++)d=this[g],d.style&&(e=f.css(d,"display"),e!=="none"&&!f._data(d,"olddisplay")&&f._data(d,"olddisplay",e));for(g=0;g<h;g++)this[g].style&&(this[g].style.display="none");return this},_toggle:f.fn.toggle,toggle:function(a,b,c){var d=typeof a=="boolean";f.isFunction(a)&&f.isFunction(b)?this._toggle.apply(this,arguments):a==null||d?this.each(function(){var b=d?a:f(this).is(":hidden");f(this)[b?"show":"hide"]()}):this.animate(cu("toggle",3),a,b,c);return this},fadeTo:function(a,b,c,d){return this.filter(":hidden").css("opacity",0).show().end().animate({opacity:b},a,c,d)},animate:function(a,b,c,d){function g(){e.queue===!1&&f._mark(this);var b=f.extend({},e),c=this.nodeType===1,d=c&&f(this).is(":hidden"),g,h,i,j,k,l,m,n,o;b.animatedProperties={};for(i in a){g=f.camelCase(i),i!==g&&(a[g]=a[i],delete a[i]),h=a[g],f.isArray(h)?(b.animatedProperties[g]=h[1],h=a[g]=h[0]):b.animatedProperties[g]=b.specialEasing&&b.specialEasing[g]||b.easing||"swing";if(h==="hide"&&d||h==="show"&&!d)return b.complete.call(this);c&&(g==="height"||g==="width")&&(b.overflow=[this.style.overflow,this.style.overflowX,this.style.overflowY],f.css(this,"display")==="inline"&&f.css(this,"float")==="none"&&(!f.support.inlineBlockNeedsLayout||cv(this.nodeName)==="inline"?this.style.display="inline-block":this.style.zoom=1))}b.overflow!=null&&(this.style.overflow="hidden");for(i in a)j=new f.fx(this,b,i),h=a[i],cn.test(h)?(o=f._data(this,"toggle"+i)||(h==="toggle"?d?"show":"hide":0),o?(f._data(this,"toggle"+i,o==="show"?"hide":"show"),j[o]()):j[h]()):(k=co.exec(h),l=j.cur(),k?(m=parseFloat(k[2]),n=k[3]||(f.cssNumber[i]?"":"px"),n!=="px"&&(f.style(this,i,(m||1)+n),l=(m||1)/j.cur()*l,f.style(this,i,l+n)),k[1]&&(m=(k[1]==="-="?-1:1)*m+l),j.custom(l,m,n)):j.custom(l,h,""));return!0}var e=f.speed(b,c,d);if(f.isEmptyObject(a))return this.each(e.complete,[!1]);a=f.extend({},a);return e.queue===!1?this.each(g):this.queue(e.queue,g)},stop:function(a,c,d){typeof a!="string"&&(d=c,c=a,a=b),c&&a!==!1&&this.queue(a||"fx",[]);return this.each(function(){function h(a,b,c){var e=b[c];f.removeData(a,c,!0),e.stop(d)}var b,c=!1,e=f.timers,g=f._data(this);d||f._unmark(!0,this);if(a==null)for(b in g)g[b]&&g[b].stop&&b.indexOf(".run")===b.length-4&&h(this,g,b);else g[b=a+".run"]&&g[b].stop&&h(this,g,b);for(b=e.length;b--;)e[b].elem===this&&(a==null||e[b].queue===a)&&(d?e[b](!0):e[b].saveState(),c=!0,e.splice(b,1));(!d||!c)&&f.dequeue(this,a)})}}),f.each({slideDown:cu("show",1),slideUp:cu("hide",1),slideToggle:cu("toggle",1),fadeIn:{opacity:"show"},fadeOut:{opacity:"hide"},fadeToggle:{opacity:"toggle"}},function(a,b){f.fn[a]=function(a,c,d){return this.animate(b,a,c,d)}}),f.extend({speed:function(a,b,c){var d=a&&typeof a=="object"?f.extend({},a):{complete:c||!c&&b||f.isFunction(a)&&a,duration:a,easing:c&&b||b&&!f.isFunction(b)&&b};d.duration=f.fx.off?0:typeof d.duration=="number"?d.duration:d.duration in f.fx.speeds?f.fx.speeds[d.duration]:f.fx.speeds._default;if(d.queue==null||d.queue===!0)d.queue="fx";d.old=d.complete,d.complete=function(a){f.isFunction(d.old)&&d.old.call(this),d.queue?f.dequeue(this,d.queue):a!==!1&&f._unmark(this)};return d},easing:{linear:function(a,b,c,d){return c+d*a},swing:function(a,b,c,d){return(-Math.cos(a*Math.PI)/2+.5)*d+c}},timers:[],fx:function(a,b,c){this.options=b,this.elem=a,this.prop=c,b.orig=b.orig||{}}}),f.fx.prototype={update:function(){this.options.step&&this.options.step.call(this.elem,this.now,this),(f.fx.step[this.prop]||f.fx.step._default)(this)},cur:function(){if(this.elem[this.prop]!=null&&(!this.elem.style||this.elem.style[this.prop]==null))return this.elem[this.prop];var a,b=f.css(this.elem,this.prop);return isNaN(a=parseFloat(b))?!b||b==="auto"?0:b:a},custom:function(a,c,d){function h(a){return e.step(a)}var e=this,g=f.fx;this.startTime=cr||cs(),this.end=c,this.now=this.start=a,this.pos=this.state=0,this.unit=d||this.unit||(f.cssNumber[this.prop]?"":"px"),h.queue=this.options.queue,h.elem=this.elem,h.saveState=function(){e.options.hide&&f._data(e.elem,"fxshow"+e.prop)===b&&f._data(e.elem,"fxshow"+e.prop,e.start)},h()&&f.timers.push(h)&&!cp&&(cp=setInterval(g.tick,g.interval))},show:function(){var a=f._data(this.elem,"fxshow"+this.prop);this.options.orig[this.prop]=a||f.style(this.elem,this.prop),this.options.show=!0,a!==b?this.custom(this.cur(),a):this.custom(this.prop==="width"||this.prop==="height"?1:0,this.cur()),f(this.elem).show()},hide:function(){this.options.orig[this.prop]=f._data(this.elem,"fxshow"+this.prop)||f.style(this.elem,this.prop),this.options.hide=!0,this.custom(this.cur(),0)},step:function(a){var b,c,d,e=cr||cs(),g=!0,h=this.elem,i=this.options;if(a||e>=i.duration+this.startTime){this.now=this.end,this.pos=this.state=1,this.update(),i.animatedProperties[this.prop]=!0;for(b in i.animatedProperties)i.animatedProperties[b]!==!0&&(g=!1);if(g){i.overflow!=null&&!f.support.shrinkWrapBlocks&&f.each(["","X","Y"],function(a,b){h.style["overflow"+b]=i.overflow[a]}),i.hide&&f(h).hide();if(i.hide||i.show)for(b in i.animatedProperties)f.style(h,b,i.orig[b]),f.removeData(h,"fxshow"+b,!0),f.removeData(h,"toggle"+b,!0);d=i.complete,d&&(i.complete=!1,d.call(h))}return!1}i.duration==Infinity?this.now=e:(c=e-this.startTime,this.state=c/i.duration,this.pos=f.easing[i.animatedProperties[this.prop]](this.state,c,0,1,i.duration),this.now=this.start+(this.end-this.start)*this.pos),this.update();return!0}},f.extend(f.fx,{tick:function(){var a,b=f.timers,c=0;for(;c<b.length;c++)a=b[c],!a()&&b[c]===a&&b.splice(c--,1);b.length||f.fx.stop()},interval:13,stop:function(){clearInterval(cp),cp=null},speeds:{slow:600,fast:200,_default:400},step:{opacity:function(a){f.style(a.elem,"opacity",a.now)},_default:function(a){a.elem.style&&a.elem.style[a.prop]!=null?a.elem.style[a.prop]=a.now+a.unit:a.elem[a.prop]=a.now}}}),f.each(["width","height"],function(a,b){f.fx.step[b]=function(a){f.style(a.elem,b,Math.max(0,a.now)+a.unit)}}),f.expr&&f.expr.filters&&(f.expr.filters.animated=function(a){return f.grep(f.timers,function(b){return a===b.elem}).length});var cw=/^t(?:able|d|h)$/i,cx=/^(?:body|html)$/i;"getBoundingClientRect"in c.documentElement?f.fn.offset=function(a){var b=this[0],c;if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);try{c=b.getBoundingClientRect()}catch(d){}var e=b.ownerDocument,g=e.documentElement;if(!c||!f.contains(g,b))return c?{top:c.top,left:c.left}:{top:0,left:0};var h=e.body,i=cy(e),j=g.clientTop||h.clientTop||0,k=g.clientLeft||h.clientLeft||0,l=i.pageYOffset||f.support.boxModel&&g.scrollTop||h.scrollTop,m=i.pageXOffset||f.support.boxModel&&g.scrollLeft||h.scrollLeft,n=c.top+l-j,o=c.left+m-k;return{top:n,left:o}}:f.fn.offset=function(a){var b=this[0];if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);var c,d=b.offsetParent,e=b,g=b.ownerDocument,h=g.documentElement,i=g.body,j=g.defaultView,k=j?j.getComputedStyle(b,null):b.currentStyle,l=b.offsetTop,m=b.offsetLeft;while((b=b.parentNode)&&b!==i&&b!==h){if(f.support.fixedPosition&&k.position==="fixed")break;c=j?j.getComputedStyle(b,null):b.currentStyle,l-=b.scrollTop,m-=b.scrollLeft,b===d&&(l+=b.offsetTop,m+=b.offsetLeft,f.support.doesNotAddBorder&&(!f.support.doesAddBorderForTableAndCells||!cw.test(b.nodeName))&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),e=d,d=b.offsetParent),f.support.subtractsBorderForOverflowNotVisible&&c.overflow!=="visible"&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),k=c}if(k.position==="relative"||k.position==="static")l+=i.offsetTop,m+=i.offsetLeft;f.support.fixedPosition&&k.position==="fixed"&&(l+=Math.max(h.scrollTop,i.scrollTop),m+=Math.max(h.scrollLeft,i.scrollLeft));return{top:l,left:m}},f.offset={bodyOffset:function(a){var b=a.offsetTop,c=a.offsetLeft;f.support.doesNotIncludeMarginInBodyOffset&&(b+=parseFloat(f.css(a,"marginTop"))||0,c+=parseFloat(f.css(a,"marginLeft"))||0);return{top:b,left:c}},setOffset:function(a,b,c){var d=f.css(a,"position");d==="static"&&(a.style.position="relative");var e=f(a),g=e.offset(),h=f.css(a,"top"),i=f.css(a,"left"),j=(d==="absolute"||d==="fixed")&&f.inArray("auto",[h,i])>-1,k={},l={},m,n;j?(l=e.position(),m=l.top,n=l.left):(m=parseFloat(h)||0,n=parseFloat(i)||0),f.isFunction(b)&&(b=b.call(a,c,g)),b.top!=null&&(k.top=b.top-g.top+m),b.left!=null&&(k.left=b.left-g.left+n),"using"in b?b.using.call(a,k):e.css(k)}},f.fn.extend({position:function(){if(!this[0])return null;var a=this[0],b=this.offsetParent(),c=this.offset(),d=cx.test(b[0].nodeName)?{top:0,left:0}:b.offset();c.top-=parseFloat(f.css(a,"marginTop"))||0,c.left-=parseFloat(f.css(a,"marginLeft"))||0,d.top+=parseFloat(f.css(b[0],"borderTopWidth"))||0,d.left+=parseFloat(f.css(b[0],"borderLeftWidth"))||0;return{top:c.top-d.top,left:c.left-d.left}},offsetParent:function(){return this.map(function(){var a=this.offsetParent||c.body;while(a&&!cx.test(a.nodeName)&&f.css(a,"position")==="static")a=a.offsetParent;return a})}}),f.each(["Left","Top"],function(a,c){var d="scroll"+c;f.fn[d]=function(c){var e,g;if(c===b){e=this[0];if(!e)return null;g=cy(e);return g?"pageXOffset"in g?g[a?"pageYOffset":"pageXOffset"]:f.support.boxModel&&g.document.documentElement[d]||g.document.body[d]:e[d]}return this.each(function(){g=cy(this),g?g.scrollTo(a?f(g).scrollLeft():c,a?c:f(g).scrollTop()):this[d]=c})}}),f.each(["Height","Width"],function(a,c){var d=c.toLowerCase();f.fn["inner"+c]=function(){var a=this[0];return a?a.style?parseFloat(f.css(a,d,"padding")):this[d]():null},f.fn["outer"+c]=function(a){var b=this[0];return b?b.style?parseFloat(f.css(b,d,a?"margin":"border")):this[d]():null},f.fn[d]=function(a){var e=this[0];if(!e)return a==null?null:this;if(f.isFunction(a))return this.each(function(b){var c=f(this);c[d](a.call(this,b,c[d]()))});if(f.isWindow(e)){var g=e.document.documentElement["client"+c],h=e.document.body;return e.document.compatMode==="CSS1Compat"&&g||h&&h["client"+c]||g}if(e.nodeType===9)return Math.max(e.documentElement["client"+c],e.body["scroll"+c],e.documentElement["scroll"+c],e.body["offset"+c],e.documentElement["offset"+c]);if(a===b){var i=f.css(e,d),j=parseFloat(i);return f.isNumeric(j)?j:i}return this.css(d,typeof a=="string"?a:a+"px")}}),a.jQuery=a.$=f,typeof define=="function"&&define.amd&&define.amd.jQuery&&define("jquery",[],function(){return f})})(window);
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OEBPS/Common_Content/scripts/highlight.js/CHANGES.md
## Version 8.4

We've got the new [demo page][]! The obvious new feature is the new look, but
apart from that it's got smarter: by presenting languages in groups it avoids
running 10000 highlighting attempts after first load which was slowing it down
and giving bad overall impression. It is now also being generated from test
code snippets so the authors of new languages don't have to update both tests
and the demo page with the same thing.

Other notable changes:

- The `template_comment` class is gone in favor of the more general `comment`.
- Number parsing unified and improved across languages.
- C++, Java and C# now use unified grammar to highlight titles in
  function/method definitions.
- The browser build is now usable as an AMD module, there's no separate build
  target for that anymore.
- OCaml has got a [comprehensive overhaul][ocaml] by [Mickaël Delahaye][].
- Clojure's data structures and literals are now highlighted outside of lists
  and we can now highlight Clojure's REPL sessions.

New languages:

- *AspectJ* by [Hakan Özler][]
- *STEP Part 21* by [Adam Joseph Cook][]
- *SML* derived by [Edwin Dalorzo][] from OCaml definition
- *Mercury* by [mucaho][]
- *Smali* by [Dennis Titze][]
- *Verilog* by [Jon Evans][]
- *Stata* by [Brian Quistorff][]

[Hakan Özler]: https://github.com/ozlerhakan
[Adam Joseph Cook]: https://github.com/adamjcook
[demo page]: https://highlightjs.org/static/demo/
[Ivan Sagalaev]: https://github.com/isagalaev
[Edwin Dalorzo]: https://github.com/edalorzo
[mucaho]: https://github.com/mucaho
[Dennis Titze]: https://github.com/titze
[Jon Evans]: https://github.com/craftyjon
[Brian Quistorff]: https://github.com/bquistorff
[ocaml]: https://github.com/isagalaev/highlight.js/pull/608#issue-46190207
[Mickaël Delahaye]: https://github.com/polazarus


## Version 8.3

We streamlined our tool chain, it is now based entirely on node.js instead of
being a mix of node.js, Python and Java. The build script options and arguments
remained the same, and we've noted all the changes in the [documentation][b].
Apart from reducing complexity, the new build script is also faster from not
having to start Java machine repeatedly. The credits for the work go to [Jeremy
Hull][].

Some notable fixes:

- PHP and JavaScript mixed in HTML now live happily with each other.
- JavaScript regexes now understand ES6 flags "u" and "y".
- `throw` keyword is no longer detected as a method name in Java.
- Fixed parsing of numbers and symbols in Clojure thanks to [input from Ivan
  Kleshnin][ik].

New languages in this release:

- *Less* by [Max Mikhailov][]
- *Stylus* by [Bryant Williams][]
- *Tcl* by [Radek Liska][]
- *Puppet* by [Jose Molina Colmenero][]
- *Processing* by [Erik Paluka][]
- *Twig* templates by [Luke Holder][]
- *PowerShell* by [David Mohundro][], based on [the work of Nicholas
  Blumhardt][ps]
- *XL* by [Christophe de Dinechin][]
- *LiveScript* by [Taneli Vatanen][] and [Jen Evers-Corvina][]
- *ERB* (Ruby in HTML) by [Lucas Mazza][]
- *Roboconf* by [Vincent Zurczak][]

[b]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[Jeremy Hull]: https://github.com/sourrust
[ik]: https://twitter.com/IvanKleshnin/status/514041599484231680
[Max Mikhailov]: https://github.com/seven-phases-max
[Bryant Williams]: https://github.com/scien
[Radek Liska]: https://github.com/Nindaleth
[Jose Molina Colmenero]: https://github.com/Moliholy
[Erik Paluka]: https://github.com/paluka
[Luke Holder]: https://github.com/lukeholder
[David Mohundro]: https://github.com/drmohundro
[ps]: https://github.com/OctopusDeploy/Library/blob/master/app/shared/presentation/highlighting/powershell.js
[Christophe de Dinechin]: https://github.com/c3d
[Taneli Vatanen]: https://github.com/Daiz-
[Jen Evers-Corvina]: https://github.com/sevvie
[Lucas Mazza]: https://github.com/lucasmazza
[Vincent Zurczak]: https://github.com/vincent-zurczak

## Version 8.2

We've finally got [real tests][test] and [continuous testing on Travis][ci]
thanks to [Jeremy Hull][] and [Chris Eidhof][]. The tests designed to cover
everything: language detection, correct parsing of individual language features
and various special cases. This is a very important change that gives us
confidence in extending language definitions and refactoring library core.

We're going to redesign the old [demo/test suite][demo] into an interactive
demo web app. If you're confident front-end developer or designer and want to
help us with it, drop a comment into [the issue][#542] on GitHub.

[test]: https://github.com/isagalaev/highlight.js/tree/master/test
[demo]: https://highlightjs.org/static/test.html
[#542]: https://github.com/isagalaev/highlight.js/issues/542
[ci]: https://travis-ci.org/isagalaev/highlight.js
[Jeremy Hull]: https://github.com/sourrust
[Chris Eidhof]: https://github.com/chriseidhof

As usually there's a handful of new languages in this release:

- *Groovy* by [Guillaume Laforge][]
- *Dart* by [Maxim Dikun][]
- *Dust* by [Michael Allen][]
- *Scheme* by [JP Verkamp][]
- *G-Code* by [Adam Joseph Cook][]
- *Q* from Kx Systems by [Sergey Vidyuk][]

[Guillaume Laforge]: https://github.com/glaforge
[Maxim Dikun]: https://github.com/dikmax
[Michael Allen]: https://github.com/bfui
[JP Verkamp]: https://github.com/jpverkamp
[Adam Joseph Cook]: https://github.com/adamjcook
[Sergey Vidyuk]: https://github.com/sv

Other improvements:

- [Erik Osheim][] heavily reworked Scala definitions making it richer.
- [Lucas Mazza][] fixed Ruby hashes highlighting
- Lisp variants (Lisp, Clojure and Scheme) are unified in regard to naming
  the first symbol in parentheses: it's "keyword" in general case and also
  "built_in" for built-in functions in Clojure and Scheme.

[Erik Osheim]: https://github.com/non
[Lucas Mazza]: https://github.com/lucasmazza

## Version 8.1

New languages:

- *Gherkin* by [Sam Pikesley][]
- *Elixir* by [Josh Adams][]
- *NSIS* by [Jan T. Sott][]
- *VIM script* by [Jun Yang][]
- *Protocol Buffers* by [Dan Tao][]
- *Nix* by [Domen Kožar][]
- *x86asm* by [innocenat][]
- *Cap’n Proto* and *Thrift* by [Oleg Efimov][]
- *Monkey* by [Arthur Bikmullin][]
- *TypeScript* by [Panu Horsmalahti][]
- *Nimrod* by [Flaviu Tamas][]
- *Gradle* by [Damian Mee][]
- *Haxe* by [Christopher Kaster][]
- *Swift* by [Chris Eidhof][] and [Nate Cook][]

New styles:

- *Kimbie*, light and dark variants by [Jan T. Sott][]
- *Color brewer* by [Fabrício Tavares de Oliveira][]
- *Codepen.io embed* by [Justin Perry][]
- *Hybrid* by [Nic West][]

[Sam Pikesley]: https://github.com/pikesley
[Sindre Sorhus]: https://github.com/sindresorhus
[Josh Adams]: https://github.com/knewter
[Jan T. Sott]: https://github.com/idleberg
[Jun Yang]: https://github.com/harttle
[Dan Tao]: https://github.com/dtao
[Domen Kožar]: https://github.com/iElectric
[innocenat]: https://github.com/innocenat
[Oleg Efimov]: https://github.com/Sannis
[Arthur Bikmullin]: https://github.com/devolonter
[Panu Horsmalahti]: https://github.com/panuhorsmalahti
[Flaviu Tamas]: https://github.com/flaviut
[Damian Mee]: https://github.com/chester1000
[Christopher Kaster]: http://christopher.kaster.ws
[Fabrício Tavares de Oliveira]: https://github.com/fabriciotav
[Justin Perry]: https://github.com/ourmaninamsterdam
[Nic West]: https://github.com/nicwest
[Chris Eidhof]: https://github.com/chriseidhof
[Nate Cook]: https://github.com/natecook1000

Other improvements:

- The README is heavily reworked and brought up to date by [Jeremy Hull][].
- Added [`listLanguages()`][ll] method in the API.
- Improved C/C++/C# detection.
- Added a bunch of new language aliases, documented the existing ones. Thanks to
  [Sindre Sorhus][] for background research.
- Added phrasal English words to boost relevance in comments.
- Many improvements to SQL definition made by [Heiko August][],
  [Nikolay Lisienko][] and [Travis Odom][].
- The shorter `lang-` prefix for language names in HTML classes supported
  alongside `language-`. Thanks to [Jeff Escalante][].
- Ruby's got support for interactive console sessions. Thanks to
  [Pascal Hurni][].
- Added built-in functions for R language. Thanks to [Artem A. Klevtsov][].
- Rust's got definition for lifetime parameters and improved string syntax.
  Thanks to [Roman Shmatov][].
- Various improvements to Objective-C definition by [Matt Diephouse][].
- Fixed highlighting of generics in Java.

[ll]: http://highlightjs.readthedocs.org/en/latest/api.html#listlanguages
[Sindre Sorhus]: https://github.com/sindresorhus
[Heiko August]: https://github.com/auge8472
[Nikolay Lisienko]: https://github.com/neor-ru
[Travis Odom]: https://github.com/Burstaholic
[Jeff Escalante]: https://github.com/jenius
[Pascal Hurni]: https://github.com/phurni
[Jiyin Yiyong]: https://github.com/jiyinyiyong
[Artem A. Klevtsov]: https://github.com/unikum
[Roman Shmatov]: https://github.com/shmatov
[Jeremy Hull]: https://github.com/sourrust
[Matt Diephouse]: https://github.com/mdiep


## Version 8.0

This new major release is quite a big overhaul bringing both new features and
some backwards incompatible changes. However, chances are that the majority of
users won't be affected by the latter: the basic scenario described in the
README is left intact.

Here's what did change in an incompatible way:

- We're now prefixing all classes located in [CSS classes reference][cr] with
  `hljs-`, by default, because some class names would collide with other
  people's stylesheets. If you were using an older version, you might still want
  the previous behavior, but still want to upgrade. To suppress this new
  behavior, you would initialize like so:

  ```html
  <script type="text/javascript">
    hljs.configure({classPrefix: ''});
    hljs.initHighlightingOnLoad();
  </script>
  ```

- `tabReplace` and `useBR` that were used in different places are also unified
  into the global options object and are to be set using `configure(options)`.
  This function is documented in our [API docs][]. Also note that these
  parameters are gone from `highlightBlock` and `fixMarkup` which are now also
  rely on `configure`.

- We removed public-facing (though undocumented) object `hljs.LANGUAGES` which
  was used to register languages with the library in favor of two new methods:
  `registerLanguage` and `getLanguage`. Both are documented in our [API docs][].

- Result returned from `highlight` and `highlightAuto` no longer contains two
  separate attributes contributing to relevance score, `relevance` and
  `keyword_count`. They are now unified in `relevance`.

Another technically compatible change that nonetheless might need attention:

- The structure of the NPM package was refactored, so if you had installed it
  locally, you'll have to update your paths. The usual `require('highlight.js')`
  works as before. This is contributed by [Dmitry Smolin][].

New features:

- Languages now can be recognized by multiple names like "js" for JavaScript or
  "html" for, well, HTML (which earlier insisted on calling it "xml"). These
  aliases can be specified in the class attribute of the code container in your
  HTML as well as in various API calls. For now there are only a few very common
  aliases but we'll expand it in the future. All of them are listed in the
  [class reference][cr].

- Language detection can now be restricted to a subset of languages relevant in
  a given context — a web page or even a single highlighting call. This is
  especially useful for node.js build that includes all the known languages.
  Another example is a StackOverflow-style site where users specify languages
  as tags rather than in the markdown-formatted code snippets. This is
  documented in the [API reference][] (see methods `highlightAuto` and
  `configure`).

- Language definition syntax streamlined with [variants][] and
  [beginKeywords][].

New languages and styles:

- *Oxygene* by [Carlo Kok][]
- *Mathematica* by [Daniel Kvasnička][]
- *Autohotkey* by [Seongwon Lee][]
- *Atelier* family of styles in 10 variants by [Bram de Haan][]
- *Paraíso* styles by [Jan T. Sott][]

Miscellaneous improvements:

- Highlighting `=>` prompts in Clojure.
- [Jeremy Hull][] fixed a lot of styles for consistency.
- Finally, highlighting PHP and HTML [mixed in peculiar ways][php-html].
- Objective C and C# now properly highlight titles in method definition.
- Big overhaul of relevance counting for a number of languages. Please do report
  bugs about mis-detection of non-trivial code snippets!

[API reference]: http://highlightjs.readthedocs.org/en/latest/api.html

[cr]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[api docs]: http://highlightjs.readthedocs.org/en/latest/api.html
[variants]: https://groups.google.com/d/topic/highlightjs/VoGC9-1p5vk/discussion
[beginKeywords]: https://github.com/isagalaev/highlight.js/commit/6c7fdea002eb3949577a85b3f7930137c7c3038d
[php-html]: https://twitter.com/highlightjs/status/408890903017689088

[Carlo Kok]: https://github.com/carlokok
[Bram de Haan]: https://github.com/atelierbram
[Daniel Kvasnička]: https://github.com/dkvasnicka
[Dmitry Smolin]: https://github.com/dimsmol
[Jeremy Hull]: https://github.com/sourrust
[Seongwon Lee]: https://github.com/dlimpid
[Jan T. Sott]: https://github.com/idleberg


## Version 7.5

A catch-up release dealing with some of the accumulated contributions. This one
is probably will be the last before the 8.0 which will be slightly backwards
incompatible regarding some advanced use-cases.

One outstanding change in this version is the addition of 6 languages to the
[hosted script][d]: Markdown, ObjectiveC, CoffeeScript, Apache, Nginx and
Makefile. It now weighs about 6K more but we're going to keep it under 30K.

New languages:

- OCaml by [Mehdi Dogguy][mehdid] and [Nicolas Braud-Santoni][nbraud]
- [LiveCode Server][lcs] by [Ralf Bitter][revig]
- Scilab by [Sylvestre Ledru][sylvestre]
- basic support for Makefile by [Ivan Sagalaev][isagalaev]

Improvements:

- Ruby's got support for characters like `?A`, `?1`, `?\012` etc. and `%r{..}`
  regexps.
- Clojure now allows a function call in the beginning of s-expressions
  `(($filter "myCount") (arr 1 2 3 4 5))`.
- Haskell's got new keywords and now recognizes more things like pragmas,
  preprocessors, modules, containers, FFIs etc. Thanks to [Zena Treep][treep]
  for the implementation and to [Jeremy Hull][sourrust] for guiding it.
- Miscellaneous fixes in PHP, Brainfuck, SCSS, Asciidoc, CMake, Python and F#.

[mehdid]: https://github.com/mehdid
[nbraud]: https://github.com/nbraud
[revig]: https://github.com/revig
[lcs]: http://livecode.com/developers/guides/server/
[sylvestre]: https://github.com/sylvestre
[isagalaev]: https://github.com/isagalaev
[treep]: https://github.com/treep
[sourrust]: https://github.com/sourrust
[d]: http://highlightjs.org/download/


## New core developers

The latest long period of almost complete inactivity in the project coincided
with growing interest to it led to a decision that now seems completely obvious:
we need more core developers.

So without further ado let me welcome to the core team two long-time
contributors: [Jeremy Hull][] and [Oleg
Efimov][].

Hope now we'll be able to work through stuff faster!

P.S. The historical commit is [here][1] for the record.

[Jeremy Hull]: https://github.com/sourrust
[Oleg Efimov]: https://github.com/sannis
[1]: https://github.com/isagalaev/highlight.js/commit/f3056941bda56d2b72276b97bc0dd5f230f2473f


## Version 7.4

This long overdue version is a snapshot of the current source tree with all the
changes that happened during the past year. Sorry for taking so long!

Along with the changes in code highlight.js has finally got its new home at
<http://highlightjs.org/>, moving from its cradle on Software Maniacs which it
outgrew a long time ago. Be sure to report any bugs about the site to
<mailto:info@highlightjs.org>.

On to what's new…

New languages:

- Handlebars templates by [Robin Ward][]
- Oracle Rules Language by [Jason Jacobson][]
- F# by [Joans Follesø][]
- AsciiDoc and Haml by [Dan Allen][]
- Lasso by [Eric Knibbe][]
- SCSS by [Kurt Emch][]
- VB.NET by [Poren Chiang][]
- Mizar by [Kelley van Evert][]

[Robin Ward]: https://github.com/eviltrout
[Jason Jacobson]: https://github.com/jayce7
[Joans Follesø]: https://github.com/follesoe
[Dan Allen]: https://github.com/mojavelinux
[Eric Knibbe]: https://github.com/EricFromCanada
[Kurt Emch]: https://github.com/kemch
[Poren Chiang]: https://github.com/rschiang
[Kelley van Evert]: https://github.com/kelleyvanevert

New style themes:

- Monokai Sublime by [noformnocontent][]
- Railscasts by [Damien White][]
- Obsidian by [Alexander Marenin][]
- Docco by [Simon Madine][]
- Mono Blue by [Ivan Sagalaev][] (uses a single color hue for everything)
- Foundation by [Dan Allen][]

[noformnocontent]: http://nn.mit-license.org/
[Damien White]: https://github.com/visoft
[Alexander Marenin]: https://github.com/ioncreature
[Simon Madine]: https://github.com/thingsinjars
[Ivan Sagalaev]: https://github.com/isagalaev

Other notable changes:

- Corrected many corner cases in CSS.
- Dropped Python 2 version of the build tool.
- Implemented building for the AMD format.
- Updated Rust keywords (thanks to [Dmitry Medvinsky][]).
- Literal regexes can now be used in language definitions.
- CoffeeScript highlighting is now significantly more robust and rich due to
  input from [Cédric Néhémie][].

[Dmitry Medvinsky]: https://github.com/dmedvinsky
[Cédric Néhémie]: https://github.com/abe33


## Version 7.3

- Since this version highlight.js no longer works in IE version 8 and older.
  It's made it possible to reduce the library size and dramatically improve code
  readability and made it easier to maintain. Time to go forward!

- New languages: AppleScript (by [Nathan Grigg][ng] and [Dr. Drang][dd]) and
  Brainfuck (by [Evgeny Stepanischev][bolk]).

- Improvements to existing languages:

    - interpreter prompt in Python (`>>>` and `...`)
    - @-properties and classes in CoffeeScript
    - E4X in JavaScript (by [Oleg Efimov][oe])
    - new keywords in Perl (by [Kirk Kimmel][kk])
    - big Ruby syntax update (by [Vasily Polovnyov][vast])
    - small fixes in Bash

- Also Oleg Efimov did a great job of moving all the docs for language and style
  developers and contributors from the old wiki under the source code in the
  "docs" directory. Now these docs are nicely presented at
  <http://highlightjs.readthedocs.org/>.

[ng]: https://github.com/nathan11g
[dd]: https://github.com/drdrang
[bolk]: https://github.com/bolknote
[oe]: https://github.com/Sannis
[kk]: https://github.com/kimmel
[vast]: https://github.com/vast


## Version 7.2

A regular bug-fix release without any significant new features. Enjoy!


## Version 7.1

A Summer crop:

- [Marc Fornos][mf] made the definition for Clojure along with the matching
  style Rainbow (which, of course, works for other languages too).
- CoffeeScript support continues to improve getting support for regular
  expressions.
- Yoshihide Jimbo ported to highlight.js [five Tomorrow styles][tm] from the
  [project by Chris Kempson][tm0].
- Thanks to [Casey Duncun][cd] the library can now be built in the popular
  [AMD format][amd].
- And last but not least, we've got a fair number of correctness and consistency
  fixes, including a pretty significant refactoring of Ruby.

[mf]: https://github.com/mfornos
[tm]: http://jmblog.github.com/color-themes-for-highlightjs/
[tm0]: https://github.com/ChrisKempson/Tomorrow-Theme
[cd]: https://github.com/caseman
[amd]: http://requirejs.org/docs/whyamd.html


## Version 7.0

The reason for the new major version update is a global change of keyword syntax
which resulted in the library getting smaller once again. For example, the
hosted build is 2K less than at the previous version while supporting two new
languages.

Notable changes:

- The library now works not only in a browser but also with [node.js][]. It is
  installable with `npm install highlight.js`. [API][] docs are available on our
  wiki.

- The new unique feature (apparently) among syntax highlighters is highlighting
  *HTTP* headers and an arbitrary language in the request body. The most useful
  languages here are *XML* and *JSON* both of which highlight.js does support.
  Here's [the detailed post][p] about the feature.

- Two new style themes: a dark "south" *[Pojoaque][]* by Jason Tate and an
  emulation of*XCode* IDE by [Angel Olloqui][ao].

- Three new languages: *D* by [Aleksandar Ružičić][ar], *R* by [Joe Cheng][jc]
  and *GLSL* by [Sergey Tikhomirov][st].

- *Nginx* syntax has become a million times smaller and more universal thanks to
  remaking it in a more generic manner that doesn't require listing all the
  directives in the known universe.

- Function titles are now highlighted in *PHP*.

- *Haskell* and *VHDL* were significantly reworked to be more rich and correct
  by their respective maintainers [Jeremy Hull][sr] and [Igor Kalnitsky][ik].

And last but not least, many bugs have been fixed around correctness and
language detection.

Overall highlight.js currently supports 51 languages and 20 style themes.

[node.js]: http://nodejs.org/
[api]: http://softwaremaniacs.org/wiki/doku.php/highlight.js:api
[p]: http://softwaremaniacs.org/blog/2012/05/10/http-and-json-in-highlight-js/en/
[pojoaque]: http://web-cms-designs.com/ftopict-10-pojoaque-style-for-highlight-js-code-highlighter.html
[ao]: https://github.com/angelolloqui
[ar]: https://github.com/raleksandar
[jc]: https://github.com/jcheng5
[st]: https://github.com/tikhomirov
[sr]: https://github.com/sourrust
[ik]: https://github.com/ikalnitsky


## Version 6.2

A lot of things happened in highlight.js since the last version! We've got nine
new contributors, the discussion group came alive, and the main branch on GitHub
now counts more than 350 followers. Here are most significant results coming
from all this activity:

- 5 (five!) new languages: Rust, ActionScript, CoffeeScript, MatLab and
  experimental support for markdown. Thanks go to [Andrey Vlasovskikh][av],
  [Alexander Myadzel][am], [Dmytrii Nagirniak][dn], [Oleg Efimov][oe], [Denis
  Bardadym][db] and [John Crepezzi][jc].

- 2 new style themes: Monokai by [Luigi Maselli][lm] and stylistic imitation of
  another well-known highlighter Google Code Prettify by [Aahan Krish][ak].

- A vast number of [correctness fixes and code refactorings][log], mostly made
  by [Oleg Efimov][oe] and [Evgeny Stepanischev][es].

[av]: https://github.com/vlasovskikh
[am]: https://github.com/myadzel
[dn]: https://github.com/dnagir
[oe]: https://github.com/Sannis
[db]: https://github.com/btd
[jc]: https://github.com/seejohnrun
[lm]: http://grigio.org/
[ak]: https://github.com/geekpanth3r
[es]: https://github.com/bolknote
[log]: https://github.com/isagalaev/highlight.js/commits/


## Version 6.1 — Solarized

[Jeremy Hull][jh] has implemented my dream feature — a port of [Solarized][]
style theme famous for being based on the intricate color theory to achieve
correct contrast and color perception. It is now available for highlight.js in
both variants — light and dark.

This version also adds a new original style Arta. Its author pumbur maintains a
[heavily modified fork of highlight.js][pb] on GitHub.

[jh]: https://github.com/sourrust
[solarized]: http://ethanschoonover.com/solarized
[pb]: https://github.com/pumbur/highlight.js


## Version 6.0

New major version of the highlighter has been built on a significantly
refactored syntax. Due to this it's even smaller than the previous one while
supporting more languages!

New languages are:

- Haskell by [Jeremy Hull][sourrust]
- Erlang in two varieties — module and REPL — made collectively by [Nikolay
  Zakharov][desh], [Dmitry Kovega][arhibot] and [Sergey Ignatov][ignatov]
- Objective C by [Valerii Hiora][vhbit]
- Vala by [Antono Vasiljev][antono]
- Go by [Stephan Kountso][steplg]

[sourrust]: https://github.com/sourrust
[desh]: http://desh.su/
[arhibot]: https://github.com/arhibot
[ignatov]: https://github.com/ignatov
[vhbit]: https://github.com/vhbit
[antono]: https://github.com/antono
[steplg]: https://github.com/steplg

Also this version is marginally faster and fixes a number of small long-standing
bugs.

Developer overview of the new language syntax is available in a [blog post about
recent beta release][beta].

[beta]: http://softwaremaniacs.org/blog/2011/04/25/highlight-js-60-beta/en/

P.S. New version is not yet available on a Yandex CDN, so for now you have to
download [your own copy][d].

[d]: /soft/highlight/en/download/


## Version 5.14

Fixed bugs in HTML/XML detection and relevance introduced in previous
refactoring.

Also test.html now shows the second best result of language detection by
relevance.


## Version 5.13

Past weekend began with a couple of simple additions for existing languages but
ended up in a big code refactoring bringing along nice improvements for language
developers.

### For users

- Description of C++ has got new keywords from the upcoming [C++ 0x][] standard.
- Description of HTML has got new tags from [HTML 5][].
- CSS-styles have been unified to use consistent padding and also have lost
  pop-outs with names of detected languages.
- [Igor Kalnitsky][ik] has sent two new language descriptions: CMake & VHDL.

This makes total number of languages supported by highlight.js to reach 35.

Bug fixes:

- Custom classes on `<pre>` tags are not being overridden anymore
- More correct highlighting of code blocks inside non-`<pre>` containers:
  highlighter now doesn't insist on replacing them with its own container and
  just replaces the contents.
- Small fixes in browser compatibility and heuristics.

[c++ 0x]: http://ru.wikipedia.org/wiki/C%2B%2B0x
[html 5]: http://en.wikipedia.org/wiki/HTML5
[ik]: http://kalnitsky.org.ua/

### For developers

The most significant change is the ability to include language submodes right
under `contains` instead of defining explicit named submodes in the main array:

    contains: [
      'string',
      'number',
      {begin: '\\n', end: hljs.IMMEDIATE_RE}
    ]

This is useful for auxiliary modes needed only in one place to define parsing.
Note that such modes often don't have `className` and hence won't generate a
separate `<span>` in the resulting markup. This is similar in effect to
`noMarkup: true`. All existing languages have been refactored accordingly.

Test file test.html has at last become a real test. Now it not only puts the
detected language name under the code snippet but also tests if it matches the
expected one. Test summary is displayed right above all language snippets.


## CDN

Fine people at [Yandex][] agreed to host highlight.js on their big fast servers.
[Link up][l]!

[yandex]: http://yandex.com/
[l]: http://softwaremaniacs.org/soft/highlight/en/download/


## Version 5.10 — "Paris".

Though I'm on a vacation in Paris, I decided to release a new version with a
couple of small fixes:

- Tomas Vitvar discovered that TAB replacement doesn't always work when used
  with custom markup in code
- SQL parsing is even more rigid now and doesn't step over SmallTalk in tests


## Version 5.9

A long-awaited version is finally released.

New languages:

- Andrew Fedorov made a definition for Lua
- a long-time highlight.js contributor [Peter Leonov][pl] made a definition for
  Nginx config
- [Vladimir Moskva][vm] made a definition for TeX

[pl]: http://kung-fu-tzu.ru/
[vm]: http://fulc.ru/

Fixes for existing languages:

- [Loren Segal][ls] reworked the Ruby definition and added highlighting for
  [YARD][] inline documentation
- the definition of SQL has become more solid and now it shouldn't be overly
  greedy when it comes to language detection

[ls]: http://gnuu.org/
[yard]: http://yardoc.org/

The highlighter has become more usable as a library allowing to do highlighting
from initialization code of JS frameworks and in ajax methods (see.
readme.eng.txt).

Also this version drops support for the [WordPress][wp] plugin. Everyone is
welcome to [pick up its maintenance][p] if needed.

[wp]: http://wordpress.org/
[p]: http://bazaar.launchpad.net/~isagalaev/+junk/highlight/annotate/342/src/wp_highlight.js.php


## Version 5.8

- Jan Berkel has contributed a definition for Scala. +1 to hotness!
- All CSS-styles are rewritten to work only inside `<pre>` tags to avoid
  conflicts with host site styles.


## Version 5.7.

Fixed escaping of quotes in VBScript strings.


## Version 5.5

This version brings a small change: now .ini-files allow digits, underscores and
square brackets in key names.


## Version 5.4

Fixed small but upsetting bug in the packer which caused incorrect highlighting
of explicitly specified languages. Thanks to Andrew Fedorov for precise
diagnostics!


## Version 5.3

The version to fulfil old promises.

The most significant change is that highlight.js now preserves custom user
markup in code along with its own highlighting markup. This means that now it's
possible to use, say, links in code. Thanks to [Vladimir Dolzhenko][vd] for the
[initial proposal][1] and for making a proof-of-concept patch.

Also in this version:

- [Vasily Polovnyov][vp] has sent a GitHub-like style and has implemented
  support for CSS @-rules and Ruby symbols.
- Yura Zaripov has sent two styles: Brown Paper and School Book.
- Oleg Volchkov has sent a definition for [Parser 3][p3].

[1]: http://softwaremaniacs.org/forum/highlightjs/6612/
[p3]: http://www.parser.ru/
[vp]: http://vasily.polovnyov.ru/
[vd]: http://dolzhenko.blogspot.com/


## Version 5.2

- at last it's possible to replace indentation TABs with something sensible
  (e.g. 2 or 4 spaces)
- new keywords and built-ins for 1C by Sergey Baranov
- a couple of small fixes to Apache highlighting


## Version 5.1

This is one of those nice version consisting entirely of new and shiny
contributions!

- [Vladimir Ermakov][vooon] created highlighting for AVR Assembler
- [Ruslan Keba][rukeba] created highlighting for Apache config file. Also his
  original visual style for it is now available for all highlight.js languages
  under the name "Magula".
- [Shuen-Huei Guan][drake] (aka Drake) sent new keywords for RenderMan
  languages. Also thanks go to [Konstantin Evdokimenko][ke] for his advice on
  the matter.

[vooon]: http://vehq.ru/about/
[rukeba]: http://rukeba.com/
[drake]: http://drakeguan.org/
[ke]: http://k-evdokimenko.moikrug.ru/


## Version 5.0

The main change in the new major version of highlight.js is a mechanism for
packing several languages along with the library itself into a single compressed
file. Now sites using several languages will load considerably faster because
the library won't dynamically include additional files while loading.

Also this version fixes a long-standing bug with Javascript highlighting that
couldn't distinguish between regular expressions and division operations.

And as usually there were a couple of minor correctness fixes.

Great thanks to all contributors! Keep using highlight.js.


## Version 4.3

This version comes with two contributions from [Jason Diamond][jd]:

- language definition for C# (yes! it was a long-missed thing!)
- Visual Studio-like highlighting style

Plus there are a couple of minor bug fixes for parsing HTML and XML attributes.

[jd]: http://jason.diamond.name/weblog/


## Version 4.2

The biggest news is highlighting for Lisp, courtesy of Vasily Polovnyov. It's
somewhat experimental meaning that for highlighting "keywords" it doesn't use
any pre-defined set of a Lisp dialect. Instead it tries to highlight first word
in parentheses wherever it makes sense. I'd like to ask people programming in
Lisp to confirm if it's a good idea and send feedback to [the forum][f].

Other changes:

- Smalltalk was excluded from DEFAULT_LANGUAGES to save traffic
- [Vladimir Epifanov][voldmar] has implemented javascript style switcher for
  test.html
- comments now allowed inside Ruby function definition
- [MEL][] language from [Shuen-Huei Guan][drake]
- whitespace now allowed between `<pre>` and `<code>`
- better auto-detection of C++ and PHP
- HTML allows embedded VBScript (`<% .. %>`)

[f]: http://softwaremaniacs.org/forum/highlightjs/
[voldmar]: http://voldmar.ya.ru/
[mel]: http://en.wikipedia.org/wiki/Maya_Embedded_Language
[drake]: http://drakeguan.org/


## Version 4.1

Languages:

- Bash from Vah
- DOS bat-files from Alexander Makarov (Sam)
- Diff files from Vasily Polovnyov
- Ini files from myself though initial idea was from Sam

Styles:

- Zenburn from Vladimir Epifanov, this is an imitation of a
  [well-known theme for Vim][zenburn].
- Ascetic from myself, as a realization of ideals of non-flashy highlighting:
  just one color in only three gradations :-)

In other news. [One small bug][bug] was fixed, built-in keywords were added for
Python and C++ which improved auto-detection for the latter (it was shame that
[my wife's blog][alenacpp] had issues with it from time to time). And lastly
thanks go to Sam for getting rid of my stylistic comments in code that were
getting in the way of [JSMin][].

[zenburn]: http://en.wikipedia.org/wiki/Zenburn
[alenacpp]: http://alenacpp.blogspot.com/
[bug]: http://softwaremaniacs.org/forum/viewtopic.php?id=1823
[jsmin]: http://code.google.com/p/jsmin-php/


## Version 4.0

New major version is a result of vast refactoring and of many contributions.

Visible new features:

- Highlighting of embedded languages. Currently is implemented highlighting of
  Javascript and CSS inside HTML.
- Bundled 5 ready-made style themes!

Invisible new features:

- Highlight.js no longer pollutes global namespace. Only one object and one
  function for backward compatibility.
- Performance is further increased by about 15%.

Changing of a major version number caused by a new format of language definition
files. If you use some third-party language files they should be updated.


## Version 3.5

A very nice version in my opinion fixing a number of small bugs and slightly
increased speed in a couple of corner cases. Thanks to everybody who reports
bugs in he [forum][f] and by email!

There is also a new language — XML. A custom XML formerly was detected as HTML
and didn't highlight custom tags. In this version I tried to make custom XML to
be detected and highlighted by its own rules. Which by the way include such
things as CDATA sections and processing instructions (`<? ... ?>`).

[f]: http://softwaremaniacs.org/forum/viewforum.php?id=6


## Version 3.3

[Vladimir Gubarkov][xonix] has provided an interesting and useful addition.
File export.html contains a little program that shows and allows to copy and
paste an HTML code generated by the highlighter for any code snippet. This can
be useful in situations when one can't use the script itself on a site.


[xonix]: http://xonixx.blogspot.com/


## Version 3.2 consists completely of contributions:

- Vladimir Gubarkov has described SmallTalk
- Yuri Ivanov has described 1C
- Peter Leonov has packaged the highlighter as a Firefox extension
- Vladimir Ermakov has compiled a mod for phpBB

Many thanks to you all!


## Version 3.1

Three new languages are available: Django templates, SQL and Axapta. The latter
two are sent by [Dmitri Roudakov][1]. However I've almost entirely rewrote an
SQL definition but I'd never started it be it from the ground up :-)

The engine itself has got a long awaited feature of grouping keywords
("keyword", "built-in function", "literal"). No more hacks!

[1]: http://roudakov.ru/


## Version 3.0

It is major mainly because now highlight.js has grown large and has become
modular. Now when you pass it a list of languages to highlight it will
dynamically load into a browser only those languages.

Also:

- Konstantin Evdokimenko of [RibKit][] project has created a highlighting for
  RenderMan Shading Language and RenderMan Interface Bytestream. Yay for more
  languages!
- Heuristics for C++ and HTML got better.
- I've implemented (at last) a correct handling of backslash escapes in C-like
  languages.

There is also a small backwards incompatible change in the new version. The
function initHighlighting that was used to initialize highlighting instead of
initHighlightingOnLoad a long time ago no longer works. If you by chance still
use it — replace it with the new one.

[RibKit]: http://ribkit.sourceforge.net/


## Version 2.9

Highlight.js is a parser, not just a couple of regular expressions. That said
I'm glad to announce that in the new version 2.9 has support for:

- in-string substitutions for Ruby -- `#{...}`
- strings from from numeric symbol codes (like #XX) for Delphi


## Version 2.8

A maintenance release with more tuned heuristics. Fully backwards compatible.


## Version 2.7

- Nikita Ledyaev presents highlighting for VBScript, yay!
- A couple of bugs with escaping in strings were fixed thanks to Mickle
- Ongoing tuning of heuristics

Fixed bugs were rather unpleasant so I encourage everyone to upgrade!


## Version 2.4

- Peter Leonov provides another improved highlighting for Perl
- Javascript gets a new kind of keywords — "literals". These are the words
  "true", "false" and "null"

Also highlight.js homepage now lists sites that use the library. Feel free to
add your site by [dropping me a message][mail] until I find the time to build a
submit form.

[mail]: mailto:Maniac@SoftwareManiacs.Org


## Version 2.3

This version fixes IE breakage in previous version. My apologies to all who have
already downloaded that one!


## Version 2.2

- added highlighting for Javascript
- at last fixed parsing of Delphi's escaped apostrophes in strings
- in Ruby fixed highlighting of keywords 'def' and 'class', same for 'sub' in
  Perl


## Version 2.0

- Ruby support by [Anton Kovalyov][ak]
- speed increased by orders of magnitude due to new way of parsing
- this same way allows now correct highlighting of keywords in some tricky
  places (like keyword "End" at the end of Delphi classes)

[ak]: http://anton.kovalyov.net/


## Version 1.0

Version 1.0 of javascript syntax highlighter is released!

It's the first version available with English description. Feel free to post
your comments and question to [highlight.js forum][forum]. And don't be afraid
if you find there some fancy Cyrillic letters -- it's for Russian users too :-)

[forum]: http://softwaremaniacs.org/forum/viewforum.php?id=6
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# Highlight.js

[![Build Status](https://travis-ci.org/isagalaev/highlight.js.svg?branch=master)](https://travis-ci.org/isagalaev/highlight.js)

Highlight.js is a syntax highlighter written in JavaScript. It works in the
browser as well as on the server. It works with pretty much any markup,
doesn't depend on any framework and has automatic language detection.


## Getting Started

The bare minimum for using highlight.js on a web page is linking to the library
along with one of the styles and calling [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

This will find and highlight code inside of `<pre><code>` tags trying to detect
the language automatically. If automatic detection doesn't work for you, you can
specify the language in the class attribute:

```html
<pre><code class="html">...</code></pre>
```

The list of supported language classes is available in the [class reference][8].
Classes can also be prefixed with either `language-` or `lang-`.

To disable highlighting altogether use the `nohighlight` class:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Custom Initialization

When you need a bit more control over the initialization of
highlight.js, you can use the [`highlightBlock`][2] and [`configure`][3]
functions. This allows you to control *what* to highlight and *when*.

Here's an equivalent way to calling [`initHighlightingOnLoad`][1] using jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

You can use any tags instead of `<pre><code>` to mark up your code. If you don't
use a container that preserve line breaks you will need to configure
highlight.js to use the `<br>` tag:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

For other options refer to the documentation for [`configure`][3].


## Getting the Library

You can get highlight.js as a hosted or custom-build browser script or as a
server module. Head over to the [download page][4] for all the options.

Note, that the library is not supposed to work straight from the source on
GitHub, it requires building. If none of the pre-packaged options work for you
refer to the [building documentation][5].


## License

Highlight.js is released under the BSD License. See [LICENSE][10] file for
details.


## Links

The official site for the library is at <https://highlightjs.org/>.

Further in-depth documentation for the API and other topics is at
<http://highlightjs.readthedocs.org/>.

Authors and contributors are listed in the [AUTHORS.en.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.en.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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Copyright (c) 2006, Ivan Sagalaev
All rights reserved.
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright
      notice, this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright
      notice, this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of highlight.js nor the names of its contributors 
      may be used to endorse or promote products derived from this software 
      without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS AND CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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var work = 1;

function pop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popper/,"popped");
	}
}
function unpop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popped/,"popper");
	}
}

function siblings(entity){
	var r = [];
	for ( var n = entity.parentNode.firstChild; n; n = n.nextSibling ) 
		if ( n.nodeType == 1 && n != entity)
			r.push( n );		
	return r;
}

/* This activates an element and deactivates all it's siblings */
function activateElement(id) {
	var entity = document.getElementById(id);
	if(entity.className.indexOf("active") == -1) {
		entity.className = entity.className + " active";
	}
	var sibs = siblings(entity);

	for(var i=0; i < sibs.length; i++) {
		if(sibs[i].className.indexOf("active") != -1) {
			deactivateElement(sibs[i]);
		}
	}
}

function deactivateElement(entity) {
	if(entity.className.indexOf("active") != -1) {
		 entity.className = entity.className.replace(/[ ]*active/, '');
	}
}

function getCookie(name) {
	var name_c = window.location.hostname + '-' + name;

	if(document.cookie) {
		var cookies = document.cookie.split(/ *; */);
		for(var i=0; i < cookies.length; i++) {
			var current_c = cookies[i].split("=");
			if(current_c[0] == name_c) {
				return(current_c[1]);
				break;
			}
		}
	}
	return('');
}

function setCookie(name, value, expires, path) {
	name = window.location.hostname + '-' + name;

	var curCookie = name + "=" + value + 
		((expires) ? ";expires=" + expires.toGMTString() : "") + 
		((path) ? ";path=" + path : "");
	document.cookie = curCookie; 
}

function setDefLangCookie(entity) {
	setCookie('switchery', entity.options[entity.selectedIndex].value, '', '/');
}

function initSwitchery() {
	var divs = document.getElementsByTagName('div');
	for(i in divs) {
		if(typeof(divs[i].className) != 'undefined' && divs[i].className.indexOf("switchery") != -1) {
			var lang = getCookie('switchery');
			if(lang != '') {
				var entity = document.getElementById(divs[i].id + '-' + lang);
				if(entity) {
					entity.onclick();
					entity.parentNode.lastChild.value = lang;
				} else {
					divs[i].firstChild.firstChild.onclick();
				}
			} else {
				divs[i].firstChild.firstChild.onclick();
			}
		}
	}

}

function showhide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("hidden") != -1) {
				entity.className = my_class.replace(/hidden/,"visible");
			}
			else if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	}

	return false;
}

function hide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	} else {
		work=1;
	}
}

var preventReset = 0;

function dehighlightTarget(entity) {
	if(preventReset == 0 && entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		var target = document.getElementById(id);
		if(target) {
			deactivateElement(target);
		}
		}
}

function highlightTarget(entity, norefresh) {
	if(entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		activateElement(id);
		preventReset = 0;
	} 
	if(norefresh == 1) {
		preventReset=1;
	}
}
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@DINFO janemurphe... myCamel | 14:01:02.000... io.fabric.api.scr.AbstractComponent  activateComponent: io.fabric8.git.internal FabricGitServicelmpl@4sdi
(DINFO janemurphe... myCamel | 14:01:02.000... io.fabric8.api.scr.AbstractComponent  activateComponent: io.fabric8.internal ZooKeeperClusterBootstrapirm
14:01:02.000..."o.fabrics.api scr AbstractComponent | activateComponent: o.fabrics.zookeeper-bootstrap.BootstrapConfio
@INFO janemurphe... myCamel |14:01:02.000... |io.fabric8.api.scr.AbstractComponent activateComponent: io.fabric8.zookeeper.curator. ManagedCuratorfri

©NFO janemurphe... myCamel  14:01:02.000...io fabrics.api.scr AbstractComponent

activateComponent: i0.fabric8.gitinternal. CachingGitDatastore@449

=] Properties & ® v=a

‘activateComponent: i0.fabric8 zookeeper bootstrap BootstrapConfiguration@11325e3






